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ABSTRACT

The high incidence of invasive breast carcinomas, which accounts for about 90%
of all breast cancer-related deaths, underscores the need for new and more effective
therapeutic approaches to block the development of the malignant phenotype. Changes
in the cytoskeletal organization of tumor cells and the physiochemical properties of the
extracellular matrix (ECM) are key drivers of invasion and metastasis. Aberrant
activation of phosphotyrosine signaling results in the formation of actin-based structures,
called invadopodia, known to play an important role in ECM remodeling. We
determined the role of Nck, adaptor proteins that link tyrosine phosphorylation with
actin dynamics, in mammary carcinoma tumorigenesis and metastatic spread. We
hypothesized that Nck-dependent actin remodeling promotes breast cancer invasion and
metastasis by promoting the membrane accumulation/activity of MMP14, a key matrix-
remodeling protease. To test this hypothesis, we used the highly metastatic MDA-MB-
231 breast cancer cell line and a combination of three-dimensional (3D) tissue culture,
optical imaging and a xenograft nude mouse model. To determine how Nck promotes
invasion and metastasis by altering actin dynamics and membrane localization of
MMP14 through regulation of Cdc42 activity we used gelatin degradation in conjunction
with immunofluorescence microscopy, fluorescence recovery after photobleaching, total
internal fluorescence microscopy and Forster resonance energy transfer.

The results show, for the first time, a requirement for Nck in breast carcinoma

growth and invasion in 3D cultures and metastasis in vivo. Nck facilitates invasiveness

il



by promoting invadopodia biogenesis and focalized matrix degradation. Loss of Nck
results in decreased MMP14 accumulation at the ventral surface of invasive cells and
altered actin dynamics at invadopodia. Loss of Nck also disrupted the localization of
active Cdc42, a key regulator of trafficking and polarity. Our results support a model
where Nck specifies patterns of Cdc4?2 activation and the targeted accumulation of
MMP14 to facilitate the formation and maturation of invadopodia by integrating

extracellular signals that modulate cytoskeletal dynamics.
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NOMENCLATURE

pm — Micrometer

Arp2/3 — Actin related protein 2/3 complex

ATCC — American Type Culture Collection

BSA — Bovine serum albumin

Cdc42 — Cell division control protein 42

dH,O — Distilled water

ddH,0 — Deionized distilled water

DPBS — Dulbecco’s phosphate buffered saline
ECM - Extracellular matrix

EGF — Epidermal growth factor

EGFR - Epidermal growth factor receptor

EMT — Epithelial to mesenchymal transition

F-actin — Filamentous actin

FBS — Fetal bovine serum

FIJT — F1JT is just ImageJ

FRAP — Fluorescence recovery after photobleaching
FRET — Forster resonance energy transfer

G-actin — Globular actin

GAPDH - Glyceraldehyde 3-phosphate dehydrogenase

kDa — Kilodalton
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MMP — Matrix metalloproteinase

MTS — Multicellular tumor spheroid

Nck — Non-catalytic region of tyrosine kinase adaptor protein
N-WASp — Neuronal Wiskott - Aldrich syndrome protein
Pen/Strep — Penicillin and streptomycin

PFA — Paraformaldehyde

PI(3,4,5)P; — Phosphatidylinositol (3,4,5)-trisphosphate
PI(4,5)P, — Phosphatidylinositol (4,5)-bisphosphate

ROI — Region of interest

RTK — Receptor tyrosine kinase

TIRF — Total internal reflection fluorescence microscopy
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CHAPTER I

INTRODUCTION

An Overview of Cancer Biology

According to the National Cancer Institute (1) the term cancer is used to describe
more than 100 different types of disease. In stark contrast to the diversity of disease
types, cancer can be characterized by two major traits including: unrestrained tumor cell
proliferation, and altered tissue architecture (2, 3). To more precisely define the
hallmarks of cancer, Hanahan and Weinberg proposed that tumor cells develop enabling
mechanisms to evade apoptosis, proliferate autonomously, promote angiogenesis,
undergo self-regeneration, invade local tissues, and metastasize (4). In addition, cancer
cells frequently thrive by evading immune surveillance and reprogramming cellular
energetics (5).

It is widely accepted that cancer cells evolve from normal cells through a process
of transformation induced by the accumulation of multiple mutations. Knudson’s two hit
hypothesis, based on a statistical analysis of retinoblastoma, provided the first direct
evidence that cancer results from as few as two mutations; either inherited through
germinal cells or acquired by somatic cells (6). Mutations responsible for cancer can be
caused by a number of different factors including chemical carcinogens, radiation, and
faulty cellular mechanisms of DNA copying/repair.

Mutations result in gain (hyperactivation) or loss (inactivation) of protein

function. Protein hyperactivation drives signaling mechanisms beyond homeostasis and



makes cells susceptible to oncogenic transformation. The genes affected by these
mutations are typically referred to as proto-oncogenes. Protein inactivation disrupts the
normal control mechanisms that balance the activating effects of proto-oncogenes. These
genes are referred to as tumor suppressor genes. In addition to mutations to specific
genes, gene amplification and translocation can result in altered protein levels or an
altered protein and thus protein function. Gene amplification increases the number of
gene copies and ultimately results in overexpression of the protein product. The result of
gene translocation is dependent on the expression profile of the location of translocation
and typically results in overexpression of proto-oncogenes (7).

In addition to mutations, cells can also undergo epigenetic changes that influence
gene expression leading to aberrant cell behavior. Epigenetic changes affect the profile
of gene expression without alterations in the DNA sequence in both development and
disease (8). DNA methylation and histone modification are classic examples of
epigenetic changes that can be inherited or directly influenced by environmental factors
(2). Thus, the combined accumulation of mutations and epigenetic changes are likely to
overcome cellular mechanisms of homeostasis and drive the progressive acquisition of
the hallmarks of cancer.

Cancers can be categorized according to the tissue of origin. Thus, cancers
originating from epithelial cells are designated as carcinomas. They can be further
categorized based on the origin of epithelial cells; squamous cell carcinomas originate
from protective epithelial layers, while adenocarcinomas originate from secretory

epithelia. Given their protective and secretory functions, epithelial cells typically
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undergo rapid proliferation; therefore, epithelia are more likely to undergo oncogenic
transformation. Leukemia and lymphomas, cancers of white blood cells, result from
excessive production of cells in the bone marrow and lymph nodes, respectively.
Neuroectodermal tumors, on the other hand, derive from the cells of the central and
peripheral nervous system (7).

Breast Cancer is a Significant Worldwide Health Concern

Breast cancer or breast adenocarcinoma is the second most common cancer and
the most common type of cancer in women worldwide (9). In 2012 there were
approximately 1.67 million cases of breast cancer diagnosed worldwide, accounting for
about 25% of all cancers (9). In addition, an estimated 522,000 women died from breast
cancer in 2012 (9).

For women in the United States, the most commonly diagnosed cancer and the
second most frequent cause of cancer related death is breast cancer (10). Over 230,000
new breast cancer cases and 40,000 deaths related to breast cancer are estimated for the
year 2015 (10). In addition, approximately 2,300 men will be diagnosed with breast
cancer in 2015 (10). Early detection and advancements in treatment of breast cancer
have improved the overall 5-year relative survival rate to nearly 90%; however, once
metastases arise, the 5-year relative survival rate sharply decreases to only 25% (10).
Metastasis, therefore, accounts for greater than 90% of deaths due to breast cancer (10,
11).

According to the National Cancer Institute, there are currently six standard types

of treatment for breast cancer: surgery, sentinel lymph node biopsy with surgery,



radiation therapy, chemotherapy, hormone therapy, and targeted therapy. The most
common treatment is surgical removal of the affected breast tissue and any affected local
lymph nodes. In some circumstances, a sentinel lymph node biopsy is performed prior to
surgery to determine if the tumor has spread. Surgery may be limited to the primary
tumor or may be as extensive as a radical mastectomy, with the ultimate goal of
removing all cancerous cells associated with the primary tumor and any affected local
lymph nodes. Radiation therapy using x-rays or radioactive material is used to kill or
prevent further growth of cancerous cells. Chemotherapy is a general term that
represents more than 28 drugs that slow proliferation or kill cancerous cells.
Chemotherapeutic agents can be administered locally or systemically and are often used
to treat metastatic cancer. Hormone therapy works by interfering with the production of
hormones or their actions to prevent hormone-induced cancer growth. Targeted
therapies, on the other hand, are used to treat specific molecular targets that are
overexpressed or hyperactivated in types of cancer (12). For example, a number of
antibodies and antibody-drug combinations are available to treat HER2-positive breast
cancer (13). Even with targeted therapies, beneficial effects are limited to increasing
survival rates. Unfortunately, available therapeutic options are ineffective to prevent
metastatic breast cancer progression. Treatments are frequently tailored to the needs of
individual patients by combining any of the six standard therapeutic methods outlined

above.



Cancer Invasion and Metastasis

Invasion and metastasis are complex, multi-step processes that involve breaching
of basement membranes by cancer cells, invasion through the local extracellular matrix
(ECM), and access to blood/lymphatic vessels (14). Cancer cells enter the vasculature, a
process known as intravasation, to subsequently transit to local lymph nodes and
eventually spread to distal organs (14). As tumor cells disseminate from the primary
tumor, they are likely to escape the circulatory system by extravasation (14) and
infiltrate distal tissues. Tumor cells with competence to adjust to the local environment
may, after variable latency, colonize the organ and develop metastases (14).

Epithelial to Mesenchymal Transition (EMT)

Transformed epithelial cells exhibit “plasticity” or the ability to change their
morphology and mode of motility to disseminate and colonize distant tissues during
metastasis. During cancer progression, epithelial cells lose their typical apical-basal
polarity and undergo a series of morphological and biochemical changes collectively
known as epithelial to mesenchymal transition (EMT) (15). For example, EMT involves
changes in cell-cell and cell-ECM adhesion, cytoskeletal remodeling, increased motility,
and activation of a transcription program supporting acquisition and maintenance of the
mesenchymal phenotype (16). Cues from the microenvironment ECM fibrils and soluble
factors, in combination with the accumulation of genetic and epigenetic changes,
promote EMT (17). The resulting signaling activation triggers changes in cell
morphology, motility, and the expression of key transcription factors including: Slug,

Snail and Twist. These transcription factors act by decreasing the expression of epithelial



markers, namely E-cadherin, and increasing expression of mesenchymal markers such as
vimentin (15, 18).
Role of Extracellular Matrix (ECM) Remodeling in Tumor Progression

Reciprocal cell-ECM interactions are essential in both tissue homeostasis and
disease progression. Key features of the extracellular matrix (ECM) that modulate the
migration of mesenchymal and tumor cells are its chemical composition, stiffness,
topography, and ligand density (19). Mesenchymal and tumor cells, on the other hand,
are capable of altering (remodeling) the ECM through a variety of mechanisms including
synthesis/deposition and/or degradation of matrix components as well as alignment and
crosslinking of matrix fibrils (20).

Three major classes of proteases employed in the ECM remodeling are the Zinc-
dependent metalloproteases, the cathepsin cysteine proteases, and serine proteases (20,
21). Although multiple secreted or membrane-associated proteases are capable of
altering/degrading the ECM, the matrix metalloproteinases (MMPs) are key modifiers of
the ECM during tumor progression (20, 22). MMPs are zinc-dependent protein
hydrolases essential for tissue remodeling during both disease and development (23, 24).
MMP activity results in degradation/modification of the ECM and, consequently,
exposure of cryptic binding sites in ECM proteins and changes in the bioavailability of
extracellular signaling molecules (25). Matrix metalloproteinase 14 (MT1-
MMP/MMP14), in particular, is thought to play a central role in invasion and metastasis
(26). MMP14 is one of the key membrane-tethered metalloenzymes required for

collagenolysis and tumor cell intravasation (27, 28). Evidence suggests that MMP14



accumulates and/or is differentially activated at invadosomes (29). In addition, MMP14
activates MMP2 and MMP9, two secreted MMPs known to promote remodeling of the
ECM and facilitate tumor cell invasion (29). The levels and activities of MMPs are
tightly regulated through biosynthesis and post-translational modifications, including
activation by furin-like proteases (20, 30). Of significance, the trafficking through the
endocytic/recycling pathways is considered an important mechanism regulating the
enrichment of MMP14 at sites of matrix degradation in tumor cells (29, 31)

Tumor Cell Migration

Cell migration is an essential process involved in organogenesis, tissue repair,
and disease progression. Various modalities of cell movement, including single and
multicellular migration, as well as expansive growth are recognized (32).

Single cells migrating through amoeboid movement do not require strong cell-
substratum adhesion or protease-dependent ECM remodeling. Mesenchymal migration,
on the other hand, is a mechanism of single cell migration that involves the formation of
polarized membrane protrusions, substantial cell-ECM adhesion, and active protease-
dependent ECM remodeling (32-34). Depending on the elastic properties of the matrix,
lobopodial and lamellipodial modes of single cell migration have been described in
three-dimensional environments (35). Importantly, cells exhibit plasticity in their
migration behavior, i.e. are capable of alternating between mechanisms of cell
movement in order to adapt to the prevalent microenvironment (34).

Collective cell migration includes multicellular streaming, characterized by

differentiation of path-generating leader and follower cells. Sheet migration, on the other



hand, is another modality of collective invasion that relies on the maintenance of cell-
cell junctions (32).

Expansive growth refers to an expanding tumor mass resulting from proliferating
tumor cells pressing out on a permissive ECM in the absence of active cell migration
(32). The diverse mechanisms of migration/invasion require cytoskeletal remodeling,
and in the case of the most aggressive cancers, ECM remodeling by MMPs appears to be
required.

Actin Dynamics Determine Cell Morphology and Motility

The actin cytoskeleton determines cell morphology and enables motility.
Globular actin (G-actin) is an abundant cellular protein with structural polarity that
assembles into polar, double-stranded helical filaments (F-actin) presenting a slow-
growing pointed end and a fast-growing barbed end (2, 36). Actin monomers being
incorporated into the polymers are loaded with ATP, which is hydrolyzed soon after
polymerization (2). The spontaneous nucleation of actin is not thermodynamically
favorable (37, 38). However, the presence of polymerization machineries allows cells to
overcome the energetic barrier of actin nucleation. Once actin nucleation is initiated, the
abundantly present actin monomers are added to barbed ends of an elongating actin
filament at a rate limited only by its diffusion constant (36, 39). Therefore, the
nucleation of actin is tightly regulated within the cells (40).

Cellular Machineries of Actin Polymerization
Two major contributors to F-actin nucleation/elongation are the Arp 2/3

complex and formins (36, 40). The Arp 2/3 complex is an intrinsically inactive complex



of seven polypeptides that form an anchor on existing (mother) actin filaments and
promote actin nucleation and elongation of daughter filaments. The resulting filament
network displays a y-branched geometry in which mother/daughter filaments are
typically arranged at a 70° angle (40-43).

Unlike the Arp2/3 complex, formins are a large family of proteins (15 members
in humans) that use conserved domains to form homodimers that polymerize linear actin
(40, 44). Thus, a “lasso” shaped domain (FH2) engages the barbed end of actin filaments
while a second polyproline-rich domain (FH1) binds multiple profilin-actin complexes
(activated building blocks) and positions them at the growing end of the filament
facilitating processive polymerization (40, 45). Formins also protect the barbed ends of
actin filaments from capping proteins during elongation, but the underlying mechanism
remains to be elucidated (40, 46). In addition, Spire and Cordon-blue are actin
nucleation factors that use multiple WH2 domains, G-actin binding modules, to promote
polymerization of unbranched filaments (47, 48). Of significance, the linear actin
filaments generated by formins and Spire play an important role in tumor cell
invasiveness (49-51).

It is now recognized that the concerted action of the various actin
nucleation/polymerization machineries are important for the dynamic organization of the
actin cytoskeleton. Thus, the cooperation of multiple actin nucleators are required for the
assembly and remodeling of F-actin structures contributing to cell shape and locomotion,
including lamellipodia, filopodia, invadosomes, as well as tension-bearing actin cables

and cortical actin networks (52).



Actin Dynamics Power Tumor Cell Invasion

Actin dynamics play a central role in invasion of tumor cells, a critical step
leading to metastasis. More than 160 actin-binding proteins have been discovered and
classified according to their role in the regulation of actin dynamics including
nucleation/polymerization, nucleation-promoting, filament severing, capping and
stabilization, and G-actin buffering (37, 53). Many of the molecules that drive
cytoskeletal dynamics in response to extracellular cues are upregulated or activated in
invasive tumor cells.

A Key Role for Arp2/3-dependent Actin Polymerization in Tumor Cell Invasion

Regulation of Arp2/3 by nucleation promoting factors

The assembly of a branched actin network by the Arp2/3 complex is critically
important in the generation of protrusive structures that enable cell migration/invasion
(54-56). Because the Arp2/3 complex is intrinsically inactive (40), the activity of
nucleation promoting factors, and particularly the Wiskott-Aldrich syndrome protein
(WASp) family, is required for the formation of branched actin networks. Members of
the WASp family act as scaffold proteins that integrate signals from extracellular stimuli
and modulate the activity of downstream effectors that, regulate actin dynamics (57).

The WASp protein, expressed in hematopoietic cells, was first identified as the
causative agent of Wiskott-Aldrich syndrome, a rare X-linked recessive disease
characterized by eczema, thrombocytopenia, and immunodeficiency (58). The closely
related N-WASp (neuronal WASp) was subsequently discovered and found to be

expressed in many tissue types (57, 59).
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WASp proteins belong to the class I nucleation promoting factors that possess
conserved C-terminal VCA domain consisting of three short conserved motifs including
verprolin homology (V), connecting (C) and acidic (A) regions (40, 60). The VCA
“output” domain mediates interactions with G-actin and the Arp2/3 complex, thus
bringing together building blocks and the builder for effective nucleation of daughter
actin filaments (40). In addition, N-terminal domains including WASp homology 1
(WHI) or Ena/VASP homology 1 (EVH1) domain, a basic region, a GTPase binding
(GBD) or Cdc42 and Rac interactive binding (CRIB) domain, and a proline-rich region,
provide interaction sites that enable regulation of N-WASp activity (57, 60). The WH1
domain binds members of the WASp-interacting protein (WIP) family, scaffolds that
appear to suppress the activity of N-WASp and assist with binding adaptor proteins such
as Nck (57). The basic region just upstream of the GBD can bind phosphatidylinositol
(4,5)-bisphosphate or PI(4,5)P,, while the GBD domain binds the small GTPase Cdc42
(57, 61). The proline-rich region of N-WASp acts as a binding site for SH3 domain-
containing proteins such as Nck or Grb2 (57, 61). The intramolecular interaction
between the VCA and GBD/basic regions results in a folded, auto-inhibited confirmation
of N-WASp that prevents exposure of the VCA region and its interaction with Arp2/3
complex and G-actin (57, 61). Thus interactions of the WASp/N-WASp regulatory
domains with upstream signals disrupts the intramolecular interaction between the VCA
and the basic region/GBD domains, allowing the unfolding of WASp/N-WASp and
exposure of the VCA domain for G-actin and Arp2/3 complex binding (57, 61). It is now

well established that N-WASp-stimulated actin polymerization by the Arp2/3 complex is
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critically involved in tumor cell invasiveness through the regulation of invadosome
biogenesis (56, 62-64). In addition, a recent report provides evidence that N-WASp is
involved in the delivery and anchoring of MMP14 at invadopodia (65).

WASH is another member of the WASp family of nucleation promoting factors
that is involved in regulation of tumor cell invasion (66). WASH also possesses a VCA
region that mediates interaction with G-actin and the Arp2/3 complex but its N-terminal
region differs from that of WASp/N-WASp. Thus, the N-terminal WASH homology
domain 1 (WHD1) facilitates the assembly of a five-member WASH complex that
regulates the nucleation-promoting activity of the WASH protein and targets it to the
endosomes compartment (67, 68). The WASH proteins stimulate actin polymerization
through activation of the Arp2/3 complex in lamellipodia and filopodia (66). In addition,
recent evidence suggests that WASH interaction with the exocyst complex on late
endosomes is required for MMP14-dependent ECM remodeling (66, 69). Collectively,
these findings suggest that WASH plays an important role in regulating F-actin
dynamics to promote the trafficking and targeted delivery of MMP14 to invasive
structures.

Regulation of Arp2/3 by cortactin

Cortactin is an actin regulatory protein consisting of a N-terminal acidic domain
followed by tandem F-actin binding repeats and a regulatory C-terminus that includes a
proline-rich segment, and one SH3 domain. By virtue of its N-terminal acidic region,
cortactin binds Arp2/3 complex and acts as a nucleation promoting factor. Cortactin may

also help stabilize actin filaments and enhance N-WASp-stimulated actin polymerization
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(70). Importantly, cortactin acts as signaling hub by integrating signals from tyrosine and
serine/threonine kinases, interacting with a number of SH3 binding partners, and
undergoing posttranslational modifications including acetylation and phosphorylation
(70, 71). Cortactin is known to play an important role in cancer cell invasion. In
particular, the formation of cellular invasive structures requires tyrosine phosphorylation
of cortactin and the subsequent activation of N-WASp/Arp2/3-dependent actin
polymerization through the adaptor Nck (63, 72). Cortactin has also been linked to pH
dependent invasion and secretion of MMPs (MMP2, 9 and 14) (73, 74).

Invadosomes

A variety of cancer cells form specialized F-actin based structures, collectively
termed invadosomes, that in conjunction with other cytoskeletal structures such as
lamellipodia and lobopodia enable tumor cell invasion and metastasis (35, 75, 76).
Invadosomes are enriched in proteases that by promoting remodeling of the ECM
facilitate migration/invasion of tumor cells (28).

The two primary structures that make up the invadosomes are invadopodia and
podosomes. The term invadopodia was coined by Wen-Tien Chen in 1989 when he
described the membrane protrusions found in Rous sarcoma virus (RSV) -transformed
fibroblasts that were capable of localized ECM degradation (77). Previously, David-
Pfeuty and Singer had identified altered localization of cytoskeletal proteins in RSV
transformed fibroblasts (78). This was followed by Tarone et al. discovering that these
sites formed cell-to-ECM adhesions that resembled cellular feet, leading them to

describe them as podosomes (79). Thus, the terms invadopodia and podosome were
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initially used to describe the same structures identified in RSV-transformed fibroblasts.
Currently, podosome and invadopodia are used, respectively, to refer to the actin-based
invasive structures formed in normal cells and in tumor/Src-transformed cells (28).
Podosomes and invadopodia share a similar overall architecture, but present
differences in morphology and molecular composition (28, 76). Important morphological
differences include: i) the presence of a prominent vinculin-containing ring surrounding
the actin core in podosomes but not in invadopodia; ii) number and location: tumor cells
typically form fewer than ten invadopodia that localize in proximity to the nucleus.
Normal cells, in contrast, display a large (greater than one hundred) number of
podosomes that localize in the proximity of the cell’s edge); iii) size and clustering:
invadopodia are usually found as single entities of 0.5-2 um in diameter whereas
podosomes tend to cluster/form arrays of larger size; and iv) lifetime: invadopodia
persist for over an hour whereas podosomes have a lifetime of only a few minutes (21,
28, 80). At the molecular level, Nck1 and Grb2 localize specifically to invadopodia and
podosomes, respectively (81). Despite characterized differences, the degrading capacity
of these structures enables cell migration through dense ECM, and for breast cancer
cells, enables invasion and metastasis.
Key Signaling Mechanisms Linking Actin Dynamics and Tumor Cell Invasion
Tumor cell invasion requires coordinated cytoskeletal rearrangement in response
to cellular stimuli. Stimulation of cell surface receptors results in activation of
intracellular signaling pathways that lead to localized actin polymerization. Multiple

signaling pathways contribute to the spatial and temporal regulation of actin dynamics

14



during invasion. Within these signaling pathways, Rho GTPases, phosphoinositides and
tyrosine phosphorylation provide critical links enabling coordinated actin rearrangement
necessary for tumor cell invasion.

Rho GTPases

The Rho GTPases are well characterized regulators of the actin cytoskeleton that
function as convergence nodes, integrating and coordinating signaling cascades activated
by multiple cell surface receptors. These small proteins are enzymes that hydrolyze
guanine-triphosphate (GTP) to guanine-diphosphate (GDP). The binding of GTP or GDP
results in alternation between two conformational states that allow the Rho GTPases to
function as molecular switches, i.e., the GTP-bound active and the GDP-bound inactive
states (82). The transitions between active/inactive states are regulated by about 85
guanine exchange factors (GEFs) and 80 GTPase activating proteins (GAPs) (83).
Whereas GEFs activate Rho GTPases by facilitating the exchange of GDP for GTP,
GAPs promote their inactivation by accelerating their GTPase activity (83). In addition,
three guanine nucleotide dissociation inhibitors (GDIs) prevent spontaneous activation
by sequestering the Rho GTPases in the cytoplasm (82, §83).

Key processes regulated by Rho GTPases through cytoskeletal remodeling
include cell polarization, migration, intracellular trafficking, and proliferation (82).
Twenty-two Rho GTPases have been identified; however, RhoA, Racl and Cdc42 are
the most extensively involved in regulation of cytoskeletal dynamics (82, 83). Of
particular interest is Cdc42, a key GTPase that controls cell polarity and directional

migration (82, 84). Key downstream targets of Cdc42, WASp/N-WASp, and
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diaphanous-related formins (83) are critical in invadosomes biogenesis. A role for Cdc42
in invadopodia formation was first established in human melanoma cells (85),
subsequently asserted in mammary adenocarcinoma cells (56, 86), and more recently,
pancreatic tumor cells (87).
Phosphoinositides

Another regulator of actin dynamics is a family of phosphorylated amphipathic
lipids (phosphatidylinositol) called the phosphoinositides (PI). Although
phosphoinositides constitute only a small fraction of the total membrane phospholipids
(i.e., <1/6™), their diversity and subcellular distribution contributes to organelle
membrane differentiation and spatiotemporally-regulated signaling (88). Two of the
seven phosphoinositide species, phosphatidylinositol (4,5)-bisphosphate (P1(4,5)P,) and
phosphatidylinositol (3,4,5)-trisphosphate (P1(3,4,5)Ps) are enriched at the plasma
membrane and have prominent roles in modulating actin dynamics (89). The relatively
more abundant PI(4,5)P, contributes to regulation of actin dynamics in endocytic
processes, membrane ruffling, cell adhesion and migration, and invadosome formation
(88, 89). The much less abundant PI(3,4,5)Ps3, on the other hand, is increased in response
to growth factor stimulation to promote cellular responses that depend on actin
dynamics, including macropinocytosis, phagocytosis, and chemotactic migration (88).
Both PI(4,5)P, and PI(3.4,5)P; regulate actin dynamics through actin binding proteins,
localization of scaffolding proteins and activation of the Rho GTPases (89). It has been
shown that disruption of phosphoinositide metabolism alters the formation/function of

invadosomes (90-92). A recent investigation suggests that the balance between P1(4,5)P,
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and PI(3,4,5)Ps is regulated by the inositol phosphate SHIP-2 during invadopodia
maturation (93).
Tyrosine Phosphorylation

Tyrosine phosphorylation, the addition of a phosphate group to particular
tyrosine residues in substrates of tyrosine kinases, is an important signal transduction
mechanism that regulates many cellular processes including proliferation,
differentiation, metabolism, transcriptional activation, immune defense, adhesion and
cytoskeletal dynamics (94). The tyrosine phosphorylation signaling mechanism relies on
a three part toolkit: tyrosine kinases (writers), phosphotyrosine phosphatases (erasers),
and phosphotyrosine peptide recognition domains (readers) such as the Src Homology
(SH)2 and phosphotyrosine binding (PTB) domains present in a number of effector
proteins (95). Because cues from the microenvironment, including growth factors and
the ECM, modulate cytoskeletal dynamics through activation of tyrosine
phosphorylation, it is not surprising that dysregulation of such signaling mechanisms
contribute to cancer progression, invasion and metastatic spread. Dysregulation of
receptor tyrosine kinases (RTK) including, among others, epidermal growth factor
receptor (EGFR) and hepatocyte growth factor receptor (c-Met), promotes uncontrolled
cell proliferation, tumor angiogenesis, and metastasis (96, 97). In addition, the non-
receptor tyrosine kinase Src is known to act as a common downstream node cooperating
with activated RTK in tumorigenesis and metastasis (98). Src phosphorylates key
cytoskeletal effectors including cortactin, Tks5 and N-WASp (75, 99). Phosphorylated

cortactin initiates invadopodia formation by engaging Nck through its SH2 domain. The
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cortactin-Nck complex, in turn, drives activation of the N-WASp-Arp-2/3 pathway of
actin polymerization that is required for invadopodia biogenesis (63, 72). Activation of
this pathway is reinforced by Src dependent phosphorylation of Tks5 (99, 100).

The discoidin domain receptors (DDR), receptor tyrosine kinases activated upon
engagement of collagen fibrils, are known to facilitate tumor invasion through
cooperation with MMPs, though the specific nature of the interaction remains to be
elucidated (101-104). Interestingly, a recent report showed that DDR1 induces linear
invadosome assembly, independently of its inherent kinase activity, through activation
of the Rho GTPase Cdc42 (86). Since activated DDRs interact with Nck (101), it is
possible that these adaptors provide a link between collagen signaling and N-
WASp/Arp2/3 actin remodeling.

Nck

The non-catalytic region of tyrosine kinase Nck1 and Nck2 (collectively referred
to as Nck) are a pair of SH2/SH3 domain-containing adaptor proteins that link cell
surface signaling to actin dynamics (105, 106). Nck consists of a single C-terminal SH2
domain and three N-terminal SH3 domains (107). SH2 and SH3 domains have no
inherent enzymatic activity and serve as protein interaction modules that facilitate the
formation of signaling ensembles (107). The SH2 domain binds phosphorylated tyrosine
residues in a sequence-specific context to perform the “reader” function in
phosphotyrosine signaling (95). The SH3 domain interacts with proline-rich binding
sites of a number of downstream effectors that include members of the WASp family

(108).
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First identified in melanoma, Nck are 47 kDa proteins that share 68% homology
(105, 106). Nck1 and Nck2 display significant overlap in expression patterns during
development and are thought to have redundant functions, with few identified exceptions
(109-111). Inactivation of both Nck1 and Nck2 causes embryonic death in mice and
defects in motility and actin polymerization in cultured embryonic fibroblasts (109). The
Nck adaptors are also required for the development of the glomerular filtration barrier by
linking nephrin phosphorylation to actin dynamics in podocytes (112). Similarly, a role
for Nck in mammary gland development downstream of activated DDRs has been
proposed (113, 114). Findings from a recent study show lethality associated with
ablation of Nck in the mouse endothelium (115). Conceivably, Nck signaling may also
contribute to tumor angiogenesis.

Several pathogens are known to manipulate actin dynamics through Nck binding.
For example, vaccinia virus induces actin comets through activation of the Nck/N-
WASp/Arp2/3 pathway; such comets propel the viral particles for productive pathogen
dissemination (116, 117). Enteropathogenic Escherichia coli, on the other hand, activate
N-WASp/Arp2/3-dependent actin polymerization through translocation of virulence
factors (118). One such factor, the intimin receptor (Tir), undergoes phosphorylation by
host tyrosine kinases and subsequently recruits Nck to induce the formation of actin
pedestals (118).

It is known that maximum stimulation of the nucleation promoting activity of N-
WASDP requires the coincidence of multiple signals. Pioneer studies by Rohatgi et al.

demonstrated synergistic activation of N-WASp by converging signals from P1(4,5)P;
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and Cdc42 (119) or PI(4,5)P, and Nck SH3 domains (120). Clustering of membrane-
targeted SH3 domains induce efficient activation of N-WASp dependent actin
polymerization and the formation of actin comets (121, 122). In addition, a reciprocal
interaction of Nck and PI(4,5)P, was shown to enhance localized actin polymerization in
living cells (123). By combining experimentation with computational modeling, it was
shown that full activation of localized actin polymerization in cells requires a 4:2:1
stoichiometry within the Nck/N-WASp/Arp2/3 complex (124). Such models also
underscore a critical role for WASp-interacting protein (WIP), another scaffold recently
shown to provide a key linkage between N-WASp and Nck (125).

Evidence suggests that Nck plays a role in cancer through modulation of tumor
cell proliferation, invasion, and metastasis. For example, work from Condeelis et al.
described a critical role for Nck1 in EGF stimulated invadopodia formation and
invasion. Findings from in vitro studies from this group suggest that EGF stimulation of
invasive breast carcinoma cells induces Src-mediated phosphorylation of cortactin and
the subsequent recruitment of Nck1 to stimulate focalized actin polymerization through
the N-WASp/Arp2/3 complex (56, 72). The silencing of Nck2 was reported to impair
cell adhesion/spreading thus precluding further analysis (56). In addition, Nck1 and
Grb2 were identified as unique markers to distinguish invadopodia from podosomes
(81).

The existing literature also suggests relationships between the scaffolding protein
Tks5/Fish and Nck in invadosome biogenesis. TksS5, a substrate of the non-receptor

tyrosine kinase Src, is required for invadopodia formation (99, 126, 127). Integrin
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engagement stimulates Src-dependent phosphorylation of Tks5 and the recruitment of
Nck in vitro. The Tks5/Nck complex, in turn, stimulates N-WASp/Arp2/3-dependent
actin polymerization and ECM remodeling (100). Collectively, these studies suggest a
critical role for Nck in invadosome formation downstream of RTK activation and/or
integrin engagement (56, 100).

Activation of EGF in pancreatic cancer cell lines promotes formation of a
complex between p130Cas and Nck that leads to activation of Ras-associated protein 1
(Rap1) (128). This study showed that EGF-mediated Rap1 activation was required for
metastasis but not primary tumor growth (128). Of note, overexpression of Nck2 in
melanoma cells resulted in larger tumors in mice (129). Thus, the role played by Nck in
tumor progression and metastasis remains largely undetermined.

Summary

Reciprocal interactions between cancer cells and their microenvironment set in
motion changes in the cytoskeletal architecture and remodeling of the ECM that enable
tumor cell invasion and metastasis. Invasion of tumor cells is facilitated by enhanced cell
motility and the formation of actin-based cellular structures, collectively termed
invadosomes, which remodel the ECM (130). The formation of invadosomes involves
localized actin polymerization stimulated primarily by the actin-related protein (Arp) 2/3
complex. Whereas the activity of the Arp2/3 complex is highly increased by the
nucleation promoting factor neural Wiskott-Aldrich Syndrome protein (N-WASp), actin
filament (F-actin) stabilization is enhanced by the actin binding protein cortactin (130).

Nck adaptors, containing SH2/SH3 domains, link tyrosine phosphorylation induced by
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extracellular signals with cytoskeletal dynamics (105, 106). Recent findings suggest that
cortactin recruits Nck to promote localized actin assembly through the N-WASp/Arp2/3
pathway (72). Thus, the cortactin-Nck complex is critically involved in actin
polymerization during invadosome biogenesis, localized ECM remodeling, and tumor
cell invasion in vitro (72).

Remodeling of the ECM is greatly dependent on the activity of matrix
metalloproteases (MMPs) (22, 25). Although the activities of multiple MMPs contribute
to the development of a tumor microenvironment, MMP14 is of particular importance in
tumor cell invasion and metastasis (29, 131). Loss of MMP14, but not other type I
collagenolytic metalloenzymes, decreases the invasive capacity of cancer cells (26).
MMP14 also activates MMP2 and MMP9, two secreted MMPs known to promote
remodeling of the ECM (29).

Components of the cytoskeletal network are required for structural formation,
delivery, and anchoring of ECM degrading MMPs at invadosomes. For example, N-
WASp is required for invadosome formation and anchors MMP14 to the F-actin scaffold
of invadosomes in breast cancer cells (56, 65). In addition, the cytoskeletal network is
critical for cell motility and invasion. These findings support a hypothesis that a
functional relationship exists between intracellular trafficking and localization of
MMP14; however, the role of Nck in the trafficking of MMP14 and targeted delivery to
invadosomes remains undetermined (31). More importantly, the functional significance

of Nck signaling in tumor progression and metastasis has not been elucidated.
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CHAPTER II
NCK IS REQUIRED FOR BREAST CARCINOMA GROWTH, INVASION AND

METASTASIS

Introduction

Cancer invasion and metastasis is a multi-step process that requires tumor cells to
breach the basement membrane and invade through the adjacent ECM. Subsequently,
tumor cells reach the local blood and/or lymphatic vessels, a process called
intravasation, to spread to distal tissues/organs where they potentially develop into
secondary tumors (14). Tumor progression results in loss of the architectural
organization of affected tissues and neovascularization (5). At the cellular level, an
important step in the metastatic process involves the epithelial-to-mesenchymal
transition (EMT), a combination of functional and morphological changes that results in
an altered pattern of protein expression, increased cellular motility, and the development
of invasive/matrix remodeling capacity (15).

Remodeling the ECM requires the activity of matrix modifying enzymes that
alter the structural, biochemical and biomechanical properties of the matrix (20).
Metalloproteinases, including the related families of MMPs (matrix metalloproteinases)
and ADAMs (A Disintegrin And Metalloproteinases), facilitate normal and tumor cell
invasion, activate tumor-associated inflammation, and stimulate angiogenesis (25).
Overall, the activity of the metalloproteinases results in the degradation of protein

components of the extracellular matrix, the shedding of the ectodomain of several cell
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surface-associated molecules, and modification of the activity and bioavailability of
extracellular signaling molecules (25). There are 23 MMPs that are expressed in human
tissues; however, MMP14 is critically involved in ECM remodeling, invasion and
metastasis (20, 25, 26). In addition to degrading multiple components of the extracellular
matrix, MMP14 also activates MMP2 and MMP9, two secreted MMPs that contribute to
invasion and metastasis (29).

Actin dynamics play a central role in the EMT transition. For example, actin
dynamics underlie the formation of transient membrane protrusion including
lamellipodia and invadopodia that facilitate tumor cell migration and invasion. Thus,
regulation of actin dynamics by extracellular signals is paramount in cancer progression.
This research focuses on the role of Nck adaptors, known to link signals that activate
tyrosine phosphorylation with actin dynamics (105, 106), in breast carcinoma growth,
invasion, and metastasis. Previous work relying on 2D models in vitro suggests that Nck
is an important mediator of matrix degradation and transwell invasion (72, 100).
However, how Nck regulates breast carcinoma cell behavior in three-dimensional
environments in vitro as well as tumor growth, invasion, and metastasis remains poorly
understood.

We hypothesized that Nck-dependent actin remodeling promotes breast
carcinoma invasion and metastasis. To test this hypothesis we combined analysis of
breast carcinoma cell growth/invasion in 3D collagen matrices with assessment of

tumorigenesis and metastasis in a model of xenogeneic transplantation of human breast
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carcinoma cells in immunodeficient mice. Here we determine the role of Nck in breast
carcinoma invasion and metastasis.
Materials and Methods
Cell Culture

MDA-MB-231 (CRM-HTB-26) and 293T (CRL-3216) were purchased from
American Type Culture Collection (ATCC) and cultured in DMEM high glucose
(HyClone) without sodium pyruvate (MDA-MB-231) or with sodium pyruvate (293T)
supplemented with 1% penicillin/streptomycin and 10% fetal bovine serum (FBS)
(Gemini), at 37°C in an atmosphere with 5% CO,. MDA-MB-231s were sub-cultured
every 4-5 days at ~5x10° cells/cm?® and 293 T were sub-cultured every 4-5 days at ~2x10*
cells/cm®. For sub-culture, cells were washed twice with warm DPBS and incubated with
0.05% Trypsin/0.53 mM ethylenediaminetetraacetic acid (EDTA) in Hank’s balanced
salt solution (HBSS) without sodium bicarbonate (Cellgro®) for 5 minutes at room
temperature (MDA-MB-231) or 1 minute at 37°C (293T). Trypsin was neutralized using
complete growth media and cells were centrifuged at 800 rpm for 3 minutes then re-
suspended in complete media, counted by hemocytometer and plated in plastic tissue
culture plates.

MDA-MB-231 is a triple negative (estrogen receptor negative, progesterone
receptor negative and human epidermal growth factor receptor 2 negative), claudin-low
cell line that was derived in 1973 from a pleural effusion in a 51 year old, white female
(132, 133). This cell line has been used extensively for breast cancer research and has

been shown to be both tumorigenic and metastatic in the nude mouse model (132, 134).
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Cryopreservation

Cells were grown for 3-4 days then sub-cultured. After centrifugation at 800 rpm
for 3 minutes cells were re-suspended in 90% FBS/ 10% DMSO and 500 pL aliquots
distributed in cryopreservation vials. Vials were placed in a Mr. Frosty  freezing
container and placed at -80°C for 24 hours. After 24 hours, the vials were stored in liquid
nitrogen vapor phase.

Plasmids and Viral Transduction

Virus was produced as previously described with minor modification (135, 136).
A detailed description of the protocol for viral transduction can be found in Appendix P
and Appendix Q. Briefly, virus were produced in 293T cells by calcium precipitation
with pSuper.puro/hygro carrying oligonucleotide sequences (shRNA) either non-
targeting (shScr) (scrambled sequence - Oligo2, Dharmacon non-targeting siRNA
SMARTPool), targeting human MMP14 (shMMP14) (Oligo3, Dharmacon MMP14
siRNA SMARTPool) or targeting human Nck1 or Nck2 (shNck) (137) for protein
knockdown. Plasmids were co-transfected with pHCMV-G and pMD.gag.pol plasmids
and incubated with chloroquine (25 uM) for 4-6 hours, then media was exchanged and
virus collected 20-48 hours later and either spun at 3500 rpm for 10 minutes and
distributed in 1 mL aliquots for storage at -80°C or filter sterilized with a 0.22 pm
syringe filter and used immediately. MDA-MB-231 were infected in the presence of 8

ng/mL polybrene and selected for 2-3 days in the presence of 1 ug/mL puromycin and/or

800 pg/mL hygromycin.
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SiRNA Transfection

siRNA transfections were carried out according to the manufacturers protocol
(Dharmacon). The transfection of siRNA for all experiments was carried out with the
standard conditions of 50 nM siRNA for MMP14, Nck1 and Nck2 and 25 nM scrambled
siRNA. For 3D spheroid assays DharmaFECT 4 transfection reagent was used at 1
uL/mL on 5x10* cells in a 35-millimeter dish. For transwell invasion assays
DharmaFECT 4 transfection reagent was used at 3 pL/mL on 30x10” cells in a 35-
millimeter dish. Transfection reagent and siRNA were incubated in separate tubes
containing serum-free and antibiotic-free media for 5 minutes. The tubes were then
combined and incubated for 20 minutes before the entire contents of the tube was added
to a plate containing the appropriate volume (1.6 mL for 35-millimeter dish) of antibiotic
free complete media and incubated for six hours. For 3D spheroid assays, after 6 hours
the cells were lifted, counted and placed into 10X spheroid formation matrix. For
transwell invasion assays, media was exchanged with fresh complete media after 6 hours
and allowed to grow for 48 hours. At 48 hours cells were starved overnight prior to
starting the invasion assay.

Transwell Invasion Assay

Transwell invasion assays were conducted as described by the manufacturer
(Corning) with minor modifications [Appendix G]. Briefly, individual cell invasion was
measured using control and growth factor reduced Matrigel-coated invasion chambers
(Corning BioCoat™, 354578 and 354483). MDA-MB-231 cells were starved overnight
in starvation media (0.2% FBS) and a total of 5x10* cells in starvation media were
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seeded in the upper chamber and allowed to migrate (5 hours) and invade (18 hours),
towards the lower chamber containing starvation media with 10 ng/mL EGF as a
chemoattractant. After 5 or 18 hours incubation at 37°C with 5% CO,, cells on the
underside of the filter were fixed with 3.7% paraformaldehyde (Electron Microscopy
Science) and cells on the upper side of the filter were removed using a cotton swab.
NucBlue® Live ReadyProbes” Reagent was diluted 2 drops in 1 mL DPBS and 100 pL
used to stain fixed cells. Images of nuclei were captured using an Olympus 1X70
inverted microscope equipped with an Olympus Plan-Apo 10X/0.30 numerical aperture
objective, a Spot RT3 Camera (7.4 um x 7.4 um pixel size) and Spot software. Percent
invasion was calculated as previously described: number of cells invaded divided by
number of cells migrated, then the result multiplied by 100 (138).
3D Growth Assay

3D growth assays were conducted as described by the manufacturer (Trevigen)
with minor modification [Appendix M]. Briefly, MDA-MB-231 cells expressing short
hairpin (sh) RNAs encoding non-targeting sequences (shScr) or sequences Nck (shNck)
were subjected to spheroid formation in 3D culture qualified 96-well spheroid formation
plate (Trevigen) in the presence of 10X spheroid formation matrix diluted to 1X in
complete media for 3 days, then 50 uL complete media was added and cell imaged every
24 hours for 6 days. To determine cell count after spheroid formation, spheroids were
disaggregated using Trypsin/EDTA and counted using a hemocytometer. To determine
changes in growth, images were acquired using an Olympus IX70 inverted microscope

equipped with an Olympus UPlan-Fluorite 4X/0.13 numerical aperture objective, a Spot
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RT3 Camera (7.4 um x 7.4 um pixel size) and Spot software. FIJI is just ImageJ (FLJI)
was used to determine spheroid area and exported to Excel or Minitab for analysis.
3D Spheroid Invasion Assay.: Laminin-rich Matrix

3D Spheroid invasion assays in laminin-rich matrix were conducted as described
by the manufacturer (Trevigen) with modifications [Appendix H]. Briefly, MDA-MB-
231 cells were transiently transfected with small interference (si) RNA oligonucleotides
encoding non-targeting sequences (siScr) or sequences targeting MMP14 (siMMP14), or
Nck (siNck) cells subjected to spheroid formation in 3D culture qualified 96-well
spheroid formation plate (Trevigen) in the presence of 10X spheroid formation matrix
diluted to 1X in complete media and then embedded in laminin-rich matrix (Invasion
Matrix Trevigen) and allowed to invade in the presence of EGF (5 ng/ml) used as a
chemoattractant in serum-reduced media. A total of 3x10° cells were seeded and
incubated for 2 days (spheroid formation), then imaged every 24 hours.

3D Spheroid Invasion Assay: Collagen [

The 3D spheroid invasion assay in collagen I was adapted from manufacturer’s
literature (Trevigen/Corning), and previously described protocols [Appendix 1] (139,
140). Briefly, MDA-MB-231 cells expressing short hairpin (sh) RNAs encoding non-
targeting sequences (shScr) or sequences targeting MMP14 (shMMP14), or Nck (shNck)
were subjected to spheroid formation in 3D culture qualified 96-well spheroid formation
plate (Trevigen) in the presence of 10X spheroid formation matrix diluted to 1X in
complete media. Formed spheroids were then embedded in 2 mg/ml acid-extracted type |

rat tail collagen polymerized at 37°C and allowed to invade in the presence of EGF (5
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ng/ml) used as a chemoattractant in serum-reduced media (2% FBS). A total of 3x10°
cells were seeded and incubated for 3 days (spheroid formation), then imaged every 24
hours.
Quantification of 3D Invasion
Images were captured on an Olympus IX70 inverted microscope equipped with
an Olympus UPlan-Fluorite 4X/0.13 numerical aperture objective, a Spot RT3 Camera
(7.4 um x 7.4 um pixel size) and Spot software. Invasion distance was determined as
previously described (141). Briefly, the extreme diameter of each spheroid was
measured using FIJI at four different angles and the average diameter calculated in
Microsoft Excel. The average diameter for time zero was then subtracted from each time
point to determine the average invasion distance.
Xenograft Studies
Xenograft studies were performed as previously described with modification
(142). A detailed protocol can be found in Appendix N. Briefly for xenograft studies,
MDA-MB-231 cells (2x10°) were injected subcutaneously into the flanks of 6-9 week
old nude mice (Jackson Laboratory NU/J 002019) in 75% growth factor reduced
Matrigel (BD Biosciences, 9.9 mg/mL). Tumors were grown for 9 weeks and measured
weekly using calipers starting after 1 week. Volumes were calculated as previously
described (143). Xenograft tumors were harvested, weighed and snap-frozen in liquid
nitrogen then stored at -80°C for DNA/RNA purification or fixed in 4%
paraformaldehyde and paraffin embedded for immunohistochemistry. Lungs and liver

were harvested and portions snap-frozen in liquid nitrogen then stored at -80°C for
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DNA/RNA purification or fixed in 4% paraformaldehyde and paraffin embedded for

immunohistochemistry. Animal experiments were accomplished according to protocols

approved by the Texas A&M Animal Care and Use Committee (AUP 2014-0194).
RNA Isolation and Reverse Transcription

RNA isolation from tissues was performed using the manufacturer’s protocol
provided with the Direct-zol™ RNA MiniPrep with TRI-Reagent® kit (Zymo Research
R2052). From the isolated total RNA 2 pg was subjected to reverse transcription into
cDNA using the manufacturer’s protocol with the iScript™ cDNA Synthesis Kit (Bio-
Rad 170-8990).

Quantitative Real-time PCR (qPCR)

Q-PCR was performed as previously described (142, 144). A detailed protocol
can be found in Appendix N. Briefly, g-PCR was performed on a Bio-Rad CFX384
Real-Time PCR detection systems using FastStart Universal SYBR Green Master (Rox)
mix (Roche). Primers (Integrated DNA Technologies) for human glyceraldehyde 3-
phosphate dehydrogenase (GAPDH) were used to detect lung metastasis: forward primer
5’-CCA GGT GGT CTC CTC TGA CTT C-3’; reverse primer 5’-CCA GGT GGT GAG
GGC AAT G-3’. Mouse B-actin (forward primer 5’-GTT TGA GAC CTT CAA CAC
CCC-3’; reverse primer 5’-GTG GCC ATC TCT TGC TCG AAG TC-3’) was used as a
normalizing gene and data was analyzed by the AACr method (145, 146).

Western Blotting
Western blotting was performed as described by the manufacturer (Bio-Rad) and

as previously described (137). A detailed protocol for western blotting can be found in
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Appendix L. Briefly, lysates were prepared for western blot by first washing adherent
cultures twice with cold DPBS then harvesting with ice-cold kinase lysis buffer (25 mM
Tris, pH 7.4, 150 mM NaCl, 5 mM EDTA, 10% glycerol, 1% Triton X-100, 10 mM [3-
glycerophosphate, 1 mM sodium orthovanadate, 10 mM sodium pyrophosphate, 10 pg/L
aprotinin and 1 mM phenylmethylsulfonyl fluoride) and the cells collected using a cell
scraper. Lysates were vortexed briefly and incubated on ice for 15-30 minutes, then
centrifuged at max speed for 10 minutes in a refrigerated centrifuge. Cleared lysate was
transferred to a fresh tube and stored at -80°C or protein concentration immediately
quantified using a Bradford Assay (Bio-Rad). For western blotting, sodium dodecyl
sulfate-polyacrylamide gel electrophoresis (SDS-PAGE) was performed on equal
amounts of protein prior to transfer to nitrocellulose membranes and blocking with non-
fat dry milk (NFDM). Blots were probed with primary antibody in blocking solution
overnight at 4°C then washed 5 times for 5 minutes in tris-buffered saline and Tween 20
(TBST). Blots were incubated with secondary antibody in blocking solution for 1 hour at
room temperature then washed 5 times for 5 minutes in TBST. Washed membranes were
then incubated with enhanced chemiluminescence substrate (Western Lightening® Plus-
ECL NEL103001) for 1 minute before imaging on ImageQuant™ LAS 4000 mini
documentation system. Anti-Nck antibody (Millipore, 06-288) was diluted 1:4000 in 3%
NFDM, anti-MMP14 antibody (Millipore, MAB3328) was diluted 1:2000 in 1% NFDM
and anti-GAPDH antibody (Invitrogen, 43700) was diluted 1:10,000 in 1% NFDM. For
secondary antibodies goat anti-mouse IgG-HRP (Santa Cruz Biotechnology, sc-2055)
was diluted 1:10,000 in 1% NFDM and goat anti-rabbit [gG-HRP (Santa Cruz
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Biotechnology, sc-2030) was diluted 1:10,000 in 3% NFDM. Images were analyzed
using FIJI software.
Statistics

When comparing multiple groups with normal distributions ANOVA with a
Tukey post-hoc was used. If data did not approximate a normal distribution a Mann-
Whitney non-parametric analysis was performed or when applicable data was log
transformed. Growth curves were analyzed using a general linear model to determine
interaction between time and treatment, followed by a Tukey post-hoc analysis. For data
depicted as a box and whisker plot the bottom and top of the boxes are the first and third
quartile, respectively, whereas the band inside is the middle quartile (median). The ends
of the whiskers extend to the lowest and highest values excluding outliers. Grubbs
outlier test was used to identify and remove outliers. Significant values where a specific
p-value is not listed indicate a p-value < 0.05.

Results
Nck is Required for Individual Cell Invasion Through Matrigel

Previous work demonstrated that Nck1 is required for matrix proteolysis and
FBS-stimulated invasion of breast carcinoma cells (72). Here, we hypothesized that Nck
is required for EGF-stimulated proteolytic invasion through a laminin-rich basement
membrane (Matrigel). To test this hypothesis we determined migration and invasion of
isolated/single MDA-MB-231 cells in the presence of 10 ng/mL EGF. Figure 2.1A
shows the experimental set-up for the transwell invasion assay. Percent invasion,

calculated as the number of cells invading divided by the number of cells migrating, was
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used to compare cells transfected with siRNA oligonucleotides encoding non-targeting,
scrambled sequences (siScr), or sequences targeting MMP14 (siMMP14) or both Nck1
and Nck2 (siNck) (138). We found that loss of Nck reduced the percent of cell invasion
significantly below that of the scrambled control (siScr) and proteolysis dependent
(siMMP14) populations (Figure 2.1 A). To further test the role of Nck in invasion, we
performed an experiment using cells stably expressing shRNAs encoding non-targeting
sequences, or sequences targeting MMP14, or both Nckl and Nck2. We found that
silencing MMP14 and Nck significantly reduced invasion below the scrambled control;
however, we were unable to detect a significant difference between the MMP14 and Nck
silenced populations (Appendix A). Using siRNA it was also observed that the Nck
silenced population of cells migrated significantly (p<0.05) faster than the siScr and
siMMP14 population (data not shown), a finding suggesting that the loss of Nck may
increase the sensitivity to EGF-induced chemotaxis through a yet undetermined
mechanism. Figure 2.1B shows the morphology and density of cells after 5 hours of
migration and 18 hours of invasion. Silencing of target proteins was confirmed by
western blotting (Figure 2.1C).
Loss of Nck Reduces Multicellular Tumor Spheroid (MTS) Growth
We assessed the growth of MTSs in complete media for 5 days by measuring
spheroid area. Identical seeding densities were used for spheroid formation and after
three days, the initial spheroid areas were measured and tracked for five additional days
(Figure 2.2A-B). Loss of Nck resulted in significantly smaller (p<0.05) spheroids that

the scrambled controls (Figure 2.2C). In addition to overall MTS area, we determined
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Figure 2.1. Loss of Nck decreases individual mammary carcinoma cell invasion. MDA-MB-231 cells
were transiently transfected with small interference (si) RNA oligonucleotides encoding non-targeting
sequences (siScr) or sequences targeting MMP14 (siMMP14) or both Nck1 and Nck2 (siNck). A) Cells
were subjected to migration or invasion assays using BD BioCoat™ Invasion Chambers (left) supplied
with 8 pm PET filters uncoated or coated with a laminin-rich matrix (Matrigel) in the presence of EGF (10
ng/ml) used as a chemoattractant. A total of 5x10* cells were seeded and incubated for 5 (migration) or 18
(invasion) hours. Box and whisker plot (right) showing cell invasiveness calculated as percent invasion
(invaded cells / migrated cells * 100). Results shown summarize data from three independent experiments
performed in triplicate. Different letters indicate a significant difference (p<0.05). B) Representative
photomicrographs showing the bottom surface of filters with cells that migrated or invaded after
incubation. Scale bar represents 100 microns. C) Representative western blot (left) and quantitative
analysis (right, mean + s.d.) showing the efficacy of protein silencing using siRNA oligonucleotides.
Within each group, means with a different letters indicate statistical differences (p<0.05).
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the change in area as an indicator of growth rate. Based on changes in MTS area, the loss
of Nck significantly decreased growth rate (p<0.05) relative to scrambled controls.Of
note, the growth rates of spheroids formed by scrambled control versus
parental/untreated cells were not significantly different (p>0.05).

To determine if there was an interaction between cell area and time we applied a
general linear model to the data and found a significant interaction only at day 0. Since
there was not a significant interaction for the remainder of the time points we reanalyzed
the data only looking at the main effects, treatment (Untreated, shScr, shNck) and time.
We found that each had a significant (p<0.001) effect on spheroid area according to the
model. Based on the findings from the general linear model we subjected each time point
to one-way ANOVA analysis.

We also analyzed the change in spheroid area using a general linear model to
determine if there was an interaction between treatment (untreated, shNck and shNck)
and time. The model did not indicate any significant interactions between treatment and
time though each main effect resulted in a significant difference (p<0.001). Since there
was no interaction between treatment and time based on the general linear model, we
analyzed each time point using ANOVA analysis.

In spite of similar cell seeding densities, spheroids formed following 72 hours of
incubation were significantly smaller (p<0.05) in the Nck silenced versus control (Scr)
condition. Such difference in area could be attributed to multiple factors including
changes in proliferation, volume, and compaction of cell. Thus, we ascertained if the

differences in spheroid area were the result of proliferation or migration defect during
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spheroid formation, i.e. the initial 72 hours following seeding. The number of cells
counted with a hemocytometer following spheroid disaggregation did not differ (p>0.05)
between the Scr versus Nck-silenced condition (Figure 2.2A). The results suggest that
the loss of Nck does not alter proliferation/viability or efficiency of cell aggregation
during spheroid formation.

Loss of Nck Reduces Growth-factor Induced Multicellular Tumor Spheroid Invasion in

3D Laminin-rich Matrices
Based on our findings that Nck is required for individual cell migration in

response to EGF in the transwell invasion assay, we hypothesized that the loss of Nck
would also decrease invasion in 3D cultures of MTS in a laminin-rich matrix. To test
this prediction, we used a commercially available kit (Trevigen) following the
recommended experimental procedure with slight modifications as detailed in Materials
and Methods. The assays use a proprietary invasion matrix with properties similar to
those of Matrigel. Using parental MDA-MB-231 cells, we first determined that 5 ng/mL
of EGF constitutes a physiologically relevant dose capable of stimulating invasion
(Appendix B). Then, we formed spheroids of Scr control, MMP14-, and Nck-silenced
cells and allowed them to invade in the presence of 5 ng/mL EGF for three days. The
results show that Nck silencing significantly (p<0.05) reduced invasion distance by
greater than 30% relative to scrambled controls as early as day 1 (Appendix C) and the

decreased invasion was maintained through day 3 (Figure 2.3). Consistent with the
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Figure 2.2. Loss of Nck reduces growth of mammary carcinoma cell multicellular tumor spheroids in
laminin-rich matrices. MDA-MB-231 cells expressing short hairpin (sh) RNAs encoding non-targeting
sequences (shScr) or sequences targeting Nck (shNck) were subjected to a spheroid growth assay. A)
Representative photomicrographs of spheroid formation (left). Bar graph depicting total cell number
(center) and area (right) per spheroid (mean + s.e.m.) measured at 72 hours. Results from two independent
experiments, total 15 spheroids. Scale bar equals 500 microns. B) Representative photomicrographs of
spheroid growth. Scale bar equals 250 microns. C) Total spheroid area (left) and change in spheroid area
(right) from day 0-5 after spheroid formation (mean + s.e.m.) D. Area represents differential area (Day X —
Day 0). Results summarize data from two independent experiments; each consisted of three spheroids per

condition. * indicates p-value < 0.05.
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results from growth profiling experiments the Nck silenced spheroids were slightly
smaller (p<0.05) than the scrambled controls at day 0 (Figure 2.3B).

We found that mammary carcinoma cells cultured in 3D laminin-rich matrices
(Figure 2.3A, insets) invade through a collective streaming-like mechanism (32). Cells
located at the invasive front (leader cells) in control (Scr) and MMP14-silenced
spheroids exhibited a mesenchymal phenotype characterized by elongated invasive
protrusions that extended into the matrix. In contrast, streams of mostly rounded cells
lacking leader cell differentiation or displaying leader cells with less pronounced
protrusions were observed in Nck-silenced spheroids (Figure 2.3A). Silencing MMP14,
on the other hand, had no effect on invasion distance. This finding suggests that the
invasion defect of siNck cells in 3D laminin-rich matrices is independent of matrix
degradation by MMP14. However, our results showed negligible invasion when parental
cells were incubated in the presence of GM6001, a broad-spectrum MMP inhibitor.
Together; these results suggest that although MMP14 activity might be dispensable, the
overall MMP activity is still required for carcinoma cell invasion in 3D laminin-rich
matrices (Figure 2.4).

The siRNA silencing methodology employed for MTS assays deviated slightly
from the manufacturers established protocol (see Materials and Methods); however, we
confirmed efficacious silencing of target by western blotting in each independent
experiment (Figure 2.3C). We also tested potential effects of the transfection reagent and
the scrambled siRNA oligonucleotide in carcinoma cell invasion. We found that the

transfection reagent alone did not significantly decrease invasion distance; however,
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Figure 2.3. Loss of Nck reduces invasion of mammary carcinoma cells in 3D laminin-rich matrices.
MDA-MB-231 cells were transiently transfected with small interference (si) RNA oligonucleotides
encoding non-targeting sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck).
Subsequently, cells were subjected to a spheroid invasion assay using laminin-rich matrix (Trevigen) in
the presence of EGF (5 ng/mL). A) Representative photomicrographs of spheroids at day 0 (left insets)
and day 3 of invasion. Boxed areas were magnified to show morphology of invading cells (right insets).
Scale bar equals 500 microns. B) Box and whisker plots showing average spheroid diameter at day 0 (left)
and invasion distance at day 3 (right). Results shown summarize data from four independent experiments
(n=total number of spheroids examined) C) Representative western blot (left) and quantitative analysis
(mean =+ s.d., right) showing the efficacy of protein silencing using siRNA oligonucleotides. Cells were
grown in 2D culture for 96 hours for western blot analysis. Within each group, means with a different
letters indicate a significant difference (p<0.05).
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transfection of the scrambled siRNA resulted in a slight, but significant decrease in
invasion at day 3, but not at day 1 or day 2 (Figure 2.4). We also confirmed that the
DMSO carrier for GM6001 did not influence invasion behavior of MDA-MB-231
(Appendix D).

Loss of Nck Reduces Growth Factor Induced Multicellular Tumor Spheroid Invasion in

3D Collagen 1
Fibrillar collagen, a major constituent of the breast tissue microenvironment

(147), is known to play a major role in the mechanical properties of the mammary gland
(148). Based on our previous findings that loss of Nck reduces invasion in laminin-rich
matrices, we hypothesized that the loss of Nck would also reduce invasion in dense
collagen I matrices. To test this prediction, we prepared MTSs using cells stably
expressing non-targeting shRNAs or shRNA targeting MMP14, or Nck1 and Nck2.
Spheroids were subsequently embedded in 2 mg/mL acid-extracted rat-tail collagen type
I polymerized at 37°C/ pH7.4, a procedure that increases the density of the meshwork
and decreases the diameter of individual fibers (149). We determined that silencing of
Nck or MMP14 significantly (p<0.05) reduces invasion distances nearly 40% and 25%,
respectively, compared to scrambled controls (Figure 2.5). We also observed that loss of
Nck resulted in significantly (p<0.05) smaller spheroid size at day 0 (Figure 2.5B). In
addition, breast carcinoma cells appear to use a mix of mesenchymal and amoeboid
mechanisms of migration. Whereas invading cells in Scr spheroids displayed a typical
mesenchymal morphology, invading cells in MMP14-silenced spheroids exhibited a

more rounded, amoeboid appearance. Invading cells in the Nck-silenced spheroids, on

41



1000 Day 0
7]
c
o
5
g a a
=500 [ o LI
[0
B
g
8
a0
Untreated
. 1500 Day 1
o Wk 1000 |
500 F . . .
= = =] —_—
0 )
(ep)
= - Day 2
2 — | 1500 ay
[
e
S| 1000 f
g
= a4
Sl sof & o= T
g (=]
g 0
: 1500 ¢ Day 3
E a
‘ 1000 b !
Day0 $ = =
500 | ¢
==
0

GM6001 T & S

Figure 2.4. Invasion in 3D laminin-rich matrices requires MMPs and is not inhibited by the siRNA
transfection reagent. MDA-MB-231 cells were left untreated or transiently transfected with small
interference (si) RNA oligonucleotides encoding non-targeting sequences (siScr) or sequences targeting
MMP14 (siMMP14) or Nck (siNck). Alternatively, cells were exposed to DharmaFECT4 transfection
reagent alone (D4), or the broad-spectrum metalloproteinase inhibitor (GM6001). A) Representative
photomicrographs of spheroids cultured in the presence of EGF (5 ng/mL) and allowed to invade for 0
(insets) or 3 days. Scale bar equals 500 microns. B) Box and whisker plots showing spheroid diameter at
day 0 and invasion distance at days 1-3. Different letters represent statistically different values (p<0.05).
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Figure 2.5. Loss of Nck reduces invasion of mammary carcinoma cells in 3D collagen matrices. MDA-
MB-231 cells expressing short hairpin (sh) RNAs encoding non-targeting sequences (shScr) or sequences
targeting MMP14 (shMMP14) or Nck (shNck) were subjected to a spheroid formation assay in a collagen
I matrix in the presence of EGF (5 ng/mL). A) Representative photomicrographs of spheroids at day 0
(insets) and day 1 of invasion. Results shown summarize data from three independent experiments
performed in triplicate. Scale bar equals 500 microns. B) Box and whisker plot showing spheroid diameter
at day 0 (left) and invasion distance at day 1 (right). C) Representative western blot (left) and quantitative
analysis (right) showing the efficacy of protein silencing using shRNAs. Cells were grown in 2D culture
for western blot analysis. Different letters represent statistically different values (p<0.05).
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the other hand, exhibited a mixed phenotype (Figure 2.5A, inset) (32). We confirmed
efficacy of target protein knockdown through western blot (Figure 2.5C).
Loss of Nck in MDA-MB-231 Xenografts Reduces Primary Tumor Growth and
Metastasis

Results from experiments in 3D matrices prompted us to test the role of Nck in
tumorigenesis and metastasis. Breast carcinoma cells stably expressing non-targeting
versus Nck-targeting shRNAs were injected bilaterally into the flanks of nude mice and
tumor size was monitored for nine weeks. No differences were observed in primary
tumor initiation; however, the results show a significant reduction (p<0.05) in tumor
xenograft growth in mice injected with Nck-silenced versus control cells (Figure 2.6). In
both control and Nck-silenced groups, we observed that 7 of 7 mice developed primary
tumors in 12 (shNck) or 13 (shScr) of 14 injection sites. One mouse from shScr and two
mice from shNck group failed to develop bi-lateral tumors. We tracked tumor volume
weekly over the duration of the study and found that mice injected with the shNck cell
population had significantly (p<0.05) smaller tumors after 6 weeks post injection (Figure
2.6B). To confirm that this analysis was appropriate we applied a general linear model to
our data to determine if there was a significant interaction between time and treatment.
We found no significant interaction between time and treatment; however, we
determined each main effect was statistically significant (p<<0.001). In addition, tumor
mass was measured at experiment termination and the shNck tumors weighed (p<0.071)
less than the control tumors (Figure 2.6B). Images of visible tumors were taken at two

weeks and again at eight weeks as a visual reference for the difference in size between
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the two groups (Figure 2.6C). The levels of Nck protein in both cell populations were
confirmed by western blotting (Figure 2.6D).

The cell line and experimental model selected for the in vivo assay were also
capable of producing micrometastases in distal organs, the lungs being a primary site for
colonization. Lung samples were processed and subjected to real-time PCR to detect
human-specific GAPDH gene expression, which has been previously shown as an
indicator of human cells in mouse lung tissue due to metastasis (150). We confirmed the
specificity of the probes used in this study by testing them against human breast cancer
cDNA and mouse tissue cDNA (Figure 2.7). We observed that 4 of 7 mice injected with
shScr cells had greater than 6-fold increase in expression of human GAPDH in the lung
tissue while there were none in the shNck injected group (Figure 2.7). A conservative
threshold of 6-fold was selected based on potential bias introduced when using only a
single reference gene (151). In addition, the average fold change, calculated using the
AACt method (145), of human GAPDH in the lung tissue for the scrambled group was
greater than 40 fold higher than shNck group, with a considerable trend towards
significance (p= 0.0552). Together these results strongly suggest a role for Nck as a
regulator of breast carcinoma growth, invasion and metastasis.

Discussion

Results from this study show that Nck signaling contributes significantly to
breast cancer progression. More specifically, this study highlights the contribution of
Nck to key hallmarks of the malignant phenotype including: i) growth of primary

tumors, and ii) invasion and metastatic dissemination. These novel findings support the
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Figure 2.6. Loss of Nck reduces primary tumor growth. Six to nine week old nude mice (NU/J) received
subcutaneous, bilateral flank injections of MDA-MB-231 cells expressing short hairpin (sh) RNAs
encoding non-targeting sequences (shScr) or sequences targeting Nck (shNck). A) Summary of xenograft
tumor development 9 weeks post-injection. B) Analysis of xenograft tumor growth (left) and mass (right).
Tumor volume was assessed weekly using a caliper and tumor mass was determined after dissection at
sacrifice 9 weeks post-injection. Values represent means + s.e.m. Statistical differences are indicated
(p<0.05). C) Representative images of tumors at 2 and 8 weeks post injection. Dotted circle highlights
early tumor location. D) Western blot showing Nck levels in cells from same populations injected into
mice. GAPDH levels were used to monitor equal loading.
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Figure 2.7. Loss of Nck reduces breast carcinoma metastasis. MDA-MB-231 micrometastases in lungs
were detected 9 weeks after tumor cell injection by quantitative (q) PCR. A) Proportion of animals with
lung metastases was determined by q-PCR amplification of human GAPDH. Positive samples were
determined based on greater than 6-fold increase in human GAPDH expression level in the lungs. B)
Human GAPDH fold change was quantified to determine extent of lung metastasis. C) Human GAPDH
fold change was quantified in human cells and mouse tissue to determine human GAPDH probe

specificity. Fold change was calculated using the AACt method.
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hypothesis that Nck adaptors constitute an important signaling node integrating
microenvironmental cues promoting tumorigenesis and metastasis. This study validates
Nck as a target of intervention in aggressive breast cancer and paves the way for future
research to develop new therapeutics that specifically disable interactions of Nck with
key binding partners involved in mammary carcinogenesis.

Previous studies using 2D in vitro cultures highlighted a role for Nck, alone or in
cooperation with Src, in invadosome formation, matrix degradation, and serum-
stimulated transwell invasion (72, 100). Because activation of signaling through the
EGFR drives epithelial-to-mesenchymal transition and promotes breast cancer
metastasis (152), we specifically focused on how Nck signaling modulates the behavior
of mammary carcinoma cells in response to EGF. We postulated that Nck-dependent
actin remodeling facilitates EGF-stimulated invasion through a mechanism that involves
increased motility and matrix remodeling by MMP14. Using EGF as a chemoattractant
in a transwell system we determined that Nck depletion not only reduces the invasion
index, a ratio between cell invasion and cell migration, but it does to a larger extent than
MMP14 deficiency. This observation supports the notion that Nck promotes
invasiveness of mammary carcinoma cells through a complex, multi-layered mechanism
of regulation that involves the fine-tuning of MMP14 levels/activity at the cell surface.
Interestingly, Nck depletion resulted in a slight but significant increase in chemotaxis
toward EGF (data not shown). The seemingly increased sensitivity to EGF resulting

from Nck silencing is interesting in the light of recent findings showing that secreted
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factors released by cells deficient in Arp2/3, an actin nucleation/polymerization complex
activated downstream of Nck, alter EGF chemotaxis in a nonautonomous manner (153).

Multicellular tumor spheroids in 3D culture provide an important model to
investigate tumor biology that more closely mimics the in vivo environment (154, 155).
The present study shows, for the first time, a requirement for Nck in breast carcinoma
invasion in both 3D laminin-rich and collagen I matrices. During the course of these
studies we observed, surprisingly, that invasion in 3D laminin-rich matrices is unaffected
by MMP14 silencing, although MMP14 is required for individual/single cell invasion
through such matrices. Interestingly, breast carcinoma cells displayed a rounded
morphology and appeared to migrate using a multicellular streaming mode of migration
in 3D laminin-rich matrices. In addition, although the overall MMP activity is required
for breast carcinoma cell invasion in 3D laminin-rich matrices (Figure 2.4), MMP14 is
dispensable. Together, these results suggest that there are important differences in
mechanisms driving individual versus multicellular/collective cell invasion. The strong
inhibitory effect of Nck silencing in invasion in 3D laminin-rich matrices, on the other
hand, points to an important role of these adaptors in regulating invasiveness through
actin remodeling/cell motility independently of the surface expression/activity of
MMP14.

A major component of the breast microenvironment is fibrillar collagen; it is
known that cross-linked collagen contributes to ECM stiffening and acts synergistically
with growth factor signaling to increase invasion and metastasis (20, 147, 156).

Therefore, for our 3D invasion studies we chose acid-extracted collagen, a preparation

49



suitable for enzymatic cross-linking (140). It has been shown that highly cross-linked
collagen I more closely resembles the tissue ECM and provides an environment
conducive to testing MMP14-dependent carcinoma cell invasion (26). Using this model,
we determined that loss of Nck decreases mammary carcinoma cell invasion to a greater
extent than MMP14 silencing. Since invasion through collagen-rich matrices requires
both the accumulation/activation of MMP14 at the cell surface and actin
remodeling/increased cell motility, we speculate that a combination of both processes
underlies decreased invasiveness resulting from abrogation of Nck signaling.

Although the loss of Nck did not alter tumor initiation, tumor growth was
reduced by Nck depletion. Likewise, similar numbers of cells in shScr versus shNck
spheroids suggests that spheroid formation in 3D laminin-rich matrices was not
compromised by Nck depletion. However, the growth rate of Nck-deficient spheroids
versus control/Scr was significantly reduced over a period of 5 days following spheroid
formation. Of interest, a recent study demonstrated a role for Nck in regulating gene
expression by acting as a scaffold for the assembly of the cytoplasmic capping complex
(157), a cellular ensemble known to modulate mRNA stability. In contrast, growth of
primary mammary tumors was not affected by silencing of N-WASp (64); an Arp2/3-
nucleation promoting factor directly activated by Nck. Ascertaining the role of Nck in
tumor cell viability/proliferation and underlying mechanisms of regulation, i.e.
cytoskeletal dependence, warrants further investigation. The hypothesis that Nck
promotes tumor growth through stimulation of tumor angiogenesis is currently being

tested.
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In sum, using a combination of in vitro and in vivo models, we show here that
Nck signaling enables breast carcinoma tumorigenesis and metastasis. The present
results lay the groundwork for future research to identify new therapies that, by

specifically disabling Nck-dependent interaction, may provide alternative treatment for

patients with malignant breast cancer.
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CHAPTER III
REGULATION OF ACTIN DYNAMICS AND MEMBRANE LOCALIZATION OF

MMP14 BY NCK ENABLES BREAST CARCINOMA CELL INVASION

Introduction

Breast carcinoma invasion and metastasis requires reciprocal interactions
between tumor cells and their microenvironment. Changes in tissue architecture brought
about by these interactions are the result of both cytoskeletal rearrangements in tumor
cells and remodeling of the ECM. Invadosomes are actin-based cellular structures
enriched with MMPs that play a direct role in remodeling the extracellular matrix (130).
In cancer cells, invadosomes are specifically termed invadopodia, while in non-cancer
cells related structures are referred to as podosomes (28). Although invadopodia were
initially described in 2D cultures, recent findings suggest that related invasive structures
are also found in tissues. For example, a role for invadopodia in vivo has been linked to
invasion of basement membrane by transformed epithelial cells in the digestive tract of
D. rerio (158); intravasation, extravasation and lung metastasis of mammary cells (64,
159), and breaching of the basement membrane and invasion by anchor cells in C.
elegans (160, 161). Together, these findings highlight invadopodia as important
organelles used by malignant tumor cells in invasion and metastasis.

The formation of invadopodia involves localized actin polymerization stimulated
primarily by the Arp2/3 complex. Activity of the Arp2/3 complex is greatly enhanced by

the nucleation promoting factor N-WASp (130). Regulatory domains and motifs located
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in the N-terminal region of N-WASP enable protein-protein and lipid-protein
interactions that alter the molecular conformation of N-WASp and modulate the activity
of the Arp2/3 complex (61). The adaptor Nck, consisting of three N-terminal SH3
domains and one C-terminal SH2 domain, has been shown to bind through its SH3
domains a proline-rich segment of N-WASp (120). Similarly, the inositol phospholipid
PI(4,5)P2 and the small GTPase Cdc42, respectively, interact with the basic region and
CDC42/Rac interactive binding (CRIB) domain in N-WASp (162). These interactions
act cooperatively to disrupt intramolecular interactions that hold N-WASp in an auto-
inhibited conformation. The relief of auto-inhibition results in exposure of the VCA
“output” region of N-WASp which becomes available to engage actin monomers and the
Arp2/3 complex (163).

Remodeling of the ECM is dependent on focalized activity of MMPs (22, 25). It
has been shown that MMP14 plays a central role in matrix degradation at invadopodia;
whereas its inactivation decreases the invasive capacity of cancer cells, the loss of other
type I collagenolytic metalloenzymes has little effect (26, 29, 131). MMP14 also acts
indirectly to degrade the ECM by activating two secreted MMPs, MMP2 and MMP9
(29). It has been suggested that intracellular trafficking is a key mechanism regulating
the cell surface levels/activity of MMP14 (29, 164).

Another important layer of regulation in breast carcinoma cell invasion is
provided by the activation of tyrosine phosphorylation, in particular activation of the
EGF receptor (EGFR) and Src (165). Tyrosine phosphorylation of scaffold proteins such

as cortactin and Tks5 by EGFR/Src generates docking sites for Nck, which is recruited
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through its SH2 domain. The resulting signaling complex drives activation of N-
WASp/Arp2/3-dependent actin polymerization, invadopodia formation, and localized
matrix degradation (72, 100). However, the exact contribution of Nck to actin dynamics
at invadopodia and membrane localization/activity of MMP14 remains poorly
understood.

We hypothesized that Nck promotes invasion and metastasis by altering actin
dynamics and membrane localization of MMP14 through spatiotemporal regulation of
Cdc42 activation.

Materials and Methods
Cell Culture

MDA-MB-231 (CRM-HTB-26) and 293T (CRL-3216) were purchased from
American Type Culture Collection (ATCC) and cultured in DMEM high glucose
(HyClone) without sodium pyruvate (MDA-MB-231) or with sodium pyruvate (293T)
supplemented with 1% penicillin/streptomycin and 10% fetal bovine serum (FBS)
(Gemini), at 37°C in an atmosphere with 5% CO,. MDA-MB-231 were sub-cultured
every 4-5 days at ~5x10° cells/cm? and 293T were sub-cultured every 4-5 days at ~2x10*
cells/cm®. For sub-culture, cells were washed twice with warm DPBS and incubated with
0.05% Trypsin/0.53 mM EDTA in HBSS without sodium bicarbonate (Cellgro™) for 5
minutes at room temperature (MDA-MB-231) or 1 minute at 37°C (293T). Trypsin was
neutralized using complete growth media and cell were centrifuged at 800 rpm for 3
minutes then re-suspended in complete media, counted by hemocytometer and plated in

plastic tissue culture plates
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Antibodies

Western blot: anti-Nck antibody (Millipore, 06-288) was diluted 1:4000 in 3%
NFDM, anti-GFP antibody was diluted 1:4000 in 3% NFDM, anti-MMP14 antibody
(Millipore, MAB3328) was diluted 1:2000 in 1% NFDM and anti-GAPDH antibody
(Invitrogen, 43700) was diluted 1:10,000 in 1% NFDM. For secondary antibodies goat
anti-mouse [gG-HRP (Santa Cruz Biotechnology, sc-2055) and goat anti-rabbit IgG-
HRP (Santa Cruz Biotechnology, sc-2030) were diluted 1:10,000 in NFDM at the same
concentration used for probing with primary antibody. Fluorescent Gelatin Degradation:
Texas Red®-X Phalloidin 1:200 (Life Technologies T7471), anti-cortactin 1:200
(Millipore #05-180), anti-MMP14 antibody 1:100 (Millipore, MAB3328), Alexa Fluor®
647Goat Anti-Mouse IgG (H+L) 1:500 (Life Technologies A-21235), NucBlue® Live
ReadyProbes® Reagent (Life Technologies R37605).

SiRNA Transfection

siRNA transfections were carried out according to the manufacturers protocol
(Dharmacon). The transfection of siRNA for all experiments was carried out with the
standard conditions of 50 nM siRNA for MT1-MMP, Nck1 and Nck2 and 25 nM
scrambled siRNA. For MDA-MB-231 cells DharmaFECT 4 transfection reagent was
used at multiple concentrations based on cell seeding density: 20x10* cells in a 35-
millimeter dish use 2.5 uL/mL DharmaFECT 4 and 30x10* cells in a 35-millimeter dish
use 3 pL/mL DharmaFECT 4. The general protocol involved incubating siRNA and
transfection reagent in separate tubes containing serum-free and antibiotic-free media for
5 minutes. The tubes were then combined and incubated for 20 minutes before the entire
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contents of the tube was added to a plate containing the appropriate volume (1.6 mL for
35-millimeter dish) of antibiotic free complete media and incubated for six hours. After
six hours the media was replaced with fresh complete media. Experiments were started
between 48 and 72 hours post transfection with siRNA based on specific assay.
Plasmids and Viral Transduction

Virus was produced as previously described with minor modification (135, 136).
A detailed description of the protocol for viral transduction can be found in Appendix P
and Appendix Q. Briefly, virus were produced in 293T cells by calcium precipitation
with pSuper.puro/hygro carrying oligonucleotide sequences (ShRNA) either non-
targeting (shScr) (scrambled sequence - Oligo2, Dharmacon non-targeting siRNA
SMARTPool) or targeting human Nck1 or Nck2 (shNck) (137) for protein knockdown.
For expression, pMSCV carrying cDNA for actin-EYFP or LifeAct EYFP was used. We
also used the Raichu Cdc42 Forster resonance energy transfer (FRET) probe (166).
Plasmids were co-transfected with pHCMV-G and pMD.gag.pol plasmids and incubated
with chloroquine (25 uM) for 4-6 hours, then media was exchanged and virus collected
20-48 hours later and either spun at 3500 rpm for 10 minutes and distributed in 1 mL
aliquots for storage at -80°C or filter sterilized with a 0.22 um syringe filter and used
immediately. MDA-MB-231 were infected in the presence of 8 pg/mL polybrene and
selected for 2-3 days in the presence of 1 pg/mL puromycin and/or 800 pg/mL
hygromycin. Lipofectamine 2000 was used according to the manufacturer’s protocols

(see Appendix J) to transiently express pcDNA3.1 MT1-MMP mCh (167).
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Western Blotting

Western blotting was performed as described by the manufacturer (Bio-Rad) and
as previously described (137). A detailed protocol for western blotting can be found in
Appendix L. Briefly, lysates were prepared for western blot by first washing adherent
cultures twice with cold DPBS then harvesting with ice-cold kinase lysis buffer (25 mM
Tris, pH 7.4, 150 mM NaCl, 5 mM EDTA, 10% glycerol, 1% Triton X-100, 10 mM [3-
glycerophosphate, 1 mM sodium orthovanadate, 10 mM sodium pyrophosphate, 10 pg/L
aprotinin and 1 mM phenylmethylsulfonyl fluoride) and the cells collected using a cell
scraper. Lysates were vortexed briefly and incubated on ice for 15-30 minutes, then
centrifuged at max speed for 10 minutes in a refrigerated centrifuge. Cleared lysate was
transferred to a fresh tube and stored at -80°C or protein concentration immediately
quantified using a Bradford Assay (Bio-Rad). For western blotting, sodium dodecyl
sulfate-polyacrylamide gel electrophoresis (SDS-PAGE) was performed on equal
amounts of protein prior to transfer to nitrocellulose membranes and blocking with non-
fat dry milk (NFDM). Blots were probed with primary antibody in blocking solution
overnight at 4°C then washed 5 times for 5 minutes in TBST. Blots were incubated with
secondary antibody in blocking solution for 1 hour at room temperature then washed 5
times for 5 minutes in TBST. Washed membranes were then incubated with enhanced
chemiluminescence substrate (Western Lightening® Plus-ECL NEL103001) for 1 minute
before imaging on ImageQuant™ LAS 4000 mini documentation system. Images were

analyzed using FIJI software.
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Fluorescent Gelatin Degradation Assay

Fluorescent gelatin degradation was performed as described previously (168). A
detailed protocol can be found in Appendix F. In brief, MDA-MB-231 cells were
transiently transfected with small interference (si) RNA oligonucleotides encoding non-
targeting sequences (siScr) or sequences targeting MMP14 (siMMP14), or Nck (siNck).
A total of 7.5x10* cells were allowed to degrade 0.2% Alexa-488 conjugated gelatin for
6 hours at 37°C in an atmosphere of 5% CO, then fixed with 3.7% PFA/5% sucrose. For
labeling of actin and cortactin, cells were permeabilized with 0.2% Triton X-100,
blocked with 2% BSA and stained with Texas Red®-X phalloidin and/or immunolabeled
with anti-cortactin. For labeling of actin and MMP14, non-permeabilized cells were
blocked in 2.5% human serum/5% goat serum and then stained with Texas Red®-X
phalloidin and immunolabeled with anti-MMP14. Cells were imaged using a Zeiss
LSM780 confocal microscope equipped with a Plan-Apo 40X/1.40NA oil objective or
an Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo
60X/1.40NA oil objective, a Spot RT3 Camera (7.4 um x 7.4 um pixel size) and Spot
software. Image analysis was performed using FIJI as previously described (169, 170).
F1JI was used for image presentation by first background subtracting each channel using
rolling ball method with a radius of 50 pixels, followed by filtering gelatin channel using
Gaussian Blur with a sigma (radius) of 1.0.

Fluorescence Recovery After Photobleaching (FRAP)
FRAP was previously described with some modifications as detailed in

Appendix K (171, 172). Briefly, FRAP was performed with the following settings:

58



image acquisition pixel dwell time 0.79 ps/pixel, resolution 512 x 512 pixels, 2.4% 514
nm laser power; photobleaching pixel dwell time 90 ps/pixel, region of interest 166 x
164 pixels, 100% 514 nm laser power. After collection of pre-bleach images, the region
of interest was photobleached and recovery was measured from six sequential scans
beginning immediately after photobleaching and then at 1.94 second intervals. FRAP
data was collected from at least 30 images and 3-15 actin puncta per image from two
culture dishes per experimental group. The rate constant (k) was estimated for
fluorescence recovery by fitting data to the following equation: FI = A (1-¢™) + B,
where FI represents the percent fluorescence intensity at a given time, A represents the
percent fluorescence recovery of the bleached structure at equilibrium and B represents
percent fluorescence intensity immediately after photobleaching. Data from at least 80
actin-EYFP puncta from each experimental group were pooled for regression analysis
(GraphPad Software) to extrapolate fluorescence recovery as a function of time.
Cdc42 Activity FRET

A detailed protocol is available in Appendix T. Briefly, time-series images were
acquired of MDA-MB-231 cells expressing scrambled or Nck shRNA and the
Raichu/Cdc42 single chain FRET probe every minute for 60 minutes using a Zeiss
LSM780 confocal microscope equipped with a Plan-Apo 40X/1.40NA oil objective.
Ratio maps for visualization of Cdc42 activity were generated using Biosensor
Processing Software 2.1 in MATLAB (173). Image processing for analysis was
performed by first processing the CFP channel stack and FRET channel stack using a
3x3 median filter. Then, the median filtered stacks were used to create a ratio stack of
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the FRET channel divided by the CFP channel. Analysis area was limited to individual
cells using regions of interest and the average FRET ratio over one hour was determined.
Total Internal Reflection Fluorescence Microscopy (TIRF)

A detailed protocol is available in Appendix O. Briefly, shScr and shNck MDA-
MB-231 cell populations were transiently transfected using Lipofectamine 2000 with
pcDNA3.1 MT1-mCh (167) (see Appendix J for detailed protocol). Cells were incubated
for one hour with transfection reagent and plasmid then fresh complete media without
antibiotic was added. The cells were incubated overnight. The following day,
approximately 20 hours before TIRF imaging the cells were lifted and plated on
fibronectin coated 35-millimeter MatTek dishes. For fibronectin coating, 1 mL
fibronectin (10 pg/mL) was added directly to the glass bottom of the MatTek dish and
incubated at room temperature for 1 hour. After 1 hour the fibronectin was removed and
replaced with 200 pL of phenol-red free complete media for ~15 minutes while the cells
were lifted and counted. Approximately 4X10* cells were plated in 200 pL phenol-red
free complete media and allowed to adhere for 1 hour. After 1 hour, 2 mL of phenol-red
free complete media was added to each MatTek dish and the cells incubated at 37°C in
normal growth conditions overnight. One hour before imaging media was exchanged to
remove any non-adherent cells and to add phenol-red free complete media with 25 mM
HEPES for imaging. Imaging was performed on a Zeiss Axio Observer Z1 TIRF 3
microscope, equipped with a plan-apochromat 100X/1.46NA oil objective and a Roper
S/W PVCAM. Samples were placed on the microscope stage at 37°C with 5% CO, and

allowed to equilibrate for a minimum of 15 minutes before imaging. Samples were kept
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on the stage for approximately 1 hour 30 minutes total time for equilibration and
imaging. The TIRF angle was set at 74° and images were acquired every 3 seconds for a
total of 5 minutes.

To quantify MMP14 mobility we calculated the “displacement index” DI as
previously described (174, 175). The DI was calculated by dividing the total area of
MMP14 mCherry present during the 5 minute time-lapse (as a result of a maximum
projection) by the area of MMP14 mCherry in the first image.

Statistics

When comparing multiple groups with normal distributions ANOVA with a
Tukey post-hoc was used. If data did not approximate a normal distribution a Mann-
Whitney non-parametric analysis was performed or when applicable data was log
transformed followed by ANOVA or a student’s t-test. For data depicted as box and
whisker plots the bottom and top of the boxes are the first and third quartile,
respectively, whereas the band inside is the middle quartile (median). The ends of the
whiskers extend to the lowest and highest values excluding outliers. Grubbs outlier test
was used to identify and remove outliers. Significant values where a specific p-value is
not listed indicate a p-value < 0.05.

Results
RNAi Silencing was Specific and Effective in Targeting Nckl and Nck?2

We used a commercial siRNA silencing system manufactured by Dharmacon.

Due to the sequence homology between Nck1 and Nck2, we performed experiments to

confirm the specificity of each individual siRNA nucleotide or SMARTPool (which
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contains four different oligonucleotides against a specific target). Due to the cross-
reactivity of available anti-Nck antibodies (i.e., no discrimination of Nck1 versus Nck2),
we tested the efficacy and specificity of SMARTPool siRNAs in cells expressing
fluorescently-tagged hNck proteins. This allowed us to express each Nck protein
independently and assess specificity of the siRNAs. SMARTPool siRNAs for Nck1
showed specific silencing of Nck1 reducing hNck1-enhanced yellow fluorescent protein
(EYFP) expression by ~70%, while only a minor change of <8% was observed in
hNck2-mCherry (mCh) (Figure 3.1A). SMARTPool siRNAs for Nck2 showed specific
silencing of Nck2 reducing hNck2-mCh expression by ~65%, while only a minor change
of <5% was observed in hNck1-EYFP (Figure 3.1B). We compared individual targeting
of Nckl1 and Nck?2 to combined targeting with the two SMARTPool siRNAs and
observed a similar decrease in protein levels. When silencing Nck we also observed that
MMP14 expression levels remained relatively constant.

We also tested the four individual siRNAs that constitute the SMARTPools to
refine our silencing methodology and evaluate the effectiveness of each individual
siRNA nucleotide. We found that siNck1 Oligo #1 outperformed the other four siRNAs
including the SMARTPool; however, all individual oligos reduced protein expression by
greater than 50% (Figure 3.2A). For Nck2, Oligos #1, 2 and 4 reduced protein
expression greater than 70% and exceeded the performance of the SMARTPool, while
Oligo #3 performed poorly only reducing protein expression by ~20% (Figure 3.2B).
The MMP14 protein expression level in the siNck1 experiment was approximately the

same as the untreated control, while there was some variability in the siNck2 data.
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Figure 3.1. Nck 1 and Nck 2 SMARTPool siRNAs specifically reduce target protein levels. MDA-MB-
231 cell lines expressing human Nck1 or human Nck2 fusion proteins were treated with 50 nM individual
SMARTPool siRNAs targeting Nck1, Nck2 or Nck1 and Nck2 for 72 hours. A-B) Representative western
blot (left) and quantitative analysis (right) showing the efficacy of human Nck1 (A) or Nck2 (B) silencing
using siRNA oligonucleotides. Levels of MMP14 were determined to rule out a potential off target effect
of Nck SMARTPool siRNAs and GAPDH was used to monitor equal loading.
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Figure 3.2 Nck 1 and Nck 2 individual siRNA oligonucleotides effectively reduce target protein levels.
MDA-MB-231 cell lines expressing human Nck1 or human Nck2 fusion proteins were treated with 50 nM
individual oligonucleotide siRNAs targeting Nck1 or Nck2 for 72 hours. A-B) Representative western blot
(left) and quantitative analysis (right) showing the efficacy of human Nck1 (A) or Nck2 (B) silencing.

* Cell line expressing hNck2-mCh fusion protein and exogenous hNckl1. Levels of MMP14 were

determined to rule out a potential off target effect of Nck SMARTPool siRNAs and GAPDH was used to
monitor equal loading.
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Silencing Nck Does Not Alter Overall MMP14 Protein Levels
Based on our findings that loss of Nck reduced MDA-MB-231 invasion and

metastasis, we ascertained if Nck silencing alters the cellular levels of MMP14, a key
MMP previously shown to facilitate invasion and metastasis (26). We found that
efficacious silencing of Nck, by either siRNA transfection or sShRNA expression, does
not significantly alter (p<0.05) the overall cellular levels of MMP14 (Figure 3.3). In
addition, we confirmed that efficacious silencing of MMP14 by either siRNA
transfection or shRNA expression does not alter the overall cellular levels of Nck
(Figure 3.3).

MDA-MB-231 Gelatin Degrading Properties are Dependent on Culture Density

Because Nck silencing decreases invasion and metastasis of breast carcinoma

cells without altering the total cellular levels of MMP14, we hypothesized that Nck
depletion alters the subcellular distribution of MMP14 and/or its activity at the
membrane, and particularly, at invadopodia. To begin to test this hypothesis, we resorted
to an established assay of focalized degradation of a fluorescent matrix (168) that
estimates membrane-associated proteolysis, and therefore, allowed us to make inferences
on the activity of MMP14 at the cell’s surface. To validate this approach, the effect of
MMP14 silencing on fluorescent matrix degradation was assessed in parallel. Figure
3.4A shows how cells plated on fluorescent gelatin form invasive structures
(invadopodia) that are enriched in MMPs, protrude into the matrix, and as a result of
focalized degradation leave dark, non-fluorescent spots. This allows quantification of the

areas of degradation for comparative analysis.
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Figure 3.3. Silencing of Nck does not alter total MMP14 levels in mammary carcinoma cells. A-B)
Representative western blots (left panels) and analysis of protein levels (right panels) showing efficacy of
protein silencing in MDA-MB-231 cells transiently transfected with small interference (si) RNA
oligonucleotides (top) or stably expressing short hairpin (sh) RNAs (bottom) encoding non-targeting
sequences (Scr) or sequences targeting MMP14 or Nck. Protein levels (mean + SD), expressed as percent
of Scr control, include three independent experiments. Different letters represent statistically different
values (p<0.05). GAPDH was used as a loading control and for normalization of protein levels.
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Figure 3.4. Structural analysis of invadopodia by confocal imaging. A) Mammary carcinoma cells form
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equals 10 microns. B) A region of interest from a confocal image showing an invadopodium and an actin
puncta. Structures showing colocalization of F-actin and cortactin were defined as invadopodia. Scale bar

equals 1 micron.
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When MDA-MB-231 cells were cultured at “high density” (cells initiated in
culture at 3.3x10* cells/cm?) and grown for 2-3 days we observed decreased capacity to
degrade fluorescent gelatin when compared to cells cultured at “low density” (cells
initiated in culture at 5.4x10° cells/cm®) (Figure 3.5). Even though both populations were
seeded at 6.0x10° cells/cm” on fluorescent gelatin and grown for 6 hours, when pre-
cultured at high density only 16.5% of the siScr population and 16% of the siNck
population degraded gelatin. When pre-cultured at low density, greater than 50% of the
siScr population actively degraded gelatin while 36% of the Nck population was active.
The pre-culture density had a similar impact on gelatin degrading capacity of MMP14-
silenced cells, although as expected, these cells were considerable less active.

Loss of Nck Reduces Matrix Degradation by Breast Carcinoma Cells

Since gelatin degradation requires the focalized activity of MMPs at invadopodia
(Figure 3.4), we determined whether Nck modulates the gelatin degrading capacity of
MDA-MB-231. The results show that Nck silencing decreases the percent of actively
degrading cells in the population (Figure 3.6). In addition, we performed an alternate
analysis on only the subset of cells actively degrading matrix and determined there was a
decrease in the degradation index (Figure 3.6B). We also ascertained the involvement of
MMP14 dependent proteolysis in gelatin degradation. The data showed a significant
decrease in both the percent of active degrading cells and the degradation index as a
result of MMP14 silencing (Figure 3.6). Efficient silencing of target proteins was
confirmed by western blot (Figure 3.6C). These results expand findings from previous

work on the role of Nck in localized matrix degradation (72) and suggest that reduced
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Figure 3.5. Culture density affects matrix remodeling by mammary carcinoma cells. MDA-MB-231 cells
were transiently transfected with small interference (si) RNA oligonucleotides encoding non-targeting
sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck). After transfection, cells
were cultured at high (3.3x10* cells/cm?) or low (5.4x10° cells/cm?) densities for 2-3 days. Subsequently,
cells from both populations were seeded at the same density (6.0x10° cells/cm”) on fluorescent gelatin-
coated coverslips and incubated for 6 hours before fixation and staining with fluorescent phalloidin to
visualize cytoskeletal F-actin. A) Representative immunofluorescence images depicting fields of
degrading cells and specific areas of degradation. Inset highlights specific regions of degradation. Scale
bar represents 20 microns. B) Bar graph depicting percentage of cells actively degrading the fluorescent
matrix (siScr n=60, siMMP14 n=30, siNck n=133).
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Figure 3.6. Loss of Nck decreases matrix degradation by mammary carcinoma cells. MDA-MB-231 cells
were transiently transfected with small interference (si) RNA oligonucleotides encoding non-targeting
sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck). Subsequently, cells were
seeded on fluorescent gelatin-coated coverslips and incubated for 6 hours before fixation and staining with
fluorescent phalloidin to visualize cytoskeletal F-actin. A) Representative confocal images depicting fields
of degrading cells (left). Boxed areas were magnified and single channel/merge images are displayed
(right). Scale bar represents 20 microns. B) Percentage (mean + SD) of active cells (top, degrading cells)
and degradation index (bottom, degradation area per active cell / cell area). Different letters represent
statistically different values (p<0.05). Results shown summarize data from three independent experiments.
C) Representative western blot showing the efficacy of protein silencing using siRNA oligonucleotides.



matrix remodeling resulting from Nck abrogation is due, at least in part, by decreased
accumulation/activity of MMP14 at the cell surface.
Loss of Nck Reduces the Number of Actin Puncta and Invadopodia Formed by Breast
Carcinoma Cells
We hypothesized that disruption of invadopodia formation contributes to
decreased matrix degradation. Thus, we performed a detailed quantitative image analysis
of invadopodia formation by MDA-MB-231 cells plated on fluorescent gelatin and
subjected to F-actin staining and endogenous cortactin immunolabeling (Figure 3.4). We
defined invadopodia as the colocalization of actin and cortactin (Figure 3.4B). We
intentionally excluded degradation as a third marker for invadopodia to include
invadopodia pre-cursors as well as mature invadopodia (176, 177). Therefore, our
analysis differentiates invadopodia (colocalization of F-actin and cortactin) from actin
puncta (focalized F-actin without cortactin accumulation). The results show that
silencing Nck or MMP14 decreased (p<0.05) both the size and number of actin puncta
and invadopodia formed by MDA-MB-231 (Figure 3.7). In both Nck- and MMP14-
silenced populations, actin puncta and invadopodia were approximately 20-25% smaller
when compared to similar structures in the scrambled control population. In addition, the
distribution of cells according to the number of actin puncta or invadopodia per cell was
altered in Nck- and MMP14-silenced populations versus the scrambled control.
Remarkably, only 10-20% of the cells in the Nck or MMP14 silenced populations had
greater than 20 puncta or invadopodia per cell, while more than 60-70% of the cells in

the scrambled population had greater than 20 puncta or invadopodia per cell.
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Figure 3.7. Loss of Nck reduces the number and size of actin puncta and invadopodia. MDA-MB-231
cells were transiently transfected with small interference (si) RNA oligonucleotides encoding non-
targeting sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck). Cells were seeded
on coverslips coated with fluorescent gelatin, incubated for 6 hours, and subsequently stained with an anti-
cortactin (CTTN) antibody and fluorescent phalloidin (F-actin). A) Representative confocal images of
MDA-MB-231 cells depicting overlays of actin, cortactin and gelatin. Boxed areas were magnified and
single channels/merge images in the X/Y planes are displayed. Scale bar equals 10 microns. B) Area of
actin puncta and invadopodia. Different letters represent statistically different values (p<0.001). C)
Distribution of cells as a function of the number of actin puncta/invadopodia displayed. Invadopodia were
defined as colocalization of actin puncta with cortactin. Three independent experiments were performed.
A minimum of 30 cells/condition and a range of 313-715 actin puncta/invadopodia were analyzed.
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These results, showing that silencing of Nck or MMP14 decrease invadopodia/actin
puncta formation to a similar extent, support the hypothesis that the reduction in
fluorescent matrix remodeling caused by Nck silencing is due, at least in part, to
decreased MMP 14 accumulation/activity at the plasma membrane.

Loss of Nck Reduces the Ratio of F-actin to Cortactin in Invadopodia

Based on our observations that invadopodia size was decreased when Nck was
silenced and previous findings that cortactin phosphorylation is linked to Nck-stimulated
actin polymerization (72, 178); we hypothesized that Nck silencing alters the ratio of F-
actin to cortactin in invadopodia. To test this predication, we analyzed invadopodia
formed by MDA-MB-231 cells plated on fluorescent gelatin and determined, indeed,
there was a significant (p<<0.001) decrease (~25%) in the ratio of F-actin to cortactin in
Nck- and MMP14-silenced cells versus scrambled controls (Figure 3.8).
Loss of Nck Alters Actin Dynamics at Actin Puncta
Fluorescence recovery after photobleaching (FRAP) microscopy allows the

determination of the rate constant for actin diffusion into the local area of actin
structures. This relates to actin polymerization through the availability of actin
monomers for polymerization into the filamentous structures. We performed FRAP
microscopy with MDA-MB-231 stably expressing actin-EYFP cultured on fibronectin
coated MatTek dishes. We found through transient silencing of Nck that the rate of
actin-EYFP recovery at actin puncta was decreased relative to scrambled controls

(Figure 3.9). Representative images and a graphical plot of the photobleaching process
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Figure 3.8. Loss of Nck reduces the ratio of F-actin to cortactin accumulation in invadopodia. MDA-MB-
231 cells were transiently transfected with small interference (si) RNA oligonucleotides encoding non-
targeting sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck). Cells were seeded
on coverslips coated with fluorescently-labeled gelatin, incubated for 6 hours, and subsequently stained
with anti-cortactin (CTTN) and fluorescent phalloidin (F-actin). A) Representative XZ projection from
confocal images showing actin, cortactin and gelatin. B) Ratio of F-actin to cortactin area at invadopodia
(mean + s.e.m.). Invadopodia were defined as colocalization of F-actin clusters with cortactin. Different
letters represent statistically different values (p<0.001). Data extracted from a minimum of 30
cells/condition and a range of 313-667 invadopodia from three independent experiments.
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and subsequent recovery of signal in the region of invasive structures are depicted in
Figure 3.9 A and B. We calculated the rate constant for recovery using the equation
FI=A (1 — ™) + B as previously described (171). Figure 3.9B (left) represents how each
component was determined from the fluorescent intensity recovery curves. Figure 3.9B,
right shows that the recovery rate for shScr was significantly faster (p<0.001) than
shNck.

Loss of Nck Decreases Localization of MMP14 at the Ventral Cell Surface

Based on our findings that gelatin degradation was reduced but total cellular
MMP14 levels remained unchanged in Nck silenced cells, we hypothesized that Nck
plays a role in the membrane targeting/accumulation and mobility of MMP14. To
determine whether loss of Nck altered localization of MMP14 at the ventral cell surface,
we performed time-lapse TIRF imaging of breast carcinoma cells co-expressing Life-Act
EYFP, an F-actin probe (179), and MMP14 mCherry. To quantify the localization of
MMP14 at the ventral surface we used a previously described method for determination
of the “displacement index” (174, 175). The displacement index (DI), an estimate of
MMP14 mobility, was calculated as the total area of MMP14 over the entire time-lapse
divided by the area of MMP14 in the initial frame of the series. Based on this
methodology, the silencing of Nck resulted in greater than 60% decrease of MMP14
mobility at the ventral surface (Figure 3.10).

As a complementary approach, we plated siRNA treated cells on fluorescent

gelatin and performed quantitative imaging of fluorescently labeled actin and
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Figure 3.9. Loss of Nck reduces rate of actin polymerization at invadopodia. MDA-MB-231 cells were
transiently transfected with small interference (si) RNA oligonucleotides encoding non-targeting
sequences (siScr) or sequences targeting Nck (siNck). Subsequently, cells were seeded on fibronectin
coated coverslips and incubated for 20 hours before FRAP microscopy. A) Representative confocal
images depicting fluorescence recovery after photobleaching at invadopodia. Scale bar represents 2
microns. B) Rate (mean + s.e.m.) of fluorescence recovery. * p<0.05. C) Representative plot of initial
fluorescence intensity and recovery after photobleaching. Results shown are from a single experiment
representative of data from three independent experiments. Data collected from a minimum of 30 images
(3-15 puncta per image) from two culture dishes per experimental group.
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Figure 3.10. Loss of Nck decreases ventral surface mobility and polarized activity of MMP14 in breast
carcinoma cells. MDA-MB-231 cells expressing MMP14-mCherry, LifeAct EYFP and short hairpin (sh)
RNAs encoding non-targeting sequences (shScr) or sequences targeting Nck (shNck) and were cultured on
fibronectin in the presence of complete medium and imaged every 3 seconds for 5 minutes. A)
Representative TIRF images taken from time-lapse series. Images are presented using an intensity
modulated display to associate intensity (activity) with color and hue (red = high activity; blue = low
activity) or with vesicles highlighted red on black cell area background. Scale bar represents 10 microns.
B) Displacement index (DI) was calculated by dividing the total area of MMP 14 mCherry present during
the 5 minute time-lapse (as a result of a maximum projection, magenta, right panel) by the area of MMP14
mCherry in the first image (green, left panel). Bar graph depicting displacement index (mean + s.e.m.,
left). A total of 20 cells (time-lapse series) from three independent experiments were analyzed. ***
indicates p<0.001. (adapted from 175)
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endogenous MMP14 detected by immunolabeling (Figure 3.11). Confocal sections of
the ventral cell surface were captured and MMP 14 intensity per cell was normalized to
the cell area. Based on this analysis we observed a significant reduction in MMP14
signal in the most ventral focal planes encompassing the cell membrane and membrane
proximal areas, even though total MMP14 protein was unchanged as confirmed by
western blot (Figure 3.11A).
Loss of Nck Increases Total Cdc42 Activity at the Ventral Cell Surface

Breast carcinoma invasion, migration and metastasis have been linked to Cdc42
activity levels and total abundance in highly metastatic breast cancer cells (180, 181). In
addition, Cdc42 is critical for invadopodia formation through activation of N-WASp for
actin polymerization and for polarized accumulation of MMP14 at invadopodia through
interactions with IQGAP (167). To determine if Nck modulates the spatiotemporal
patterns of Cdc42 activation, we performed time-lapse confocal imaging of the ventral
surface of MDA-MB-231 cells expressing the Raichu Cdc42-FRET biosensor (182). The
results show that silencing of Nck results in a greater than 20% increase over scrambled
control in levels of active Cdc42 at the ventral surface (Figure 3.12).

Discussion

Our findings that the loss of Nck reduced invasion and metastasis prompted us to
elucidate the underlying cellular and molecular mechanisms. Previous studies
established that invadopodia formation and matrix remodeling capacity of mammary
carcinoma cells directly correlate with their invasive and metastatic potential (56). To

investigate the mechanism of Nck-dependent invasion we focused on regulation of actin
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Figure 3.11. Loss of Nck decreases ventral surface accumulation of MMP14 in active breast carcinoma
cells. MDA-MB-231 cells were transiently transfected with small interference (si) RNA oligonucleotides
encoding non-targeting sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck).
Cells were seeded on coverslips coated with fluorescent gelatin, incubated for 6 hours, and subsequently
stained with anti-MMP14 (MMP14) and fluorescent phalloidin (F-actin). Samples were imaged from top
to bottom of gelatin in five 0.5 micron z-slices. A) Graphical representation of actin and MMP14
localization at invadopodia. Green area indicates planes imaged by confocal microscope to measure
MMP14 intensity at ventral surface of cell. B) Representative immunofluorescence images depicting
single cells and X-Z planes of actin, MMP14, and fluorescent gelatin. Scale bar represents 10 microns.
Representative western blot showing similar MMP14 protein levels in siScr and siNck and the efficacy of
protein silencing using siRNA oligonucleotides. C) Boxplot of MMP14 intensity in arbitrary units at the
most ventral plane in each condition (left). Bar graph depicting relative intensities (mean + s.e.m.,
arbitrary units) of MMP14 normalized to the control of each plane imaged (right). Different letters within
each group are different (p<0.05).
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Figure 3.12. Loss of Nck increases Cdc42 activity at the ventral surface of invasive mammary carcinoma
cells. MDA-MB-231 cells expressing the Raichu Cdc42 FRET biosensor and either short hairpin (sh)
RNAs encoding non-targeting sequences (shScr) or sequences targeting Nck (shNck) were plated on
fibronectin in the presence of complete medium. Confocal, time-lapse images of the ventral surface of the
cells were acquired every minute for 30-60 minutes. A) Representative FRET/CFP ratio images taken
from time-lapse series. Images are presented using an intensity modulated display to associate intensity
(activity) with color and hue (red = high activity; blue = low activity). B) Quantitative analysis of FRET
activity (mean +/- s.e.m., *** p-value <0.001) in arbitrary units (A.U.). FRET ratios were collected for
each cell in 2-4 fields (2-4 cells per field) for every time point for analysis: n=642.
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dynamics and cell surface exposure/activity of MMP14 in breast carcinoma cells. It has
been shown that MMP14 is critical for tumor cell invasion (26), and evidence suggests
that N-WASp is involved with anchoring MMP14 to invadopodial F-actin (65).
Considering that Nck recruits and strongly activates N-WASp (121, 124), we
hypothesized that Nck-modulation of actin dynamics regulates MMP14
accumulation/activity at invadopodia. To test this, we first ascertained that specific
silencing of Nck does not alter the overall cellular levels of MMP14. Because recent
evidence suggests that intracellular trafficking is an important mechanism regulating the
activity/surface exposure of MMP14 (29, 164, 183-186), we speculated that altered
function or localization of MMP14 at the cell surface contributes to the reduction in
invasion and metastasis resulting from abrogation of Nck signaling.

The gelatin degradation assay (168) is an established, powerful method for the
assessment of invadopodia dynamics and focalized, membrane-associated (MMP14-
dependent ) matrix degradation. In the course of our experiments, we identified that the
matrix remodeling activity of mammary carcinoma cells is dependent on the history of
the culture, i.e. cells cultured at high versus low densities display, respectively,
decreased and increased indexes of matrix degradation. This unexpected yet important
observation could be explained, presumably, by decreased expression levels of MMPs
when cells reach high densities in 2D tissue culture conditions as previously suggested
(187). The sensitivity to culture conditions highlights the need for careful interpretation
when comparing findings generated by multiple groups, even when using the same

materials and cell lines. This observation led us to perform subsequent experiments
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using optimized cultures, namely cells cultured at low densities that express full invasive
potential.

Results from our experiments using the fluorescent matrix degradation assay
show that cells with Nck or MMP14 silenced display decreased indexes of matrix
remodeling when compared to scrambled control cells. MMP14 silencing had a more
pronounced effect on matrix remodeling than Nck silencing; however, both conditions
altered actin dynamics to a similar extent. Thus, results from this study suggest that the
Nck-dependent matrix remodeling is mediated, at least in part, by altered surface
accumulation/activity of MMP14. Our findings that Nck silencing reduces endogenous
MMP14 accumulation and mobility of MMP14 at the membrane/membrane proximal
region of the cells provide strong support to the notion that loss of Nck disrupts MMP14
trafficking and/or membrane localization. Of interest, when cells were plated on non-
permissive poly-L-lysine coated glass coverslips, we were unable to detect differences
between the Nck silenced and scrambled control cells (Appendix E). Thus, a permissive
stratum appears important for the efficient formation and full maturation of degrading
invadopodia.

Altered actin dynamics in the Nck-deficient cells is likely a significant factor
contributing to decreased invasiveness. Nck has been shown to associate with both
cortactin and Tks5 to regulate N-WASp mediated actin polymerization at invadopodia
(72, 100). Our results showing a decrease in the ratio of F-actin to cortactin in response
to Nck silencing suggests structural defects in invadopodia formation that could

potentially limit their transition to mature, fully invasive structures. The reduced rate of
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recovery observed in our FRAP data also provides support that the loss of Nck alters the
actin dynamics at invadopodia. Our results demonstrate that the loss of Nck reduces both
the activity and number of invadopodia formed by invasive breast carcinoma cells.
Clearly, further studies are necessary to fully dissect the contributions of Nck to tumor
cell invasion through actin dynamics versus MMP-mediated proteolysis and matrix
remodeling.

Cdc42 is a key GTPase that controls cell polarity/directional migration,
cytoskeletal dynamics, polarized delivery of MMP14 at invadopodia, and invadopodia
formation (56, 82-87, 167). In highly invasive cancer, overexpression of constitutively
active Cdc42 or hyperactivation of endogenous Cdc42 impairs invasion (180, 188). We
have shown that silencing Nck in endothelial cells increases Cdc42 activation in
conjunction with increased formation of transient, multidirectional protrusions
associated with the loss of directional cell migration in endothelial cells (137).
Consistent with our previous findings, we show that silencing of Nck increases Cdc42
activity and decreases the invasive characteristics of invasive breast carcinoma. Our
findings suggest that Nck silencing leads to dysregulated activation of Cdc42 at the
ventral surface, and consequently, altered directional migration and polarized trafficking
of MMP14.

In conclusion, this study provides new mechanistic insights suggesting that Nck
modulates the spatiotemporal activation of Cdc42 to coordinate actin dynamics with the

targeted delivery of MMP14 to invadopodia.
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CHAPTER IV

SUMMARY AND CONCLUSIONS

Even with the ongoing development of new treatments, increased awareness, and
improved screening methodologies, breast cancer remains a major health problem in the
United States and worldwide. The lack of effective therapies for metastatic breast
cancer, which accounts for greater than 90% of deaths due to this malignancy (11),
represents a daunting challenge for scientists and clinicians. Thus, a better understanding
of cancer biology, including the identification of new markers for early detection and
new molecular targets for intervention, remains a critical need. We investigated the role
of the SH2/SH3 domain containing Nck adaptor proteins, critical links between tyrosine
phosphorylation and cytoskeletal remodeling, in breast cancer invasion and metastasis.
Results from this study fill an important gap in our knowledge of how signaling
integration by adaptors/scaffold proteins contributes to breast cancer progression by
demonstrating that Nck promotes i) primary tumor growth, and ii) tumor invasion and
metastasis.

For the first time, we show a requirement for Nck in breast carcinoma growth in
3D laminin-rich matrices and invasion in both 3D laminin-rich and collagen matrices.
Loss of Nck also reduces both individual/single cell and collective cell invasion through
laminin-rich matrices in response to EGF stimulation. We identified a requirement for
MMP14 for individual/single cell invasion that was not required for collective invasion

in laminin-rich matrices, a finding demonstrating important differences in mechanisms
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driving distinct invasion modes. Using a nude mouse xenograft model, we also
determined, though not required for tumor initiation, Nck signaling is a significant
contributor in primary tumor growth and metastasis. These results validate Nck as an
important target in aggressive breast cancer and lay the groundwork for future research
to develop new and more efficacious therapeutics.

To better understand the mechanisms associated with reduced invasion and
metastasis of breast carcinoma cells deficient in Nck signaling, we determined the
dynamics of invadopodia formation and surface accumulation/activity of MMP14, a key
matrix remodeling enzyme. We determined that, although the total cellular levels of
MMP14 remained unaltered, the loss of Nck decreased invadopodia biogenesis and
focalized matrix degradation. The attenuation of cellular mechanisms of invasion was a
result of decreased accumulation of MMP14 at the ventral surface of invasive cells and
altered actin dynamics at invadopodia. Importantly, Nck deletion led to increased,
mislocalized activation of Cdc42, a key regulator of intracellular trafficking and
directional cell migration. Our results support a model whereby Nck, by integrating
extracellular signals that modulate cytoskeletal dynamics, specifies patterns of
spatiotemporal activation of Cdc42 and the targeted delivery/membrane accumulation of

MMP14 thus facilitating invadopodia formation and maturation.
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Future Directions
We have demonstrated a role for Nck in invasion and metastasis of highly
metastatic, triple negative breast cancer cells. The present findings provide a foundation
for future studies to address:
e The role of Nck in other cell and tumor types
e Mechanisms of Nck-dependent modulation of tumor growth, including
cell autonomous and non-autonomous regulation
e Contributions of Nck to tumor-associated disruption of the tissue
architecture and angiogenesis
e Identification of the molecular mechanism underlying Nck-regulated
Cdc42 activation
e Role of Nck in extracellular matrix remodeling and tumor cell-matrix
adhesion in three dimensional cultures and tissues
e Efficacy of peptides/peptidomimetics to block specific Nck/effector

interactions
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APPENDIX A

SHRNA TRANSWELL INVASION ASSAY
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Loss of Nck decreases individual mammary carcinoma cell invasion. MDA-MB-231 cells stably
expressing short hairpin (sh) RNAs encoding a non-targeting sequence (shScr) or sequences targeting
MMP14 (shMMP14) or Nck (shNck). Cells were subjected to migration or invasion assays using BD
BioCoatTM invasion chambers supplied with 8 micron PET filters uncoated or coated with a laminin-rich
matrix (Matrigel) in the presence of EGF (10 ng/ml) used as a chemoattractant. A total of 5x10” cells were
seeded and incubated for 5 (migration) or 18 (invasion) hours. A) Box and whisker plot showing cell
invasiveness calculated as percent invasion (invaded cells / migrated cells * 100). Results shown
summarize data from one experiment performed in triplicate. B) Representative western blot showing the
efficacy of protein silencing using shRNA oligonucleotides. a, b indicate statistical differences (p<0.05).
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APPENDIX B

3D SPHEROID INVASION EGF STIMULATION STANDARDIZATION
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Epidermal growth factor (EGF) stimulates invasion of mammary carcinoma cells in 3D laminin-rich
matrices. Spheroids of MDA-MB-231 cells were allowed to invade in the presence of reduced serum
medium (RSM) or RSM supplemented with various concentrations of EGF. A) Representative images of
MDA-MB-231 spheroids at day 0 (insets) and day 3 of invasion. Scale bar equals 500 microns. B) Bar
graphs showing average spheroid diameter at day 0 and EGF-stimulated invasion distance following
various intervals of incubation. Error bars on bar graphs indicate standard deviation. Spheroids (n) per
condition: RSM n=1, 5-50ng/mL EGF n=2.
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3D SPHEROID INVASION IN LAMININ-RICH MATRICES: DAY 1 AND DAY 2

APPENDIX C
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Loss of Nck reduces invasion of mammary carcinoma cells in 3D laminin-rich matrices. MDA-MB-231
cells were transiently transfected with small interference (si) RNA oligonucleotides encoding non-
targeting sequences (siScr) or sequences targeting MMP14 (siMMP14) or Nck (siNck). A-B)
Representative photomicrographs of spheroids (upper) after 1 (A) or 2 (B) days of invasion and box and
whisker plots showing invasion distance (lower). Different letters represent statistically different values
(p<0.05). Results shown summarize data from four independent experiments (n=3-6 spheroids/condition).
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APPENDIX D

3D SPHEROID INVASION GM6001 CONTROL
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The general MMP inhibitor GM6001, but not the vehicle DMSO, inhibits mammary carcinoma cell
invasion in 3D laminin-rich matrices. Spheroids of MDA-MB-231 cells were allowed to invade in
complete medium supplemented with 50 ng/mL of EGF in the absence or presence of DMSO (%vol/vol)
or DMSO plus 25 mM GM6001. A) Representative images of spheroids at day 0 (insets) or day 4 of
invasion. Scale bar equals 500 microns. B) Box and whisker plot (right) showing spheroid diameter at day
0 (left) and invasion distance at day 4 (right). Different letters represent statistically different values
(p<0.05). Data from one experiment performed in duplicate.
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APPENDIX E

IMMUNOFLUORESCENCE OF MEMBRANE MMP14
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Steady-state membrane MMP14 levels are independent of Nck expression on poly-L-lysine coated glass.
MDA-MB-231 cells were plated on poly-L-lysine and fixed but not permeabilized. Subsequently, cells
were stained with control isotype IgG (cilgG) or an antibody that recognizes the extracellular, catalytic
domain of MMP14. Pseudocolor Z-projections of confocal stacks were generated after background
subtraction. Pseudocolored images show nuclei (blue) and MMP14 A) or non-specific binding of cilgG B)
at the cell surface. White scale bar represents 10 microns. C) Fluorescence intensity was normalized to
siScr for each experiment then replicates combined to generate relative fluorescence. Different letters
represent statistically different values (p<0.05). D) Representative western blot showing efficacy of
protein silencing.
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APPENDIX F

FLUORESCENT GELATIN DEGRADATION

Part 1: Gelatin Labeling

Materials:

0.2% Gelatin
a. 20 mg Gelatin from porcine skin, type A (Sigma Cat. No. G2500)
b. 10 mL DPBS
c. Incubate in a 37C water bath for 30 minutes vortex ever 5-10 minutes to
help dissolve
d. Filter sterilize dissolved gelatin with 0.2 um syringe filter

e Alexa Fluor 488 protein labeling kit (Invitrogen Cat. No. A10235)
e | M sodium bicarbonate (prepare fresh, filter sterilize)
¢ Ring stand and clamp
e Amber-colored microcentrifuge tubes
Procedure:

Perform in biosafety cabinet with the lights turned off to protect gelatin from
contamination and photo degradation of the Alexa dye.

1.
2.

3
4,

Prepare 0.2% gelatin in DPBS and filter sterilize
Combine 50 pL 1 M sodium bicarbonate and 500 pl 0.2% gelatin in a tube
containing the reactive dye and stir bar
Mix at room temperature protected from light, on a stir plate for 1 hour
Load resin from Alexa Fluor Protein Labeling kit into provided column up to 3
centimeters from the top
a. Allow excess buffer (provided with kit, DPBS + 2 mM sodium azide, pH
7.2) to flow out of column
Load labeled gelatin into column
a. Collect excess buffer in 500 pL aliquots and keep loading clean buffer
(also in 500 aliquots) until 1** fraction flows out
Collect 1** fraction containing the Alexa 488-labeled gelatin
a. Excess unlabeled gelatin will be in the 2™ fraction
Prepare 100 pL aliquots in amber-colored microcentrifuge tubes
a. Store at -20°C.

Part 2: Fluorescent gelatin coating coverslips Perform in biosafety cabinet with the

lights turned off to protect gelatin from contamination and photo degradation of the
Alexa dye.

Materials:

0.2% Gelatin (see protocol in Part 1)
Labeled gelatin from Part 1
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Acid-washed 18-millimeter coverslips
DPBS, at room temperature
0.5% gluteraldehyde (need 1 mL per coverslip)
o Dilute from 50% (Electron Microscopy Sciences, Cat. No. 16320) stored
at 4°C) in DPBS and filter sterilize. Must be prepared directly before use.
5 mg/mL sodium borohydride (need 1 mL per coverslip) dissolved in DPBS
o Filter sterilize
o Must be prepared directly before use
Sterile forceps

Procedure:

1.

2.

SNk w

10.

11

13.
14.

15.

Place acid-washed, sterile 18-millimeter coverslips in individual wells of 12-well
plate
Add 1 mL of 0.005% poly-L-lysine solution per coverslip (0.01% poly-L-lysine,
Cultrex 3438-100-01)
a. Make a 1:1 dilution of stock poly-L-lysine in DPBS in a tube chilled on
ice
Incubate 20 minutes at RT, then aspirate solution
Wash three times with DPBS (1 mL each wash)
Incubate coverslip in 1 mL of 0.5% gluteraldehyde for 15 minutes
Mix 0.2% gelatin and Alexa labeled gelatin (from Part 1 above) at an 8:1 ratio
and incubate in a 37°C water bath to warm the mixture
a. You will need 80 pL of the fluorescent gelatin matrix for each coverslip
(make enough of this solution for n+1 coverslips)
Aspirate gluteraldehyde and wash coverslips three times with 1 mL of DPBS
a. Do not aspirate DPBS after the 3" wash
Cut a sheet of parafilm and place it in a humidified chamber
a. Humidified chamber is a 150-millimeter tissue culture plate covered with
aluminum foil and a piece of Whatman paper wetted with ddH,O placed
in the bottom
Place 80 pL droplets of the preheated fluorescent gelatin on the Parafilm far
enough apart to allow placement of coverslips without overlap
Using forceps, lift coverslips out of 12-well plate and place them directly on
fluorescent gelatin

. Incubate 45 minutes at RT
12.

Carefully lift each coverslip and transfer to individual 12-well plates

a. IMPORTANT: make sure to place them with the fluorescent gelatin

facing up

Wash three times with DPBS (1 mL each wash)
Quench residual reactive groups in the gelatin matrix with 5 mg/mL sodium
borohydride

a. Add 1 mL of the solution to each well as soon as it starts bubbling
Incubate 15 minutes at RT with gentle rocking
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a. Ensure bubbles are released from beneath the coverslips
b. Do not allow bubbles to settle on the side of the coverslip coated with the
gelatin matrix to prevent damaging the gelatin

16. Wash three times with DPBS (2 mL each wash)

a. If bubbles persist continue to wash until they have been eliminated

17. Incubate 30 minutes with 70% EtOH protected from light
18. Wash three times with DPBS (1 mL each wash)

a. Do not aspirate DPBS after last wash and wrap each plate with parafilm
and aluminum foil to prevent contamination and exposure to light

19. Store coated coverslips at 4°C for up to 6 days or use immediately

a. Itis best coat coverslips the day before use

Part 3: Cell Preparation and Immunofluorescence Staining

**Protect your samples from light by wrapping your plates in aluminum foil when not
handling them.
Materials:

3.7% Paraformaldehyde

5% Sucrose

0.2% Triton X-100

2% BSA

Human serum (Jackson ImmunoResearch, 009-000-121)

Goat serum (Sigma G9023-10 mL)

NucBlue® Live ReadyProbes” Reagent (Life Technologies R37605)
DPBS, at room temperature (RT)

Texas Red”-X Phalloidin (Life Technologies T7471)
Anti-Cortactin (p80/85), clone 4F11 (Millipore #05-180)
Anti-MMP14 (Millipore, MAB3328)

Alexa Fluor® 647 Goat Anti-Mouse IgG (H+L) (Life Technologies A-21235)
TBS-T

Prolong® Gold Antifade Mountant (Life Technologies P36934)

Procedure for actin and cortactin staining:

1.

NownkEwWw

Count cells: for MDA-MB-231 cells in a 12 well plate, use 7.5x10* cells in 1 mL
media

Incubate coverslips in complete media for 30 minutes to 1 hour prior to addition
of cells on gelatin matrix coated coverslip

Place 1 mL of the cell suspension on top of the gelatin-matrix coated coverslips
Incubate at 37°C for 6 hours

20 minutes prior to fixation add 2 drops NucBlue to each well

Warm a 3.7% paraformaldehyde/5% sucrose (in DPBS) solution to 37°C
Aspirate cell-culture medium from each well, rinse with 1 mL DPBS and add 1
mL of warmed 3.7% paraformaldehyde with 5% sucrose

Incubate 20 minutes at RT
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9. Wash three times with DPBS (1 mL each wash)

10. Permeabilize with 0.2% Triton X-100 in DPBS for 10 minutes at RT

11. Wash three times with DPBS (1 mL each wash)

12. Block in 2% BSA in DPBS for 30 minutes at RT

13. Incubate with 1:200 anti-cortactin diluted in 2% BSA for 1 hour at RT

14. Wash three times for 10 minutes with TBS-T

15. Incubate with 1:200 Texas Red"-X Phalloidin and 1:500 Alexa Fluor”™ 647 goat
anti-mouse IgG diluted in 2% BSA for 1 hour at RT

16. Wash three times for 10 minutes with TBS-T

17. Rinse once with 1 mL DPBS

18. Dip in small flask of ddH»O and allow excess ddH,O to wick onto a folded
KimWipe

19. Mount with 1-drop Prolong Gold

20. Protect from light and allow to cure for 24 hours at RT prior to imaging

21. Store at 4°C protected from light until imaging

Procedure for actin and MMP14 staining:

1. Count cells: for MDA-MB-231 cells in a 12 well plate, use 7.5x10* cells in 1 mL
media

2. Incubate coverslips in complete media for 30 minutes to 1 hour prior to addition

of cells on gelatin matrix coated coverslip

Place 1 mL of the cell suspension on top of the gelatin-matrix coated coverslips

Incubate at 37°C for 6 hours

20 minutes prior to fixation add 2 drops NucBlue to each well

Warm a 3.7% paraformaldehyde/5% sucrose (in DPBS) solution to 37°C

Aspirate cell-culture medium from each well, rinse with 1 mL DPBS and add 1

mL of warmed 3.7% paraformaldehyde with 5% sucrose

8. Incubate 20 minutes at RT

9. Wash three times with DPBS (1 mL each wash)

10. Block in 2.5% human serum/5% goat serum in DPBS for 1 hour at RT

11. Incubate 1:100 anti-MMP14 diluted in 2.5% human serum/5% goat serum for 1
hour at RT

12. Wash three times for 10 minutes with TBS-T

13. Block in 2% BSA in DPBS for 30 minutes at RT

14. Wash three times for 10 minutes with TBS-T

15. Incubate with 1:200 Texas Red®-X Phalloidin and 1:500 Alexa Fluor® 647 goat
anti-mouse IgG diluted in 2% BSA for 1 hour at RT

16. Wash three times for 10 minutes with TBS-T

17. Rinse once with 1 mL DPBS

18. Dip in small flask of ddH,O and allow excess ddH,O to wick onto a folded
KimWipe

19. Mount with 1-drop Prolong Gold

20. Protect from light and allow to cure for 24 hours at RT prior to imaging

21. Store at 4°C protected from light until imaging
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Part 4: Image Acquisition

All samples were blinded during image acquisition and analysis. Images were acquired
on two different imaging platforms for analysis:

Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo
60X/1.40 numerical aperture oil objective, a Spot RT3 Camera (7.4 pm x 7.4 pm
pixel size) and Spot software

Zeiss Laser Scanning Microscope 780 equipped with a Plan-Apo 40X/1.4
numerical aperture oil objective

Part 5: IX70 Image Processing and Analysis Using FIJI Software

Images acquired using the IX70 inverted microscope were used to quantify the percent
of degrading cells in the population, the area of degradation and the cell area. The
following methodology describes how the images were processed.

Processing Gelatin Channel

1.

9.

Select Analyze—> Set Scale

a. Image Pixel Size = (Camera pixel size x binning)/(Objective Lens

Magnification x Lens Magnification)
i. For IX70 60X/1.4 numerical aperture objective 0.123 pm/pixel

Take histogram of sample and determine the mode intensity of the image
Open the color picker menu (Ctrl+Shift+K) and change the value to match the
mode
Select Image—> Adjust-> Threshold=> Auto MaxEntropy (adjust to fit the bright
artifacts) but do not apply
Select Analyze—> Analyze Particles>OK (this should outline all bright artifacts
in gelatin) e -

a. Size 0-infinity

b. Circularity 0.00-1.00

c. Show Nothing

d. Display results

e. Include Holes

f.  Add to Manager
Go to the ROI manager and select More->Fill

a. This is necessary to remove the bright artifacts present in the gelatin
Delete all ROI from the ROI manager
Select Process—> Subtract Background—> OK

a. Rolling ball radius: 50.0 pixels

b. Check light background
Take histogram of image (Ctrl+H), record minimum intensity (Intjow)

10. Determine the mean pixel values associated with undegraded gelatin

a. Use the rectangle tool and select regions from the background subtracted
image in areas without degradation or artifacts and measure the pixel
values (Ctrl+M)
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b. Summarize the mean pixel intensity and record (Intyndee) and delete all
measurements after recording
11. Insert values into the equation described by Starnes et al. 2013
a. Record minimum intensity (Intj,,) and mean intensity (Intuydeg)
b. threshy; =Intioy + [(Intundeg-Intiow)-X]
i. 0.3<x<0.6
1. Starnes et al. recommends 0.3-0.6 for the degradation
coefficient “x,” but points out it may need to be optimized
based on individual researchers application and conditions
2. Set value to 0.6 for our conditions
12. Select Image-> Adjust Threshold—> Set
a. Insert values for minimum (Int,y)and maximum (threshy;)
b. The thresholded areas should align with areas of degradation
c. Leave this image open or save this work then proceed to process the actin
channel

Processing Actin Channel

1. Open the actin channel image
2. Select Image-> Adjust-> Threshold—=> Auto Huang—> Apply
3. Select Process—> Binary—> Fill Holes
4. Select Analyze—>Set Scale

a. Image Pixel Size = (Camera pixel size x binning)/(Objective Lens

Magnification x Lens Magnification)
1. For IX70 60X/1.4 numerical aperture objective 0.123 um/pixel

5. Select Analyze-> Set Measurements

a. Check: Area and Limit to Threshold
6. Select Analyze-> Analyze Particles=>OK (this should outline each cell)

a. Size 50-infinity

b. Circularity 0.01-1.00
c. Show Outline

d. Display results

e.

Include Holes

f. Add to Manager
7. Record Area of Cell
8. Record Number of Cells

Measuring Degradation Using the Actin Channel Cell Outlines
1. Either select or open the background subtracted gelatin image from step 12 of
Processing Gelatin Channel
2. Using the ROI(s) generated from step six of Processing Actin Channel select
Measure on the ROI manager to get the area of degradation under each cell
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Part 6: LSM780 Actin/Cortactin Image Processing and Analysis Using FIJI
Software
Processing Actin Channel
1. Select Analyze—>Set Scale
a. Image pixel size = (Camera pixel size x binning)/(Objective Lens
Magnification x Lens Magnification)
b. For LSM 780 40X/1.4 numerical aperture objective 0.1 pM/pixel
2. Select an area with only one cell and Image—> Duplicate hyperstack so only one
cell is in the image
Separate the channels by selecting Image—> Color—> Split Channels
4. Select and duplicate the actin channel slices with invadopodia and change to
Image—>Type—>8-bit
Smooth the image with Process—>Smooth
6. Run Process—> Subtract Background->OK
a. Rolling Ball Radius=5
b. Uncheck light background
c. This reduces any actin stress fibers within the cell body
7. Select Process>Math->Gamma
a. Value=1.3
8. Select Process>Filters=>Convolve
a. textl=[-1-1-1-1-1\n-1-1-1-1-1\n-1-130-1-I\n-1-1-1-1-1\n-1-1-
1-1-1\n]
b. Select Normalize Kernel
9. Select Process—>Binary—>Make Binary
10. Select Analyze-> Analyze Particles
a. Size=0.05-0.5
b. Circularity=0.05-1.0
c. Check Add to Manager
11. Overlay particles on each slice of the actin channel and visually inspect to ensure
all puncta were counted
12. Perform steps 4-11 with channels with actin puncta
13. Make final actin binary image by filling all puncta that were analyzed with Black
(0,0,0)
14. Record the sizes of all puncta

(98]

9]

Processing Cortactin Channel
1. Select and duplicate the actin channel slices with invadopodia and change to and
8-bit image (Image-> Type—> 8-bit)
2. Select Process—> Smooth
a. This will smooth the image
3. Run Process—>Subtract Background->OK
a. Rolling Ball Radius=5
b. Uncheck light background
c. This reduces any actin stress fibers within the cell body
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4. Select Process>Math—->Gamma
a. Value=1.3
5. Select Process—>Filters>Convolve
a. textl=[-1-1-1-1-1\n-1-1-1-1-1\n-1-130-1-1\n-1-1-1-1-1\n-1-1-
1-1-1\n]
Select Normalize Kernel
Select Process—=>Binary—>Make Binary
8. Select Process—>Image Calculator...—> Select binary actin channel and binary
cortactin channel as Image 1 and Image 2
a. Operation: Multiply
b. Check: Create new window
c. This process will create a resulting image that only contains black pixels
that corresponds with overlapping signal in both images (colocalization)

e

Processing Colocalized Image

1. Select Image—> Adjust Threshold
a. Upper threshold level = 255
b. Lower threshold level = 255
c. Puncta and cell artifacts should be red

2. Go to ROI Manager, Select All, and Select Measure

3. Record colocalized areas
a. There should be the same number of measurements as in the actin puncta

alone channel, although some values may be 0

Part 7: LSM780 MMP14 Intensity Analysis Image Processing Using FIJI Software
Processing Actin Channel
1. Select Analyze->Set Scale
a. Image pixel size = (Camera pixel size x binning)/(Objective Lens
Magnification x Lens Magnification)
b. For LSM 780 40X/1.4 numerical aperture objective 0.1 uM/pixel
2. Image->Stack—>Z-Project—> Sum Slices
3. Image-> Adjust-> Threshold
a. Adjust threshold to area of each cell
1. Note-automatic does threshold most cells and their area, but some
visual inspection may be necessary
4. Analyze-> Analyze Particles
a. Size=20-infinity
b. Add to manager

Processing Gelatin Channel
1. Image->Stack—>Z-Project->Sum Slices
2. Process—>Filters=>Gaussian Blur
a. Sigma (Radius)=2.00
3. Process—>Filters>Convolve
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6.
7.

a. “textl=[-1-1-1-1-1\n-1-1-1-1-1\n-1-130-1-1\n-1-1-1-1-1\n-1-1
-1 -1 -1\n] normalize”);
Take histogram
Record minimum intensity (Intjo,) and mean intensity (Intuydeg)
a. threshy; =Intioy + [(Intyngeg-Intiow)-x]
b. x=0.6
Measure area of degradation in field
Measure area of degradation under cell area ROI

Processing MMP14 Channel

1.

2.
3.

Analyze—> Set Measurements
a. Area, integrated density,
Record area
Record integrated density at all 5 slices of image stack
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APPENDIX G

TRANSWELL INVASION/MIGRATION ASSAY

Materials:

MDA-MB-231 complete media(10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 starvation media (0.2% FBS and 1% v/v penicillin streptomycin)
DPBS
Trypan Blue (Gibco Cat# 15250)
EGF (BD recombinant hEGF Cat# 354052)

a. Stock solution 100 ng/uL in 0.1% BSA stored at -80°C
Corning” BioCoat™ Matrigel® Invasion Chambers, Corning® Growth Factor
Reduced (Ref: 354483)
Corning® Control Inserts (Ref: 354578)
3.7% Paraformaldehyde (16% Solution Cat # 15710 Electron Microscopy
Sciences)
Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo
10X/0.30 numerical aperture objective, a Spot RT3 Camera (7.4 um x 7.4 pm
pixel size) and Spot software

Procedure:
1 Day Prior to Experiment

1. Starve cells for ~24hours
a. Starve siRNA treated cells 48 hours post transfection to begin assay at 72
hours post transfection
Day of Experiment

2. Remove BioCoat covered Boyden chambers from -20°C and allow to come to
room temperature

3. Rehydrate with 500 pl warm starvation media for 2 hours

4. While the gel is equilibrating — lift the cells and make single cell suspension of
5x10* cells/ 500 pl (10x10* in 1 mL) starvation media (resuspend in 3 mL for
counting with Trypan Blue then perform dilution)

5. Following 2 hours of gel equilibration, carefully remove media from invasion
chamber and then add 500 pl of your cell suspensions (5x10* cells) very gently
(Tip: Remove media by inverting invasion chamber over a 100 millimeter plate
using forceps)

6. Fill the lower chamber with 750 pl of chemoattractant (starvation media plus
EGF: 10 ng/mL)

7. Incubate at 37°C, 5% CO, for 5 hours to assess migration

8. Incubate at 37°C, 5% CO, for 18 hours to assess invasion

Important note: Always 1% place the insert in well and then add any solution very gently
and slowly to the lower chamber through the insert gap
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Fixation and staining:

1. Add 500 pl 3.7% paraformaldehyde in DPBS (made from 16% liquid stock) for
20 minutes at room temperature
a. Fix cells 5 minutes then start removing Matrigel and non-invading cells
i. Remove cells from inner side by Q-tip and place back in
paraformaldehyde
2. Wash the inserts once in DPBS beaker gently and place in a clean well
3. Add 100 uL of NucBlue diluted in DPBS to 400 uL. of DPBS in the well (2 drops
NucBlue in 1 mL DPBS) and incubate for 20 minutes at RT (protect from light)
4. Observe under microscope under 10X dry objective
a. They can be imaged in the 24 well plate with 10X objective
5. Analyze data using ImageJ software
a. 10X Invasion Assay Script for ImageJ — can be performed manually or
Input as a new macro
i. Run("Dilate");
ii. run("Watershed");
iii. roiManager("Show All with labels");
iv. roiManager("Show All");
v. run("Analyze Particles...", "size=0.002-Infinity circularity=0.00-
0.99 show=[Overlay Outlines] display clear summarize add")
b. Visually inspect that the nuclei have all been counted properly and adjust
the count as required manually

Notes:
e Protocol was adapted from manufacturer’s (Corning) product literature.
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APPENDIX H

3D INVASION ASSAY — CULTREX" INVASION MATRIX

Materials:

MDA-MB-231 complete media(10% FBS and 1% v/v penicillin streptomycin)

e MDA-MB-231 starvation media (0.2% FBS and 1% v/v penicillin streptomycin)

e DharmaFECT 4

e siRNA — Scrambled, MMP14, Nck1, Nck2

e 10X Spheroid Formation Matrix (Trevigen — This reagent should be thawed and
16.5 uL aliquots made then stored at -80°C)

e Cultrex” Invasion Matrix (Trevigen — This reagent should be thawed and 165 uL
aliquots made and then stored at -80°C)

e DPBS

e Trypsin/EDTA Corning

e Trypan Blue (Gibco Cat# 15250)

e EGF (BD recombinant hEGF Cat# 354052)

a. Stock solution 100 ng/uL in 0.1%BSA stored at -80°C

e Centrifuge with swing plate rotor (Eppendorf 5810 R centrifuge equipped with
an A-4-81 rotor)

e Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo
10X/0.30 numerical aperture objective, a Spot RT3 Camera (7.4 pym x 7.4 pum
pixel size) Model 25.4 2 Mp Slider and Spot software

Procedure:
Alternate siRNA Treatment Methodology for 3D Invasion Assay
Day 1

1. Plate 5x10* cells in a 35-millimeter plate

2. Thaw appropriate number of aliquots of 10X Spheroid Formation Matrix on ice
at 4°C overnight

Day 2

1. Treat cells with 1 pL/mL DharmaFECT 4 and 25-50 nM siRNA for six hours

2. After six hours wash cell twice with DPBS

3. Add 120 uL of Trypsin/EDTA and keep at room temperature for 5 minutes

4. Use 1 mL complete media to neutralize trypsin and collect cells in 15 mL Falcon
tube

5. Wash plate with 1 mL complete media to collect the remainder of the cells

6. Spin at 800 rpm for 3 minutes to pellet cells

7. Carefully aspirate media and resuspend cells in small volume complete media

8. Perform Trypan Blue exclusion assay to count the number of viable cells

9. From this make 0.3 x 10" cells/45 pL in ice cold complete media (enough for 1-2

more wells than you need)
e 0.3 x 1000/ (cell count from hemocytometer) = X
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10.

11

13
Day 3

Day 4

Notes:

e Take 45 —x =Y (Y is the amount of ice cold CM you should add)
e For triplicate spheroids make enough for 4-5 wells, so multiple both X
and Y by 4 or5
Mix the 148.5 pL cold cell suspension with the 16.5 pL of 10X spheroid mix

. Plate 50 uL in chilled 3D culture qualified 96 well spheroid formation plate
12.

Spin at 200 rcf for 3 minutes at room temperature
e Important — set centrifuge acceleration to 9 and deceleration to 1 for a
slow finish of the spin — this helps with spheroid formation

. Place at 37°C for 48 hours

Thaw appropriate number of aliquots of Cultrex” Invasion Matrix on ice at 4°C:

. Remove 3D culture qualified 96 well spheroid formation plate from 37°C

incubator and place on ice for at least 15 minutes
e Place ice bucket in refrigerator
Cool centrifuge to 4°C
Add 50 pL Invasion Matrix to each well and keep on ice
Transport on ice to centrifuge and spin at 300 rcf for 5 minutes
e Important — set centrifuge acceleration to 9 and deceleration to 1 for a
slow finish of the spin — this helps with spheroid formation
Place in 37°C incubator
After 1 hour add 100 uL warm (37°C) cell culture media (must be 37°C not just
room temp) with appropriate serum and chemoattractant
e Stock to add is starvation media with 10 ng/mL EGF
Images should be acquired immediately after addition of media (time point 0)
and then every 24 hours for 2-3 days
e Can image spheroids up to 6 days

Protocol was adapted from Trevigen® Cultrex” 96-well 3D Spheroid BME Cell
Invasion Assay product literature.
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APPENDIX I

3D INVASION ASSAY — PURE COLLAGEN I

Materials:

MDA-MB-231 complete media(10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 reduced serum media (2% FBS and 1% v/v penicillin
streptomycin)

e 10X DMEM with phenol red — Low Glucose

e 1 M-HEPES

e 7.5% Sodium Bicarbonate

e DPBS

e | N NaOH - per Corning Protocol

e 1 N HCI - in the event you need to re-acidify to reach a pH of 7.4

e 9.06 mg/mL Corning® Collagen I High Concentration (HC), Rat Tail in 0.02 N
Acetic Acid

e ColorpHast pH-indicator strips, range: 6.5-10 (Millipore)

e Microcentrifuge

e Starvation Media Recipe

o DMEM High Glucose (HyClone)
o 0.2% Fetal Bovine Serum
o 1% Pen Strep

e CoolSink™ XT 96U (Biocision)

e Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo
10X/0.30 numerical aperture objective, a Spot RT3 Camera (7.4 pym x 7.4 pum
pixel size) and Spot software

Procedure:
Alternate siRNA Treatment Methodology for 3D Invasion Assay
Day 1

1. Plate 5x10* cells in a 35-millimeter plate

Day 2

b=

o N

Thaw appropriate number of aliquots of 10X Spheroid Formation Matrix on ice
at 4°C overnight

Treat cells with 1 uL/mL DharmaFECT 4 and 25-50 nM siRNA for six hours
After six hours wash cell twice with DPBS

Add 120 pL of Trypsin/EDTA and keep at room temperature for 5 minutes

Use 1 mL complete media to neutralize trypsin and collect cells in 15 mL Falcon
tube

Wash plate with 1 mL complete media to collect the remainder of the cells

Spin at 800 rpm for 3 minutes to pellet cells

Carefully aspirate media and resuspend cells in small volume complete media
Perform Trypan Blue exclusion assay to count the number of viable cells
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9. From this make 0.3 x 10* cells/45 uL in ice cold complete media (enough for 1-2
more wells than you need)
e 0.3x 1000/ (cell count from hemocytometer) = X
e Take45—-x=7Y (Y is the amount of ice cold CM you should add)
e For triplicate spheroids make enough for 4-5 wells, so multiple both X
and Y by4or5
10. Mix the 148.5 pL cold cell suspension with the 16.5 pL. of 10X spheroid Mix
11. Plate 50 pL in chilled 3D culture qualified 96 well spheroid formation plate
12. Spin at 200 rcf for 3 minutes at room temperature
e Important — set centrifuge acceleration to 9 and deceleration to 1 for a
slow finish of the spin — this helps with spheroid formation
13. Place at 37°C for 48 hours
Day 4
Preparation of Collagen I
1. Turn on and fast cool microcentrifuge
2. Cool centrifuge to 0°C to embed spheroid in collagen
3. Place 3D culture qualified 96 well spheroid formation plate on cold sink and
place on ice in the 4°C refrigerator to pre-chill the plate and the multicellular
tumor spheroids (needs a minimum of 15 minutes to chill)
4. Components to place on ice

e 10X DMEM

e Rat Tail Collagen
e DPBS

e 1 N NaOH

e Sterile tubes for mixing collagen
5. Determine final volume of diluted collagen (include a 20% excess for pipetting
errors)
e 3D Spheroid Assay requires 50 uL of collagen per well
6. 50 x Number of samples x 1.2 = total uL of diluted collagen to make
7. Calculate the volume of Corning Collagen I HC to be used
¢ (Final volume x Final collagen concentration in mg/mL) / (Concentration
of collagen in bottle (lot specific)) = volume of collagen to be added
8. Calculate the volume of sterile ice cold 1 N NaOH to be added:
e Volume of collagen to be added x 0.023 mL = volume of 1 N NaOH
9. Calculate the volume of sodium bicarbonate (7.5%) and HEPES (1 M) to add
e Add 2.5% v/v of both components
e Total volume x 0.025 = amount to add
10. Calculate the volume of 10X DMEM to add
e Add 10% v/v
e Total volume x 0.1 = amount to add
11. Calculate the amount of DPBS to add to bring the final concentration of collagen
(i.e. 2.2 mg/mL or 4.4 mg /mL)
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¢ Final volume — volume collagen — volume 10X DMEM — volume sodium
bicarbonate — volume HEPES = volume DPBS to add

12. Once all calculations are complete and double checked ensure all components

that will come into contact with the collagen are chilled

Neutralization of Collagen I for Embedding

1.

8.
9.

Take tube on ice and begin by adding calculated amount of 10X DMEM

2. Add calculated amount of 1 N NaOH to the 10X DMEM
3.
4. Add calculated volume DPBS and mix the solution well by pipetting up and

Add sodium bicarbonate and HEPES

down carefully avoiding the introduction of bubbles
The final step is the addition of the calculated amount of collagen to the mix
e Once added gently pipet up and down to mix without causing bubbles or
collagen precipitates to form
e Ifbubbles appear the solution can be cold centrifuged for 3 minutes at
10,000 rpm
e Be careful as any increases in temperature after the neutralization of the
collagen will result in polymerization
Wait ~4 minutes after mixing all components to test pH
Test the pH of the collagen by pipetting a small amount onto a strip of pH paper
and using the color scale to determine actual pH
e pH must be between 7.1 and 7.4
e Ifitis outside this range use ice cold 1 N NaOH or 1 N HCI to adjust
final pH
e Add small volume, mix gently and wait ~4 minutes before testing pH
again
Can be kept on ice for a brief period of time — recommend using it immediately
Collagen will now be ready to be used for embedding multicellular tumor
spheroids

3D Spheroid Embedding: Pure Collagen I Mixture

1.

Once collagen is ready bring the chilled 96 well glass flat bottom plate still on ice
into the tissue culture hood and disperse 20 uL of chilled collagen on bottom of
each well, be careful not to introduce bubbles
e One way to avoid introduction of bubbles is to plunge the pipet slightly
beyond the first stop so that you pull slightly more collagen than 20 pL.
but only expel to the first stop
Once all needed wells are coated remove plate from ice and place in 37°C
incubator for 30 minutes to polymerize collagen I (Corning Product Technical
Literature)
Do not keep at room temperature as this will alter the characteristics of collagen
polymerization and may introduce experimental variability.
Once polymerization is completed place 96 well glass flat bottom plate on ice at
4°C for at least 15 minutes to chill the plate then proceed with the next step
Make fresh collagen preparation
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10.

11.

12.

Notes:

Once collagen is ready bring the chilled 96 well glass flat bottom plate still on ice
into the tissue culture hood and add 100 pL of chilled collagen to each well, be
careful not to introduce bubbles
e One way to avoid introduction of bubbles is to plunge the pipet slightly
beyond the first stop so that you pull slightly more collagen than 100 pL
but only expel to the first stop
After all collagen has been added take chilled pre-formed spheroids and place
them on ice
Use a P20 pipette set to 5 uL, plunge to just past the stop point and carefully
aspirate the preformed spheroid
Next place the spheroid in the middle of the chilled 96 well plate containing the
aliquoted collagen I
e (Care must be taken not to place the spheroid to high or too low in the
aliquoted collagen I or this will prevent proper invasion and imaging
Once spheroids are placed remove plate from ice and place in 37°C incubator for
1 hour to polymerize collagen I
e Do not keep at room temperature as this will alter the characteristics of
collagen polymerization and may introduce experimental variability
After 1 hour add appropriate media and growth factors for the experimental
design warmed to 37-38°C
¢ Basic protocol is to add 100 pL of Reduced Serum Media + 10 ng/mL
EGF
1. Reduced serum media contains 2% FBS compared to Starvation
Media that contains 0.2% FBS
ii. EGF final concentration will be 5 ng/mL when added to the 100
pL of collagen I
Images should be acquired immediately after addition of media (time point 0)
and then every 24 hours for 2-3 days
e Can image spheroids up to 6 days

Spheroid formation for siRNA treated cells was limited to two days, while
spheroid formation for sShRNA expressing cells was allowed to proceed for 2 or 3
days based on assay performed

The only change this makes to the protocol is the day the cells are embedded in
invasion matrix

Protocol adapted from Artym et al. 2010, Guzman et al. 2014, Corning Collagen
I product literature and Trevigen” Cultrex”™ 96-well 3D Spheroid BME Cell
Invasion Assay product literature
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APPENDIX J

TRANSIENT TRANSFECTION WITH LIPOFECTAMINE 2000

Materials:

MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 complete media without antibiotic (10% FBS)

Lipofectamine®™ 2000 Transfection Reagent (Life Technologies Catalog Number:
50470)

Opti-MEM" Reduced Serum Medium (Life Technologies Catalog Number:
31985-062)

Plasmid DNA

1.5 mL Eppendorf Tubes

Procedure:
Day 1
1. Plate 20x10* MDA-MB-231 cells with complete media in a 35-millimeter dish
and place in a 37°C incubator with 5% CO,
Day 2
1. Label two Eppendorf tubes and add 250 puL of Opti-MEM media to each tube
e Tube I - Plasmid DNA
e Tube 2 - Lipofectamine 2000
2. Add 2 pg plasmid DNA to tube 1 and mix well by gently pipetting up and down
3. Add 5 pL of Lipofectamine 2000 reagent to tube 2 and mix well by gently
pipetting up and down
4. Incubate at room temperature for 5 minutes
5. After 5 minutes take entire volume from Tube 2 and add it to Tube 1
6. Mix well by gently pipetting up and down then incubate at room temperature 20-
30 minutes
7. Add 500 pL antibiotic free complete media to the transfection reagent plasmid
mixture in Tube 1
8. Remove complete from cells and add entire contents of Tube 1 to the plate then
place back in 37°C incubator
9. After one hour replace media with fresh antibiotic free complete media
10. After an additional four hours the media can be replaced with complete media
containing antibiotic
11. Grow cells overnight then lift and re-plate with fresh complete media
12. The cells will be ready for use within 1-3 days based on the plasmids transfected
Notes:

Adapted from manufacturer’s protocol (Life Technologies) for Lipofectamine
2000
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APPENDIX K

FLUORESCENCE RECOVERY AFTER PHOTOBLEACHING (FRAP)

Materials:

MDA-MB-231 stably expressing pMSCV Actin-EYFP

MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)

DPBS (HyClone, ThermoScientific)

Live Cell Imaging Media (Phenol-red free DMEM High Glucose supplemented
with 10% FBS, 1% Pen/Strep and 25 mM HEPES)

35-millimeter glass bottom MatTek dishes (MatTek Corporation, Ashland, MA)
Fibronectin (10 pg/mL in DPBS)

Zeiss LSM780 Confocal Microscope Plan-Apo 40X/1.40NA oil objective

Procedure:

1.

2.

3.

4.

Three days prior to imaging perform siRNA mediated silencing using scrambled
and Nck targeting sequences
Two days prior to imaging plate 10x10* cells in a 60-millimeter tissue culture
plate to synchronize growth at low density
One day prior to imaging:
a. Coat MatTek dishes with 10 pg fibronectin (use 1 mL of 10 pg/mL
fibronectin in DPBS for one hour at room temperature
b. After 1 hour aspirate excess DPBS and add 200 uL live cell imaging
media to the glass portion of the MatTek for 15 minutes and place in
37°C/5% CO; incubator
Lift cells using 350 puL Trypsin/EDTA for 5 minutes at room temperature
Collect cells in 15 mL Falcon tube and spin for 3 minutes at 800 rpm
Re-suspend cells in 250 pL of Live Cell Imaging Media
Count cells using hemocytometer
Make dilutions of 4x10” cells in 200 pL Live Cell Imaging Media
Remove fibronectin coated plates from incubator and aspirate media
Add 4x10* cells in 200 pL to each fibronectin coated plate and place in
37°C/5% CO, incubator for one hour to allow cells to adhere
j. After 1 hour add 2 mL imaging media to each plate and incubate for
approximately 20 hours prior to imaging
Day of imaging
a. Place plate on stage and allow 5 to 15 minutes for equilibration
b. FRAP settings
1. Acquisition
1. Pixel dwell time: 0.79 ps/pixel
2. Picture resolution: 512 x 512
3. Laser power: 2.4% 514 nm
ii. Photobleach

FER o Ao
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1. Pixel dwell time: 90 ps/pixel

2. Region of interest: 164 x 166

3. Laser power: 100% 514 nm
Collect 3 initial image scans prior to photobleaching
After initial image capture, region of interest was photobleached
Recovery of fluorescence was measured from 6 sequential scans
beginning immediately postbleach, and then at 1.94 second intervals
Data were collected from at least 60 images from two culture dishes per
treatment

5. Data analysis (adapted from Barhoumi et al. 1993 and Li et al. 2010)

a.

b.

Rate constant estimation (k) was performed for fluorescence recovery by
fitting the percent fluorescence intensity at a given time, FI to the
equation below
i. FI=A(1-e"+B
1. A represents percent fluorescence recovery of the bleached
structure at equilibrium
2. B represents percent fluorescent intensity immediately
after photobleaching
Data from at least 80 actin-EYFP puncta from each group were pooled to
obtain mean A and k values using a curve fitting regression analysis
(GraphPad Software) to extrapolate fluorescence recovery as a function
of time
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APPENDIX L

WESTERN BLOT

Part 1: Harvesting Cells

Materials:

Kinase Lysis Buffer (KLB) Stock

e DPBS
¢ (.5 M phenylmethylsulfonyl fluoride in DMSO
e Aprotinin, from Bovine Lung
e 100 mM Sodium Pervanadate (NaVOy)
e Microcentrifuge tubes (1.5 mL Eppendorph tubes)
e Refrigerated Table Top Centrifuge
e Cell scraper (BD Falcon 353085)
Procedure:
1. Turn on refrigerated centrifuge and cool to 4°C
2. Label microcentrifuge tubes with appropriate sample names in duplicate and chill
on ice
3. Prepare KLB by adding 1/500 phenylmethylsulfonyl fluoride, 1/100 NaVOy, and
1/100 Aprotinin to KLB stock
4. Remove plate containing cells to be harvested from incubator and aspirate
growth media
5. Wash cells gently with cold DPBS then aspirate the solution
6. Repeat step 5 one time
7. After second wash with DPBS place plate on ice
8. Add KLB to plate (amount varies by cell type, plate size and confluence)
a. MDA-MB-231 confluent plates
1. 35-millimeter — 50 puL
it.  60-millimeter — 100 uL
iii.  100-millimeter — 200 pL.
iv. 150-millimeter — 300 uL
9. Scrape cells off the bottom of the plate using the cell scraper
a. For multiple samples wash cell scraper in distilled water between samples
10. Transfer cells/solution to microcentrifuge tubes and vortex
11. Incubate on ice 15-30 minutes
12. Spin samples for 10 minutes at max speed in refrigerated centrifuge
13. Transfer supernatant to fresh tubes previously labeled in step 2
14. Keep on ice and proceed to measure protein concentration or store at -80°C
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Part 2: Determining Protein Concentration

Materials:

Cell Lysate Samples

96-Well Tissue Culture Flat Bottom Plate (Falcon 353072)

BSA Protein Standards in KLB (10 pug/uL, 5 ug/uL, 2.5 pg/uL, 1.25 pg/uL,
0.625 ng/uL, 0.3125 pg/ul)

Bradford Reagent (Bio-Rad Protein Assay Dye Reagent Concentrate #500-0006)
Microcentrifuge tubes (1.5 mL Eppendorph tubes)

Plate Reader (FLOUstar Omega)

Procedure — Preparation and Loading of Samples:

1.

NN kW

9.

10.

11.
12.

Prepare Bradford reagent by making a 1:5 dilution in deionized distilled water
(ddH,0)
Prepare microcentrifuge tubes by labeling one for each sample being quantified
a. Include 7 additional tubes for the blank and protein standard
Pipet 1 mL of diluted Bradford reagent into each microcentrifuge tube
Add 5 uL of KLB to tube labeled blank
Add 5 pL of each standard to the appropriately labeled tubes
Add 5 pL of each sample to the appropriately labeled tubes
Mix samples well by inverting tubes several times until the color is visibly
homogenous
Start 10 minute timer
a. Bradford reagent reaction should take place for a minimum of 10 minutes
but should not exceed 1 hour
Aliquot 200 pL of each mixture in triplicate into 96-well plate
After 10 minutes, but before 1 hour absorbance should be measured on a plate
reader
Measure absorbance on plate reader
Create a standard curve to determine protein concentrations
a. Ifusing all 6 standards a 4-parameter curve should be generated
b. Ifusing only the 4 lowest concentration standards a linear curve should
be used

Part 3: Sample Preparation for Sodium Dodecyl Sulfate-Polyacrylamide Gel

Electrophoresis (SDS-PAGE)

Materials:

5X Sample Buffer

Samples with known protein concentration
Microcentrifuge tubes (1.5 mL Eppendorph tubes)
Microcentrifuge tube locks

Heat block (set to 105°C)

Table top microcentrifuge
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Procedure:

1.

2.

3.
4.

5.

Combine 4 parts protein sample with 1 part 5X sample buffer in a
microcentrifuge tube
Vortex sample and lock lid closed with a tube lock and place in 105°C heat block
for 5 minutes
Cool sample on ice and briefly spin down contents in microcentrifuge
Normalize all protein concentrations using 1X Sample Buffer (5X Sample Buffer
diluted with distilled water)

a. Example — all protein concentrations should be at 0.4 pug/uL so the same

volume of each sample can be used for SDS-PAGE

Treated samples can be used immediately or stored at -20°C

Part 4: SDS-PAGE Gel Casting

Materials:

30 % Acrylamide Solution (Protogel EC890)
1 M Tris, pH 8.8
1 M Tris, pH 6.8
10% Sodium dodecyl sulfate (SDS)
10% Ammonium persulfate (APS)
TEMED
n-Butanol (H,O-Saturated)
Mini-PROTEAN® Tetra Cell System
o Spacer plate, desired thickness,
o Short plate
o Casting frame
o Casting stand
o Casting stand gaskets
o Gel comb
15 mL Falcon tube

Procedure —Gel Casting System Assembly:

1.
2. Place short plate on top of spacer plate
3.
4

AN

Place casting frame on a flat surface with pressure cams in the open position

Orient the plates so labels can be read normally
Slide the glass plates into the plastic casting frame with the shorter plate towards
the front of the frame (side with handles for pressure clamps)
a. Ensure that both plates are flush with the flat surface at the bottom to
prevent leaking
Engage the pressure clamps
Place gray casting stand gaskets in appropriate location on casting stand
Place casting frame on casting stand while engaging spring-loaded lever on the
top
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a. Alternated pressure on the left and right side of the casting frame to
properly seat the plates on the casting stand gasket to prevent leaks

Procedure — Gel Casting:
1. Prepare resolving gel in 15 mL Falcon tube
2. Mix gently by inversion without introducing bubbles into the solution
3. Pipet the resolving gel solution into the opening between the spacer plate and the
short plate
4. Immediately overlay with n-Butanol
5. Allow 20-30 minutes to polymerize
a. Excess resolving gel in 15 mL Falcon tube will indicate polymerization
status of gel
Pour off n-Butanol and rinse gel surface thoroughly with ddH,O
Prepare stacking gel in 15 mL Falcon tube
Pipet stacking gel solution to the top of the short plate
Insert comb with appropriate number of wells between the spacers
0 Allow the stacking gel to polymerize for 20-30 minutes
a. Excess stacking gel in 15 mL Falcon tube will indicate polymerization
status of gel
11. Leave the comb in the gel and rinse well with dH,O
12. The gel can be used immediately
a. Alternatively the gel can be wrapped in a damp paper towel (use ddH,O)
and plastic wrap and stored at 4°C overnight

Swene

Part 5: SDS-PAGE Protein Separation
Materials:

e Hand-Cast Gels
10X Tank Buffer Stock
ddH,0O
Mini-PROTEAN® Tetra Cell System
Gel Releaser
Power Supply (BioRad PowerPac™ Basic)
Running Buffer
Sample Loading Tip (Pipet Tips with Microcapillary for Loading Gels, VWR
37001-150)

Procedure:
1. Place the clamping frame on a flat bench top surface in the open position
2. Set the electrophoresis module on a clean flat surface
3. Ensure the short plate is facing inward and place the first gel cassette on the
molded supports of the electrophoresis module
a. By placing the gel at a 30° angle away from center of the clamping frame
it will seat to the bottom of the supports
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10.

11.

12.

13.

14.

15.

16.

17.
18.
19.
20.
21.
22.
23.

Repeat with a second gel on the opposite side or use a Mini Cell Buffer dam in
its place if only running a single gel
Pull both gels towards vertical and firmly hold in place
a. The short plate should sit just below the notch in at the top of the green
gasket
Clamp the frame closed ensuring the gels do not shift during the process
Once assembled place the electrophoresis module in the Mini-PROTEAN Tank
a. Ensure that the positive and negative electrodes are lined up properly
i. These are color coded red and black on both the tank and the
assembly
Use 10X Tank Buffer and dilute to 1X
a. Make 700 mL for 1 or 2 gels — 70 mL 10X Tank Buffer and 630 mL of
dH,O
Fill the upper chamber between the gels with Tank Buffer
a. Observe for leaking of Tank Buffer into the Mini-PROTEAN Tank
1. If leaking is observed, disassemble and reassemble according to
steps 1-7
Pour the remainder of the Tank Buffer into the bottom of the Mini-PROTEAN
Tank
Optional Step — A sample loading guide can be placed between the gels at this
time to aid in sample loading
Load samples into each assembly
a. Use a pipet with sample loading tips
b. Load sample slowly allowing it to settle in the bottom of the well evenly
c. Use care not to puncture the bottom or the sides of the well
Place the lid on the Mini-PROTEAN Tank ensuring that the red and the black
color coded regions are aligned properly
Insert the electrical leads into the power supply matching the red and black lead
colors
Apply power and begin electrophoresis
a. Recommended that voltage be set at 200V and remain constant for SDS-
PAGE
b. Run time is 40-70 minutes
i. protein of interest size and acrylamide concentration can alter the
time required
After electrophoresis is completed, turn off the power supply and disconnect the
electrical leads
Remove the tank lid and lift out the assembly
Pour off and discard the running buffer
Open the arms of the electrophoresis assembly and remove the gel cassettes
Use the gel releaser to gently separate the short plate from the spacer plate
Use the gel separator to cut then remove the stacking gel from the resolving gel
Discard the stacking gel
The resolving gel is ready for transfer to nitrocellulose
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Part 6: SDS-PAGE Protein Transfer to Nitrocellulose
Materials:

o SDS-PAGE, post protein separation
Transfer Buffer (stored at 4°C)
Nitrocellulose Membrane (BioTrace™ NT 66485)
Whatman™ Chromatography Paper (3030-6188)
Mini Trans-Blot” Cell (BioRad)
Power Supply (BioRad PowerPac™ Basic)
Diagger Stirrer

Procedure:
*Nitrocellulose membrane should never be handled with bare hands, always used gloved
hands and forceps to ensure best blots
1. Cut nitrocellulose membrane and filter paper to the gel dimensions
a. For gels cast using the Mini-PROTEAN Tetra Cell System
i. Nitrocellulose dimension: 6.5centimeters by 9 centimeters
1. Whatman paper can be folded in half twice then cut along the
folds to create four rectangles
2. Equilibrate resolving gel and soak the nitrocellulose membrane, filter paper and
fiber pads in transfer buffer (15 minutes to 1 hour based on gel thickness)
3. Place standard stir bar in bottom of buffer tank while components are
equilibrating
4. Important: Prepare transfer stack in the gel holder cassette in the following order
(all components should be pre-wetted before beginning this step)
a. Black side of cassette
b. Fiber pad
Whatman paper
Equilibrated gel
Nitrocellulose membrane
Whatman paper
Fiber pad
Clear side of cassette
Close the gel holder cassette firmly without moving the internal components
Lock the gel holder cassette and place it in the electrode module
Repeat for second gel holder cassette if necessary
Place frozen cooling unit in the buffer tank
Completely fill tank with transfer buffer
0. Place unit on stirrer and set speed as fast as possible to maintain even buffer
temperature and ion distribution
11. Place lid on tank lining up the red and black guides
12. Plug cables from lid into the power supply and run the blot
a. 2 to 3 hour transfer

SR o Ao

e S B
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b. 100 V
c. 350 mA
13. Once run is complete unplug cables and remove lid from buffer tank
14. Remove gel holder cassette and disassemble the transfer stack
a. The gel can be stained with coomassie blue to confirm efficient protein
transfer or it can be discarded
b. Nitrocellulose membrane is ready for western blot
i. Do not let the membrane dry out, it should be immediately placed
in TBS-T

Part 7: Western Blot
Materials:
e Nitrocellulose Membrane —Post Protein Transfer
TBS-T (Tris-Buffered Saline and Tween 20)
Specific Antibodies
Polyester Pouches
Heat Sealer (Hualian FS-305)
Chemiluminescent Horseradish Peroxidase (HRP) Substrate
ImageQuant™ LAS 4000 Mini Documentation System
The Belly Dancer
Clear Sheet Protectors

Procedure — Blocking Non-specific Binding
*Perform each wash by placing the nitrocellulose membrane in a small dish with enough
TBS-T to cover the membrane and then place it on the belly dancer shaking for 5
minutes
**Perform incubations in a polyester pouch - ensure bubbles are minimal prior to sealing
the pouch
1. Wash nitrocellulose membrane in a small dish with TBS-T
2. Incubate in 10 mL of blocking solution for 1 hour at room temperature on The
Belly Dancer
a. Each antibody has an optimized blocking solution
3. After 1 hour remove nitrocellulose membrane from polyester pouch and place in
TBS-T prior to proceeding to the next step
Procedure - Primary Antibody
1. Make dilution of primary antibody in 5 mL of blocking solution or antibody
appropriate solution
2. Incubate nitrocellulose membrane in primary antibody overnight at 4°C with
shaking
3. Wash 5 times with TBS-T
Procedure — Secondary Antibody
1. Make dilution of secondary antibody in 5 mL of the same blocking solution used
for the primary antibody
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2.
3.

Incubate in secondary antibody for 1 hour at room temperature
Wash nitrocellulose membrane 5 times with TBS-T
a. Leave the membrane in the last wash until ready to proceed

Procedure — Detection of Signal

1.

2.

[98)

9]

7.
8.

9.

Cut clear sheet protector into rectangles larger than your nitrocellulose
membrane

Mix 500 pL of each component from the Western Lightening® kit in an
microcentrifuge tub

Place a small stack of KimWipes on the bench

Using forceps remove the membrane from the TBS-T and allow excess solution
to wick off the membrane into the stack of KimWipes

Transfer nitrocellulose membrane between the sides of the sheet protector

Add the Western Lightening® solution to the membrane and lay the upper portion
of the sheet protector down to evenly distribute the solution across the entire
membrane

Protect from light and allow to incubate for 1 minute

Remove the membrane with forceps and allow excess Western Lightening®
solution to wick into the KimWipes

Place in a fresh sheet protector and protect from light

10. Transport to ImageQuant™ LAS 4000 mini documentation system
11. Place sheet protector with membrane in the documentation
12. Acquire images at multiple time settings

a. An initial image at 20-30 seconds exposure will allow you to properly
align your blot within the machine and determine an appropriate exposure
time

Procedure — Stripping Membrane and Re-Probing for Alternate Target

1.

ol

Once imaging is complete place membrane in TBS-T

Prepare 20 mL of fresh stripping buffer per membrane to be stripped

Incubate in a 55°C shaking water bath for 45 minutes

Wash 5 times with TBS-T

Once wash steps are complete proceed to the procedure for blocking non-specific
binding and continue through the protocol again

Part 8: Western Blot Quantitation Using ImagedJ or F1JI

1.

3.

Open gel image in ImageJ or F1JI

Outline region of gel containing all bands to be quantified with rectangle tool

Duplicate region — processing is performed on duplicated region

1. Note: you can do all bands at once (GAPDH and MMP14 or Nck; however,
this can make separating the MMP 14 bands difficult due to scaling:
recommend quantifying each probed protein separately even if probed on
same blot)

Run background subtraction
a. Rolling ball radius: 50 pixels
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b. Check light background
5. Outline each lane or band using the Analyze—> gels—>select first lane tool, then
label all consecutive bands using the Analyze—> gels—>select next lane tool
a. Once all lanes have been selected use the Analyze—> gels—>select plot
lanes tool
6. Once the plot is created ensure that you close any gaps to only collect the area
where there is signal
7. Use the wand tool and click in each region to get the area
Cut and paste measurements into excel
9. In excel you can normalize each protein concentration to a loading control
(GAPDH is a standard loading control) and then convert the output into a percent
of control measurement for graphing and comparison purposes

>

Part 9: Western Blot Solutions

Resolving buffer -1 M Tris-Cl (pH 8.8)
e 60.6 g Tris (FW 121.1); Sigma cat# T1503-1KG
e 300 mL ddH,O
Adjust to pH 8.8 using 2.5 N HCI
e Add ddH,O to make a final volume of 500 mL
Store up to 3 months at 4°C in the dark

Stacking buffer - 1 M Tris-Cl (pH 6.8)
e 60.6 g Tris (FW 121.1) Sigma cat# T1503-1KG
e 300 mL ddH,O
Adjust to pH 6.8 using 2.5 N HCI
e Add ddH,O to make final volume to 500 mL
Store up to 3 months at 4°C in the dark

10% SDS
e 10gSDS
e ddH,O to 100 mL
Store up to 6 months at room temperature

10% APS
¢ 1.0 g ammonium persulfate
e ddH,Oto 10.0 mL
Store 0.5 mL aliquots at -20° C for up to 6 months

5X Sample Buffer
e 6.0 mL Stacking buffer (1 M Tris, pH 6.8)
e 2.0gSDS

e 9.0 mL glycerol
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e 6.0 mg bromophenol blue
e 5.0 mL B-Mercaptoethanol
Store 0.5 mL aliquots at -20° C for up to 6 months

n-Butanol (H,O-Saturated)
e 50 mL n-butanol
e 5mL ddH,O
Combine and shake in a bottle
Store at room temperature

10X Tank Buffer Stock, pH 8.3
e 30.3 gTris
e 144.0 g glycine
e 10.0gSDS
e dH,OtolL
Do not adjust with acid or base
Store at 4° C
Mix thoroughly before use

Transfer Buffer
o 2424 ¢gTris
e 115.28 g glycine
e 8.0gSDS
e dH,Oto64L
¢ Add methanol up to 8 L

Kinase Lysis Buffer (KLB)
e 12.5mL 1M Tris, pH 7.4
15 mL 5 M NaCl
5mL 0.5 M EDTA
5 mL Triton X-100
5mL 1 M B-GP(B-glycerophosphate)
50 mL 100 mM Na3VO4
50 mL Glycerol
e 347.5mL H20
Store at 4°C. Add fresh with each use:
e 1/500 0.5 M phenylmethylsulfonyl fluoride in DMSO
e 1/100 Aprotinin
e 1/500 50 mM Na3VO4
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100 mM Sodium Orthovanadate (NazVQOy)
e 092 gNa3VO4
e 40 mL ddH,O
Solution will be orange in color
When dissolved the pH should be approximately 12
Use HCl to adjust pH to 10
Use a boiling water bath to heat for about 5 minutes then cool on ice
Repeat 5-6 times
Color should now be light yellow
Measure to confirm pH is lower
Raise pH to 10 with NaOH
Repeat boiling and cooling until color is gone
Measure pH to confirm it is stable at 10
e dH,O to 50 mL
e Aliquot and freeze at -20°C

Stripping Buffer

e 4 mL 10% SDS

e 125mL 1M Tris pH 6.8
143 pl B-Mercaptoethanol
14.6 mL ddH,O

SDS-PAGE Resolving Gel — 10 mL/12%
e 2. 1mL HzO

4.0 mL 30% Acrylamide mix

3.8 mL 1 M Tris (pH 8.8)

0.1 mL 10% SDS

0.1 mL 10% APS

0.004 mL TEMED

SDS-PAGE Stacking Gel -5 mL
e 344 mL H,O
e 0.83 mL 30% Acrylamide mix
e 0.63mL 1M Tris (pH 8.8)
e 0.05mL 10% SDS
0.05 mL 10% APS
0.005 mL TEMED

Notes:
e Adapted from BioRad Mini-PROTEAN® Tetra Cell Product Literature
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APPENDIX M

3D GROWTH ASSAY

Materials:

MDA-MB-231 complete media(10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 stable silenced cell lines (shScramble and shNck)

10X Spheroid Formation Matrix (Trevigen — This reagent should be thawed and
16.5 uL aliquots made then stored at -80°C)

DPBS

Trypsin/EDTA (Corning)

Trypan Blue

Centrifuge with swing plate rotor (Eppendorf 5810 R centrifuge equipped with
an A-4-81 rotor)

Olympus IX70 inverted microscope equipped with an Olympus Plan-Apo

10X/0.30 numerical aperture objective, a Spot RT3 Camera (7.4 um x 7.4 um
pixel size) Model 25.4 2 Mp Slider and Spot software

Procedure:

Day 1
1.

Plate 10x10* cells in a 60-millimeter plate

2. Thaw appropriate number of aliquots of 10X Spheroid Formation Matrix on ice

Day 2

Nown kW

8.
9.

at 4°C overnight

. Lift cells with 350 pL of Trypsin/EDTA and keep at room temperature for 5

minutes
Use 1 mL complete media to neutralize trypsin and collect cells in 15 mL Falcon
tube
Wash plate with 1 mL complete media to collect the remainder of the cells
Spin at 800 rpm for 3 minutes to pellet cells
Carefully aspirate media and resuspend cells in 250 pLL volume complete media
Perform Trypan Blue exclusion assay to count the number of viable cells
From this make 0.3 x 10* cells/45 L in ice cold complete media (enough for 1-2
more wells than you need)

a. 0.3x 1000 / (cell count from hemocytometer) = X

b. Take 45 —x =Y (Y is the amount of ice cold complete media required)

c. For triplicate spheroids make enough for 4-5 wells

i. Multiple both X and Y by 4 or 5

Mix the 148.5 uL cold cell suspension with the 16.5 uL of 10X spheroid mix
Plate 50 pL in chilled 3D culture qualified 96-well spheroid formation plate

10. Spin at 200 RCF for 3 minutes at room temperature

11.

a. Important — set centrifuge acceleration to 9 and deceleration to 1
Place at 37°C for 72 hours
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12. Add 50 pLL warm complete media
13. Image every 24 hours for 4-6 days
a. After 4 days add 25 pL warm complete media

Notes:
e Method described in Trevigen product literature
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APPENDIX N

XENOGRAFT IN NUDE MOUSE

Part 1: Generation of Cell Population

Materials:

Fresh short hairpin (sh) virus collected day of infection and filter sterilized
o shNckl
o shNck2
o shScramble (shScr)
CRM-HTB-26
Puromycin (10 mg/mL stock)
Hygromycin (100 mg/mL stock)
Trypsin EDTA
DPBS
MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 freezing media (10% DMSO + 90% FBS)
Texas A&M Animal Care and Use Committee (AUP 2014-0194)

Procedure:

I.
2.

NowvhkWw

o o0

11.

12.

13.

14.

Cells should be infected with freshly prepared, filter sterilized retrovirus

The day following virus infection cells should be lifted with trypsin/EDTA and
passaged to a 60-millimeter plate

Select the shScr population with 1 pg/mL puromycin for two days

Select the shNck population with 1 pg/mL puromycin for two days

After two days exchange media for fresh complete media

Observe growth of shScr until ready to passage to 100-millimeter plate

For shNck population allow cells to recover one day then select with 800 pg/mL
hygromycin for two days

After two days exchange media for fresh complete media

Observe growth of shNck until ready to passage to 100-millimeter plate

. Grow shScr population four days and expand to maximum number of 100-

millimeter plates
Grow expanded shScr population four days then lift and freeze in MDA-MB-231
freezing media
Place in Mr. Frosty™ at -80°C for 24 hours then store in liquid nitrogen until
ready to use
Grow shNck population for five to seven days and expand to maximum number
of 100-millimeter plates

a. Note after double selection the shNck population grows at a much slower

rate than shScr population

Grow expanded shNck population five to seven days then lift and freeze in
MDA-MB-231 freezing media
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15. Place in Mr. Frosty™ at -80°C for 24 hours then store in liquid nitrogen until

ready to use

Part 2: Expansion of Cell Population

Materials:

150-millimeter tissue culture plates

e MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)

e DPBS

e Trypsin EDTA

Procedure:

1. Approximately two weeks prior to experiment start date remove cell populations
from liquid nitrogen

2. Thaw and resuspend in MDA-MB-231 complete media

3. Spin cells for 3 minutes at 800 rpm

4. Remove supernatant

5. Resuspend in complete media and plate 100x10” cells in 150-millimeter tissue
culture plate

6. Grow cells for five to seven days

a. Cell population grows slower during first passage out of liquid nitrogen
than during normal sub-culture
7. Cells should be passage twice before used for animal experiments
8. Plan to have enough cells for 5x10° cells per mouse

a. This is more than required but the excess is required due to the syringe
used to inject the mice

Part 3: Lifting and Preparing Cell Population for Injection

Materials:

MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
DMEM high glucose, plus L-glutamine and phenol red without sodium pyruvate
DPBS

Trypsin EDTA

Growth Factor Reduced Matrigel (BD 9.9 mg/mL)

1.5 mL Eppendorf tubes

Procedure:

1.

Approximately one hour before injection of MDA-MB-231 cell populations into
mice wash 150-millimeter plates containing cell populations twice with 10 mL
room temperature DPBS

a. Aspirate DPBS between washes
Aspirate second DPBS wash and add 1.5 mL Trypsin EDTA to 150-millimeter
plate

a. Leave the plate at room temperature for 5 minutes
Use complete media to neutralize the trypsin and collect the cells
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4. Resuspend the cells well and determine total volume of media
5. Use a small aliquot of cells and trypan blue to count the number of viable cells
6. Determine the total number of cells
7. Based on the total number of cells expressed as number of cells x 10° use a
multiplication factor of 0.2 to determine the total volume required to resuspend
the cells to achieve 2x10° cells per 100 pL of solution
8. Multiple the total volume required by 0.25 to determine the amount of DMEM
high glucose, plus L-glutamine and phenol red without sodium pyruvate required
9. Multiple the total volume required by 0.75 to determine the amount of Matrigel
required
10. Spin cells 3-8 minutes at 800 rpm depending on the volume of media collected
a. Small volumes of less than 5 mL can be spun 3 minutes
b. Large volumes of 50 mL should be spun 8 minutes
11. Aspirate all media off of the cells
12. Place on ice to chill
13. Resuspend in ice cold DMEM high glucose, plus L-glutamine and phenol red
without sodium pyruvate and Matrigel in the previously determined volumes
14. Aliquot ~250 pL or more of the cell solution in ice cold 1.5 mL Eppendorf tubes
15. Cells are now ready for transport on ice to animal housing facility
Part 4: Injection of MDA-MB-231 Cells into Mice
Materials:
e Cells prepared for injection in Part 3
e Mice (Jackson Laboratory, stock number 002019, NU/J, 6-9 weeks old, female)
e Chilled syringes (27 gauge)
e Sterile gloves
e Identification tags
Procedure:
1. Chill syringes on ice
2. Load approximately 250 puL of cells in syringe
3. Bilaterally inject 100 pL of cells subcutaneously into the flank
4. Apply identification tag to each mouse as they are injected with cells
5. Keep experimental groups housed in separate cages
a. Do not exceed the recommended number of mice to be housed per cage
Part S: Sample Collection and Processing
Materials:
e C(Calipers
e Dissection supplies — forceps, scalpel, scissors
e Direct-zol™ RNA MiniPrep with TRI-Reagent® kit (Zymo Research R2052)
e iScript™ cDNA Synthesis Kit (Bio-Rad 170-8990)
e Bio-Rad CFX384 Real-Time System
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e FastStart Universal SYBR Green Master (Rox) mix (Roche)

Procedure:
1. Tumor volume was assessed weekly using calipers
a. Volume was calculated as (LxS?)x0.5 and expressed as mean volume +
SEM as described by Blouw et al. 2015
i. L = longest measurement
ii. S = shortest measurement
2. Mice were sacrificed at 9 weeks post injection in accordance with protocols
approved by the Texas A&M Animal Care and Use Committee (AUP 2014-
0194)
3. Xenograft tumors were removed and weighed prior to sectioning
a. Sections were snap-frozen in liquid nitrogen and stored at -80°C for
DNA/RNA purification or fixed in 4% paraformaldehyde and paraffin
embedded for immunohistochemistry
4. Lungs and liver were removed and sectioned
a. Sections were snap-frozen in liquid nitrogen and stored at -80°C for
DNA/RNA purification or fixed in 4% paraformaldehyde and paraffin
embedded for immunohistochemistry
5. RNA isolation was performed following the manufacturers protocol using the
Direct-zol™ RNA MiniPrep with TRI-Reagent® kit
a. A small portion of tissue was cut using forceps and a scalpel and placed
in 500 pL Tri-Reagent
b. The tissue was homogenized using an Omni International Tissue Master
125 electric tissue homogenizer
i. Between each tissue homogenized the probe was washed in a
series of 4 — 50 mL Falcon tubes filled with 40 mL ddH,O
c. Samples were centrifuged at 12,000 rpm for 1 minute
d. 100% ethanol was added at a 1:1 ratio and mixed by vortexing
e. Mixture was loaded on Zymo-Spin™ IIC Column in a collection tube and
centrifuged at 12,000 rpm for 30 seconds
f. Column was transferred to a new collection tube and 400 pLL RNA wash
buffer was added and centrifuged into the collection tube
g. Contents of collection tube was poured out and 80 uLL of DNase [ in DNA
digestion buffer was added to the column and incubated for 15 minutes at
room temperature
h. Column was washed twice with 400 uL Direct-zol™ RNA PreWash
i. A final wash with 700 uL RNA Wash Buffer and centrifuged for 2
minutes
j. Transfer column to an RNase free tube
k. Add 40 uL DNase/RNase-Free Water and centrifuge for 30 seconds
1. Place samples on ice and quantify RNA using NanoDrop 1000
6. Synthesis of cDNA was performed using iScript™ cDNA Synthesis Kit
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a. Combine following components in RNase free PCR tube to a final
volume of 20 pL.
1. 4 uL 5x iScript advanced reaction mix
ii. 1 pL iScript advanced reverse transcriptase
iii. 2 pug RNA template
iv. Nuclease-free water to 20 uLL
b. Use the following protocol in a thermal cycler
i. 5 minutes at 25°C
ii. 30 minutes at 42°C
iii. 5 minutes at 85°C
iv. wat4°C
c. Either store cDNA at -20°C or use immediately for real-time PCR
. Real-time PCR reactions were performed using FastStart Universal SYBR Green
Master (Rox) mix (Roche)
a. Primers for determining lung metastasis
i. Human GAPDH Forward
1. 5-CCA GGT GGT CTC CTC TGA CTT C-3°
ii. Human GAPDH Reverse
1. 5’-CCA GGT GGT GAG GGC AAT G-¥’
b. Primers for normalization
i. B-actin Forward
1. 5°-GTT TGA GAC CTT CAA CAC CCC-3°
ii. P-actin Reverse
1. 5°-GTG GCC ATC TCT TGC TCG AAG TC-3’
c. Program used for RT-PCR on Bio-Rad CFX384 Real-Time System
i. 95°C for 10 minutes
ii. 95°C for 15 seconds
iii. 60°C for 1 minute
iv. Plate read
v. Repeat ii. to iv. 39 times
vi. 95°C for 10 seconds
vii. Melt curve 65°C to 95°C — Increment 0.5°C for 5 seconds + Read
viii. End
d. Real-time PCR data were analyzed by the AACt method
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APPENDIX O

TOTAL INTERNAL REFLECTION FLUORESCENCE (TIRF) MICROSCOPY OF

MMP14

Materials:

MDA-MB-231 stably expressing:

o Scrambled shRNA plus pMSCV LifeAct-EYFP

o Nckl and Nck2 shRNA plus pMSCV Life-Act EYFP
Lipofectamine 2000
pcDNA3.1 MT1-MMP mCherry
MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
DPBS (HyClone, ThermoScientific)
Live Cell Imaging Media (Phenol-red free DMEM High Glucose supplemented
with 10% FBS, 1% Pen/Strep and 25 mM HEPES)
35-millimeter glass bottom MatTek dishes (MatTek Corporation, Ashland, MA)
Fibronectin (10 pg/mL in DPBS)
Zeiss Axio Observer Z1 TIRF 3 microscope, equipped with a plan-apochromat
100X/1.46NA oil objective and a Roper S/'W PVCAM

Procedure:

1.

2.

4,

Three days prior to imaging plate 20x10* cells in a 35-millimeter tissue culture
plate for Lipofectamine 2000 transfection
Two days prior to imaging transfect 2 ug pcDNA3.1 MT1-MMP mCherry using
5 uL Lipofectamine 2000 (see Appendix J)
One day prior to imaging:

a. Coat MatTek dishes with 10 pg fibronectin (use 1 mL of 10 pg/mL

fibronectin in DPBS for one hour at room temperature

b. After one hour aspirate excess DPBS and add 200 pL live cell imaging
media to the glass portion of the MatTek for 15 minutes and place in
37°C/5% CO; incubator
Lift cells using 350 puL Trypsin/EDTA for 5 minutes at room temperature
Collect cells in 15 mL Falcon tube and spin for 3 minutes at 800 rpm
Re-suspend cells in 250 pL of Live Cell Imaging Media
Count cells using hemocytometer
Make dilutions of 4x10” cells in 200 pL Live Cell Imaging Media
Remove fibronectin coated plates from incubator and aspirate media
Add 4x10* cells in 200 pL to each fibronectin coated plate and place in
37°C/5% CO, incubator for one hour to allow cells to adhere

j. After one hour add 2 mL imaging media to each plate and incubate for

approximately 20 hours prior to imaging

Day of imaging

P ER o Ao
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Exchange media with 2 mL fresh Live Cell Imaging Media 1 hour prior
to imaging
. Place plate on stage and allow >15 minutes for equilibration
Images of EYFP/mCherry were captured every 3 seconds for 5 minutes
i. Laser power: 5% 488nm/exposure 100 ms; 1 % 561 nm/exposure
100 ms
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APPENDIX P
RETROVIRUS PREPARATION

Materials:
e 293T (Human Embryonic Kidney Cells ATCC® CRL-3216™)
e 293T complete media (HyClone DMEM/High Glucose catalog number
SH30243.01 plus 10% FBS and 1% v/v penicillin streptomycin)
e Retroviral DNA Plasmid (Store at -20°C)
o pMSCV
o pSuper
pHCMV-G plasmid (Store at -20°C)
pMD.Gag.pol plasmid (Store at -20°C)
2 M CaCl, (Store at -20°C)
2X Transfection Buffer (Store at -20°C)
50 mM Chloroquine (Store at -20°C)
Syringe filter (PVDF 0.22 pm 30 mm diameter Denville F5508)
1.5 mL Eppendorf tubes

Procedure:
1. One day prior to virus production sub-culture 293T cells to achieve 80%
confluence the following day
a. 60-millimeter plate — approximately 300-350x10* cells
b. 100-millimeter plate — approximately 900-950x10* cells
2. Day of virus production add Chloroquine to 293T cells with a final concentration
of 25 uM just prior to transfection
a. 60-millimeter plate — 2.5 pL in 5 mL 293T growth media
b. 100-millimeter plate — 5 pL in 10 mL 293T growth media
3. In asterile polypropylene tube combine
a. Sterile water
i.  60-millimeter plate — Adjust so final volume is 250 uL.
ii.  100-millimeter plate — Adjust so final volume is 500 pL
b. Plasmid DNA
i. Retroviral DNA Plasmid
1. 60-millimeter plate — 12 pg
2. 100-millimeter plate — 24 pg
ii. pMD.Gag.pol plasmid
1. 60-millimeter plate — 6 pg
2. 100-millimeter plate — 12 pg
1. pHCMV-G plasmid
1. 60-millimeter plate — 2 pg
2. 100-millimeter plate — 4 pg
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10.

11.
12.
13.

Notes:

c. 2M CaCl,
1. 60-millimeter plate — 62.5 uLL
ii.  100-millimeter plate — 125 pLL

Once components from Step 3 have been combined in a polypropylene tube add
2X Transfection Buffer - MUST BE ADDED DROPWISE WHILE
VORTEXING

a. Pre-warm solution to 37°C

b. 60-millimeter plate — 250 pL

c. 100-millimeter plate — 500 pL
Add entire mixture dropwise over the entire plate of 293T cells with chloroquine
Gently swirl the plate and immediately place in 37°C/5% CO,/humidified
incubator
After 4-6 hours exchange media with fresh complete media and place back in
37°C/5% COy/humidified incubator for 20 hours

a. 60-millimeter plate —2 mL

b. 100-millimeter plate — 5 mL
After 20 hours collect media with virus and replace media

a. 60-millimeter plate — 2 mL

b. 100-millimeter plate — 5 mL
After 8 hours collect media with virus

a. 60-millimeter plate — 2 mL

b. 100-millimeter plate — 5 mL
Virus can be used immediately after filter sterilization using a 0.22 pm syringe
filter

a. Immediate use provides highest viral titer
Virus can be stored at -80°C after centrifugation at 4000 rpm for 5 minutes
After centrifugation store 1 mL aliquots in 1.5 mL Eppendorf tubes
Place in -80°C and leave until ready to use

a. Viral titer decreases with freeze/thaw cycle

b. Once thawed the aliquot should be used or discarded

2X transfection buffer: 6.5 g HEPES, 8.0 g NaCl, 0.105 g Na2HPO4 in 500 mL
H2O; pH solution to 7.05
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APPENDIX Q
RETROVIRUS INFECTION

Materials:
e Retrovirus
e MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
e Polybrene (4 mg/mL stock, store at -20°C)

Procedure:
1. Sub-culture MDA-MB-231 cells one day prior to retrovirus infection
a. 35-millimeter plate —10x10* cells in 2 mL complete media
2. Add 8 pg/mL polybrene to each tube of virus and vortex briefly
a. Rapidly thaw frozen aliquots of retrovirus prior to addition of polybrene
b. Polybrene should be added immediately to fresh virus
3. Aspirate media from cells and add retrovirus/polybrene mixture to begin
infection
4. Incubate cells for 4 hours
a. Ifadouble infection is required repeat steps 2-4 after first retrovirus has
been incubated for 4 hours
After infection aspirate media and replace with fresh complete media
6. Grow cells overnight then sub-culture
a. Antibiotic selection can be performed with sub-culture of cells

9]
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APPENDIX R

IMMUNOFLUORESCENCE LABELING MEMBRANE MMP14

Part 1: Cell Preparation and Immunofluorescence Staining

Materials:

MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
DPBS (HyClone, ThermoScientific)

NucBlue® Live ReadyProbes™ Reagent (Molecular Probes)
Human serum (Jackson ImmunoResearch, 009-000-121)

Goat serum (Sigma G9023-10 mL)

Syringe filter (MillexGV 0.22 pum Durapore PVDF — Millipore)
Anti-MMP14 antibody (Millipore MAB3328)

Goat anti-mouse IgG 488 (Invitrogen A11029)

Parafilm

Tween-20

Prolong Gold (Invitrogen P36934)

Procedure:

1.

2.

(98]

10.

11

48 hours after time 0 siRNA Treatment — lift and re-plate cells on poly-L-lysine
coated coverslips (40x10* cells per mL)

Add 1000 pL fresh complete media to coverslip, allow surface tension to hold in
place

Add 1000 uL cells dropwise to distribute evenly over coverslip

72 hours after time 0 siRNA treatment — add NucBlue® Live ReadyProbes™
Reagent to media 20 minutes prior to wash and fixation - check that cells are
~70-80% confluent — aspirate media and wash 2 times with room temperature
DPBS

Fix for 15 minutes with 3.7% paraformaldehyde in DPBS (750 uL/coverslip)
Prepare humidified chamber—150-millimeter plate lined with Whatman paper
soaked in ddH,O —place parafilm on top of Whatman paper for incubations
Wash cells 2 times for 5 minutes each with 2 mL room temperature DPBS
(DPBS washed coverslips dry out quickly, act accordingly)

Block for 1 hour at room temperature in 100 puL 2.5% human serum and 5%
goat serum in DPBS

Incubate cells with primary antibody diluted in blocking solution (1:100) for 1
hour at room temperature (primary antibody: mouse anti- MMP14)

Spin antibody in blocking solution prior to use: 12,000 rpm for 5 minutes
(http://www .cbi.pitt.edu/protocols/cellimuno.htm)

. Drain excess fluid from coverslip without allowing it to dry
12.

Place a 100 pl drop on parafilm and place the coverslip cell side down on top of
the drop
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13.
14.
15.
16.
17.

18.
19.

20.

21.

22.

23.
24.

In a new 12 well plate wash 3 times with 2 mL/well DPBS for 10 minutes at
room temperature protected from light
Incubate cells for 1 hour at room temperature with fluorescent goat anti-mouse
IgG 488 diluted in blocking solution (1:500)
Spin antibody in blocking solution prior to use: 12,000 rpm for 5 minutes
Drain excess fluid from coverslip without allowing it to dry
Place a 100 pl drop on parafilm and place the coverslip cell side down on top of
the drop
Store in dark location for incubation
Wash 2 times with 2 mL/well 0.05% Tween-20 in DPBS in 12-well plate for 10
minutes at room temperature
Wash 1 time with 2 mL/well DPBS in 12-well plate for 10 minutes at room
temperature
Just before mounting in Prolong Gold dip coverslip in sterile filtered ddH20 then
drain excess fluid
Mount in small drop (5-10 uL) Prolong Gold (avoid bubbles-if they form leave
them alone, attempting to remove will potentially ruin any usable portions of the
slide) on a clean glass slide, then store in the dark at room temperature for 24
hours to allow solution to cure
Optional: Seal with finger nail polish around the edges of the coverslips
Image using LSM510 confocal microscope

a. Ensure z-stack includes all signal from ventral to apical surface of the

cells

Part 2: Image Processing and Analysis Using ImageJ Software

Images were collected with a Plan-Neofluor 40X/1.3NA oil objective using a Zeiss
LSM510 confocal microscope. Stack depths were varied to collect the entire depth of the
cell starting below the ventral surface of the cell through the top of the cell. There were
instances when cells would stack and greater than 20 slices would be taken, in addition,
there are some cells where the very top of the cell is not collected due to stacking.
During image analysis these regions were excluded from the analysis

Procedure:
1. Open Image: Image—>Color->Split Image
2. DIC Stack — Find membrane focal plane
c. Duplicate focal plane only and close DIC Stack
d. Save in data analysis working folder
e. Auto adjust brightness and contrast
f. Outline cell and add to ROI manager
i. Save all ROI as an ROI set in working folder
3. MMP14 Labeled Channel — Image—> Stacks—=>Z-project (Sum of Slices)

b. Use rectangle tool to select a region with no cells or membrane and take a
measurement
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c. Use the mean from this measurement to subtract the background from the
image
i. Process—>Math—> Subtract
d. Save image in data analysis working folder after subtracting the
background
e. Take measurement for each ROI generated from the DIC image above

i. Save measurements in an excel file for analysis using excel or
Minitab

Notes:
o Filter sterilize all solutions using MillexGV 0.22 um Durapore PVDF filter to
remove any particulates that may interfere with imaging or image analysis
e Protocol adapted from:

o Wiesner C, Faix J, Himmel M, Bentzien F, Linder S. KIF5B and
KIF3A/KIF3B kinesins drive MT1-MMP surface exposure, CD44
shedding, and extracellular matrix degradation in primary macrophages.
Blood. 2010;116(9):1559-69

o Hagedorn M, Neuhaus EM, Soldati T. Optimized fixation and
immunofluorescence staining methods for Dictyostelium cells. Methods
in Molecular Biology. 2006;346:327-38.
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APPENDIX S

PSUPER SHRNA PLASMID CONSTRUCTION

Materials:

Forward custom oligo (100 uM in nuclease free water)

e Reverse custom oligo (100 uM in nuclease free water)
e pSUPER retro.puro (pPSUPER RNAi System™ - original format)
e Autoclaved ddH,0 (H,0O)
e 10X Ligase Buffer (Promega T4 DNA Ligase Buffer 10X C126A 27464315)
e PCR machine
e Hind III restriction enzyme (NEB)
e Bgl II restriction enzyme (NEB)
e QIAquick Gel Extraction Kit (28704)
e  QIAprep Spin Miniprep Kit (27104)
e NanoDrop 1000 spectrophotometer
e Competent DH5a
e [BAgar
e LB Broth
Procedure:
1. Anneal oligonucleotides
H,O 41.1 uL
Forward oligo 1.5 uL (100 uM)
Reverse oligo 1.5 uL (100 uM)
10X Ligase Buffer 4.9 uL
Total 49 uL
a. Use PCR machine: set-up reaction as follows — incubate at 94°C for 4
minutes = 80°C for 4 minutes = 75°C for 4 minutes = 70°C for 10
minutes = 60°C for 4 minutes = 50°C for 10 minutes = 37°C for 20
minutes = 10°C for 10 minutes and finish the run at 4°C for infinity >
product is ready for ligation
2. Linearize vector by restriction enzyme digestion

a. Hind III & Bgl II RE digestion in sequential reaction step:

H,O 15.8 uL
10X buffer 2 2.0 uL
100X BSA 0.2 uL
pSUPER .retro.puro 1.0 uL (1 pg)
Hind IIT RE 1.0 uL

164



Total 20 uL

Incubate at 37°C for 60 minutes
Add 2 pl 10X buffer 3.1 and 1.0 ul Bgl I
Incubate at 37°C for 2 hours
Confirm digestion of pSUPER.retro.puro by gel electrophoresis on 1%
agarose gel
i. Add 4 pL 5X gel loading dye and run whole digested product
il. Run circular vector as control
iii. Purify gel using QIAquick gel extraction kit
iv. Quantify linear vector using NanoDrop spectrophotometer
. Ligation of annealed oligonucleotides to linearized vector using NEB quick
ligation protocol (M2200)
a. Combine 50 ng of pSUPER retro.puro with a 3-fold molar excess of
annealed oligonucleotides
i. NEBioCalculator can be used to calculate molar ratios
ii. Adjust volume to 10 ul with H,O
Add 10 pl of 2X Quick Ligation Buffer and mix
Add 1 pl of Quick T4 DNA Ligase and mix thoroughly
Centrifuge briefly and incubate at room temperature (25°C) for 5 minutes
Chill on ice, then transform or store at -20°C
Do not heat inactivate
i. Heat inactivation dramatically reduces transformation efficiency
. Reduce background transformants by Bgl II digestion
a. Vector that contain an insert lack a Bgl II digestion site and will remain
intact while vector that lack an insert will be linearized

opo

me e o

Ligated pSUPER .retro.puro vector ------------------ 20 pl (From the
previous step)

10X Buffer 3.1 2.0l

Bgl 11 restriction enzyme 1.0 ul

Total 23 pl

b. Incubate at 37°C for 1 hour (digestion)
c. Chill onice
d. Add 5 pL of reaction to competent DH5a
Transformation of competent DH5a
a. Add 5 pL of product from previous step to 50 uL of competent DH5a
i. Competent cells should be stored at -80°C
ii. When handling competent cells ensure they are kept on ice at all
times unless indicated for transformation
iii. Do not pipet competent cells to mix instead use the tip of the pipet
to mix the insert and the vector or gently flick the tube
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°opo

Tt B

k.

iv. Include two controls
1. Untransformed DH5a without any insert
2. DHS5a transformed with control vector that underwent all
procedures as target vector with the exception that the
oligonucleotide insert was not included
Incubate mixture on ice of 10 minutes
Incubate at 42°C for 30 seconds
Immediately place back on ice and incubate for 10 minutes
Add 1 mL 37°C LB media without antibiotics and incubate at 37°C in a
shaking incubator for 1 hour
Pellet cells by spinning at 13,200 rpm for 1 minute
Remove supernatant
Re-suspend cells in approximately 100 uL of LB
Pipet cells onto an LB agar plate with ampicillin (100 pg/mL)
Use a glass rod or sterile loop to spread cells well enough to get single
colonies
i. Spread until LB no longer appears wet on the surface of the agar
Grow at 37°C overnight

6. Screening transformed DH5a colonies

a.
b.

The untransformed control plate of DH5a should have no colonies
The control vector without insert should have very few colonies or no
colonies
The target vector should have multiple colonies to select
i. The target vector should have at least four times more colonies
than the control vector without an insert prior to proceeding with
screening
Select individual colonies and grow them overnight in 5 mL LB broth
with 100 pg/mL ampicillin
Isolate plasmid DNA using QIAprep Spin Miniprep Kit
Analyze insert by restriction digestion with Bgl 11
1. Uncut plasmid remains supercoiled and will run further down the
gel than plasmids with inserts
Once candidates have been identified with restriction digestion,
orientation and sequence of inserts should be confirmed by sequencing
1. Sequencing primers for pSUPER.retro.puro
1. pMSCV Fwd -5>-CCC TTG AAC CTC CTC GTT CGA
CcC-3%
2. pMSCV Rvs -5’ -GAG ACG TGC TAC TTC CAT TTG
TC-3’
Upon confirmation of correct sequence and orientation of insert in vector
additional plasmid should be produced for use in transfection of
mammalian cells
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i. Confirmation of an effective insert is accomplished with biochemical
screening in the target cell line
i. RT-PCR or western blot of target product should show greater
than 60% silencing of the target mRNA or protein over a control
sample
7. Retrovirus should be produced using pSUPER .retro.puro according to Appendix
P retrovirus preparation

Notes:
e Manufacturer’s (Oligoengine) protocol was used with modifications
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APPENDIX T
RAICHU CDC42 FORSTER RESONANCE ENERGY TRANSFER

Materials:
e MDA-MB-231 stably expressing:
o Scrambled shRNA plus Raichu Cdc42 Forster resonance energy transfer
(FRET) probe
o Nckl and Nck2 shRNA plus Raichu Cdc42 Forster resonance energy
transfer (FRET) probe
¢ MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
e DPBS (HyClone, ThermoScientific)
e Live Cell Imaging Media (Phenol-red free DMEM High Glucose supplemented
with 10% FBS, 1% Pen/Strep and 25 mM HEPES)
e 35-millimeter glass bottom MatTek dishes (MatTek Corporation, Ashland, MA)
e Fibronectin (10 pg/mL in DPBS)
o Zeiss LSM780 Confocal Microscope Plan-Apo 40X/1.40NA oil objective

Procedure:
1. Two days prior to imaging plate 10x10” cells in a 60-millimeter tissue culture
plate to synchronize growth at low density
2. One day prior to imaging:

a. Coat MatTek dishes with 10 pg fibronectin (use 1 mL of 10 pg/mL

fibronectin in DPBS for one hour at room temperature)

b. After one hour aspirate excess DPBS and add 200 pL live cell imaging
media to the glass portion of the MatTek for 15 minutes and place in
37°C/5% CO; incubator
Lift cells using 350 pL Trypsin/EDTA for 5 minutes at room temperature
Collect cells in 15 mL Falcon tube and spin for 3 minutes at 800 rpm
Re-suspend cells in 250 pL of Live Cell Imaging Media
Count cells using hemocytometer
Make dilutions of 4x10” cells in 200 pL Live Cell Imaging Media
Remove fibronectin coated plates from incubator and aspirate media
Add 4x10* cells in 200 pL to each fibronectin coated plate and place in
37°C/5% CO, incubator for one hour to allow cells to adhere

j. After one hour add 2 mL imaging media to each plate and incubate for
approximately 20 hours prior to imaging
3. Day of imaging
a. Place plate on stage and allow 5 to 15 minutes for equilibration
b. Images of CFP/FRET/YFP were captured every minute for 1 hour
4. Data analysis
a. Process CFP channel stack and FRET channel stack using a 3x3 median
filter

SRR o Ao
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. Use the median filtered stacks to create a ratio stack of the FRET channel

divided by the CFP channel
Limit analysis area to individual cells using regions of interest

. Average the FRET ratio over one hour for each cell
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APPENDIX U

MAMMALIAN CELL STABLE PLASMID TRANSFECTION

Materials:

MDA-MB-231 complete media (10% FBS and 1% v/v penicillin streptomycin)
MDA-MB-231 complete media without antibiotic (10% FBS)

Lipofectamine® 2000 Transfection Reagent (Life Technologies Catalog Number:
50470)

Opti-MEM" Reduced Serum Medium (Life Technologies Catalog Number:

31985-062)
e Plasmid DNA
e 1.5 mL Eppendorf Tubes
¢ Geneticin
Procedure:
Day 1
1. Plate 20x10* MDA-MB-231 cells with complete media in a 35-millimeter dish
and place in a 37°C incubator with 5% CO,
Day 2
2. Label two Eppendorf tubes and add 250 pL of Opti-MEM media to each tube
a. Tube 1 - Plasmid DNA
b. Tube 2 - Lipofectamine 2000
3. Add 2 pg plasmid DNA to tube 1 and mix well by gently pipetting up and down
4. Add 5 pL of Lipofectamine 2000 reagent to tube 2 and mix well by gently
pipetting up and down
5. Incubate at room temperature for 5 minutes
6. After 5 minutes take entire volume from Tube 2 and add it to Tube 1
7. Mix well by gently pipetting up and down then incubate at room temperature 20-
30 minutes
8. Add 500 pL antibiotic free complete media to the transfection reagent plasmid
mixture in Tube 1
9. Remove complete from cells and add entire contents of Tube 1 to the plate then
place back in 37°C incubator
10. After one hour replace media with fresh antibiotic free complete media
11. After an additional four hours the media can be replaced with complete media
containing antibiotic
12. Grow cells overnight then lift and re-plate with fresh complete media
13. Grow cells for 48 hours
14. After 48 hours lift and re-plate cells in complete media with 800 pg/mL
Geneticin
15. During selection process cells were passed as required
16. Cells were selected for 14 days with 800 pg/mL Geneticin
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17. Cells were then expanded for 7 days in 500 pg/mL Geneticin
18. After expansion cells were frozen in liquid nitrogen

Notes:

e Adapted from manufacturer’s protocol (Life Technologies) for Lipofectamine
2000 and selection conditions adapted from Yu et al. 2012
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